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Introduction




When you begin any enterprise, you must find a starting
point. You set out from that starting point and acquire a basic
vocabulary, a notion of boundaries and techniques, a sense
of how things fit together and what is possible. For those
who want to learn how to create OPENSTEP applications,
this book provides a starting point.

With this book you become familiar with OPENSTEP
application development not merely by reading but by
doing. 'The book guides you through the creation of three
applications of increasing complexity. Along the way it
explains related concepts and issues. The techniques and
concepts you learn in one tutorial lay the foundation for the
more advanced techniques and concepts in the next
tutorial.

The final chapter of the book tells you where to go for
further information and where and how to find things, such
as tools and documentation. It also tells you how to get
NeX'T products and services.

"This book covers a lot of ground, although sometimes at
only a summary level. Finishing this book makes you much
better prepared to take on serious application development

with OPENSTEP in general and the Enterprise Object
Framework in particular.

Although the aim is primarily to educate, this book is also
intended—for those interested in programming—to be fun.

..................................................

Some of you might be new to OPENSTEP. To learn more
about OPENSTEP, the standard on which it’s based, and
OPENSTEP Developer, turn the page.



Chapter 1 Introduction to OPENSTEP

OPENSTEP is NeXT Software's graphical, object-oriented user
and development environment. Itis based on the OpenStep
standard and available on a variety of platforms. OPENSTEP is
earning a growing reputation in the corporate world as the
premier-environment for developing and deploying mission-
critical custom applications.

The two core components ofthe productare OPENSTEP User and' V

OPENSTEP Developer.

OPENSTEP Useris a user environment

acclaimed for its intuitively navigable desktop

and file manager. On it you can easily deploy

your own OPENSTEP applications as well as those
supplied by NeXT and third-party vendors. Intelligent networking,
particularly Netlnfo, makes it possible to install and upgrade
OPENSTEP in a fraction of the time it takes other systems.

OPENSTEP Developer, NeXT’s software-
development environment, provides ,
seamlessly integrated set of tools for building
complex applications that can be deployed on
heterogeneous client/server networks running not only
OPENSTEP, but Portable Distributed Objects, Enterprise Objects

Framewaork, and OpenStep based software developed by other

- vendors.

k e DlsplayPostScnpt.APlsforPostScnptkdrawmg
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~ OpenStep

OpenStep is the software industry's first open standard for object-
oriented software development. Itis an application programming
interface (API) based on the fundamental NEXTSTEP object layer:

the Application Kit, the Foundation Kit, and Display PostScript.

Application Kit

Applications

Display |Foundation
Postscript Kit

Applications

_ and deploy multi-tier, client/server business applications in a fraction of .
. time it takes other methods.

- » Foundation Kit: APIs that define basic object behavior, that support

System

OpenStep

Applications

The OpenStep object layer allows corporate customers to create, evolve

* Application Kit: APIs for user-interface objects and for essentlal s
application behavior, such as event handling

~object persistence and distribution, and that “objectify” collections
Unicode strings, and many other programmatic entities

"OPENSTEP’ refers to the saftware product. ”UpenStep refers to the standard or speczf/cat/an on which the product is based, and by extension to the

cancepts expressed by the specification.

The OpenStep speclﬁcatmn is available via ananymaus ftp atfp. next com.



The OPENSTEP user

environment includes File T
Viewer (a file-system browser), Mngr 2
Mail, Preferences, Edit, and

other applications in /NextApps.
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Other Products from NeXT
« With WehbObjects you can easily create dynamic websites. application to be distributed among a heterogeneous network
Web0bjects applications provide a smart, interactive of OpenStep clients and a broad range of servers.
connection between corporate databases and customers on
“The Web.” o D’OLE brings the PDO object model to the Windows platform,
giving Windows application developers the ability to make use
¢ Enterprise Objects Framework enables you to construct of distributed-object technology.

applications that use (and reuse) enterprise business objects,
storing them in relational databases such asthose from Oracle  In addition to software products, NeXT provides developer
and Sybase. support and professional services, in particular the Object

Experts program, an innovative on-site support and training
¢ Portable Distributed Objects (PDO) allow objects in a single program.

OPENSTEP— Platforms and Interoperability

Supported Platforms Intel-based PCs, Sun SPARC workstations, NeXT’s Motorola 68040-based computers.

~CORBA - NeXT has licensed SunSoft's implementation of the CORBA standard (from the Object Management
. Group) and is committed to CORBA interoperability.




Chapter 1 Introduction to OPENSTEP

OPENSTEP Developer 4.0 ise programming environment ideally
ited for the rapid development of custom object-oriented
applications deployable on a variety of computer architectures. It - Standard palettes hold an assortment of Application
- comprises an integrated set of development software, libraries, - Kit objects. Custom palettes can include third-party
i headerflles, tools, document tion, and other resources. _~objects as well as the developer’s own objects. Interface Builder
. archives and restores elements of a user interface as objects—it
doesn’t “hardwire” them into the interface. Interface Builder
helps to connect objects for messaging, and it assists in the
“definition of custom classes.

Interface Builder makes it easy to create application
interfaces by dragging objects from palettes.

Project Builder is an application that manages

- software-development projects, and that

| orchestrates and streamlines the development
process. It integrates a project browser, a full-
featured code editor, language-savvy symbol recognition,
sophisticated project search capabilities, header file and
documentation access, build and debugging support, and a host
of other features.

,'Themam window of Project Builder - & SimplePlayer — {NextDeveloper/Examples/HEXTIME
combines a praject browser with a ; i ’

- code editor.

Iconic buttons above the browser .
let you access the application’s
Build, Project Find, and Loaded Files
panels as well as the project
" inspector and the graphrcal
debugger.

Whenp a/ects are indexed, Project

Bu:lder caches all symbols in
memory and makes them instantly -
available upon request.

#import "Controller.h”
#import "Document.h”
#import "SimplePlayer_ Globals.h"

static NSString *curDirectory = nil; /% Directory for open panel */

@implementation Controller

// Register our defaults
+ (void)initialize {

if (self == [Controller class]) {

NSDictionary *dict = [NSDJ.ctionary dictionaryWithGb jectsAndKeys:




Interface Builder lets you craft user

interfaces from palettes of ready-
made objects, then store the
interface in a file.

* No Movie Loaded....

Bl s

J/ rstahces .

A palettes window contains
assortments of standard
Application Kit and (if installed)
Enterprise Objects Framework
objects as well as custom objects
that you or third-party developers
create.

A nib file window enables the initial
definition of custom classes and

facilitates the connection of these
classes to objects on the interface.
It also catalogs the image and
sound resources used in the
interface.

 OpenStep Class Libraries. Includes NeXT’s implementation of
the Application Kit, the Foundation Kit, and Display PostScript,
with some extensions.

¢ Objective-C. An object-oriented programming language that is
an extension of standard ANSI C, Objective-C is a simple and
powerful language. It is easy to learn, yet elegant in its
‘application to the problem domain‘ OPENSTEP projects can
- include Objective-C, C, and C++ source code.

s In‘addition OPENSTEP Developer 4.0 offers a new version of the
GNU C compiler, enhancemems to C++ compilation, and GNU
make technology.

Compiler and Library Technology. Two important features of
OPENSTEP Developer 4.0 for Mach are dynamic shared
libraries and framewarks. Programs linked with a dynamic
shared library share one copy of thatlibrary’s routines, and are
linked with only those modules they currently need.
Frameworks assemble all library companents in one place:
executable code, header files, resources, and documentation.
The executable code is in the form of a dynamlc shared llbrary
The Application Kit, Foundation, and Display PostScnpt are
installed as frameworks.
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“many applications. And througt

Objects are the snftWare equivalent of the Industrial Revolution.
In the same way that modern factories assemble products out of
prefabricated components rather than manufacture every

product from scratch, object-orientation allows programmers tb =

build complex software by reusing software components called
objects. Specifically, objects lead to several measurable

'”advantages

foeater reliability. By breaking complex software projects into
i small, self-contained, and modular objects, object-orientation
ensures that changes to one part of a software project will not

adversely affect other portions of the software. Being small, each
of these objects is a well-tested module of code, and so the
overall reliability of the software increases.

—>» Messages

 Greater maintainability. Since objects are modular and usually

small (in terms of the overall code size of a project), bugs in code
are easier to locate. Developers can also change the

lmplementatmn of an object without causing havoc to other parts
of an pplication.

Greater productlvnty:through reuse. One of the principal benefits
of object-orientation is reuse. Objects can be integrated into
classing you can create
specnallzed objects m g the code unique to the new
object. Objects of th inherit functionality from the
5 : ucing coding and promoting greater reliability.

‘The structure has become inconsistent and unreliable. -

: Another problem is that all parts of the application must have

affect every part of the application that accesses, adds, or
 deletes elements from the list.

Wit
" as a whole wouldn't directly manipulate the data structure;
_rather, thattask is entrusted to a partlcular object. Since the.

An Example

~ Object-oriented programming delivers its greatest benefits to
Iarge and ‘complex programs. But its advantages can also be -
~ demonstrated with a simple data structure such as might be used

in any application.

With procedural programming techniques, the applicationis-
directly responsible for data manipulation. One problem with this
is illustrated in the picture above: It shows a data structure
consisting of a count variable and a data paointer. Since the .
application directly manipulates the data, ithas the opportunity to
introduce inconsistencies. Here, it has added an itemto the data,
but has forgotten to increment the count; the countvariable says
there are still only two data elements when infact there are three.

intimate knowledge about the structure of the data. If the
allocation of data elements were changed from a statlcally
allocated array to a dynamically allocated linked list, it would

e
eSsage to ;etng:\le a2 —~

obj ct-onented programming paradigm, the apphcat :

application doesn’ t dlrectly access the data, it can't introduce -
inconsistencies. Note also that it's possmle to change the - i
lmplementatmn of the oblect Wlthout br aklng other parts of the




The Advantage of OPENSTEP

Proven Technology. NeXT Software’s technology has been
evolving through 10 years and four major releases. During that
time, it has been rigorously tested and iteratively refined. NeXT

has an established track record in object technology, while it will

be years before its major competitors can offer comparable
technology of comparable maturity.

True Objects. OPENSTEP objects are truly objects—modular,
autonomous, persistent, and distributable. They are not static

entities, but can be bound dynamically atrun time. When you drag an
object from an Interface Builder palette, you're getting a real object

and not an area painted on the screen with some code attached.

Portabhility. OPENSTEP is designed to foster both hardware
portability and operating-system portability.

Simplified Client/Server Development. OPENSTEP Developer’s
integrated toolset simplifies the complex process of building
distributed client/server applications.

Substantial Business Benefits. OPENSTEP's object-orientation
helps managers to accelerate the introduction of new products
and services that depend on new software. With OPENSTEP

programmers can modify software quickly and assuredly to take
advantage of evolving business opportunities. Through reusable

object libraries, systems integrators can quickly customize a

generic productto produce an individualized software solution for

each client.

Inthree years, Nicholas-Applegate
Capital Management reengineered
its business systems, enabling the
company to manage its business
growth from $4 billion to $14 billion
in assets. Using object technology

Don't Take Our Word For It

Here are a few comments on OPENSTEP and its predecessor,
NEXTSTEP:

¢ Booz Allen & Hamilton's study of OPENSTEP development
suggests that experienced developers could increase their
productivity five to ten times.

» “Information is our business. That's why OPENSTEP succeeds
here. The most important product we have is the quality of the

service we provide: our timeliness, the effectiveness of our
analysis and planning.” :
Director, Software Engineering
Fannie Mae

“We would never have be able to do what we did on time or on

budget if we had chosen any other solution but NeXT.”
Manager, IS Branch Automation
Chrysler Financial Corporation

“The greatthing about object-oriented programming is that the

longer you're at the game, the more benefits you derive. You
can reuse objects you've created or add to objects to make
them more robust. And NEXTSTEP is the best integrated
computer platform on the market.”

MIS Manager,

UBS Securities

from NeXT, Nicholas-Applegate
was able to develop an investment
and trading environment that was
flexible and able to expand as the

company grew.

T
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You can find the
CurrencyConverter projectin the
AppKit subdirectory of
/NextDeveloper/Examples.

The application that you are going to create in this tutorial is called Currency
Converter. It is a simple application, yet it exemplifies much of what software
development with OpenStep is about. As you’ll discover, Currency Converter is
amazingly easy to create, but it’s equally amazing how many features you get
“for free”— as with all OpenStep applications.

Currency Converter converts a dollar amount to an amount in another currency,
given the rate of that currency relative to the dollar. Here’s what it looks like:

Cuﬁency Converter

Enter an exchange rate and a dollar amount.

When you click the Convert button, the
converted amount appears in the Amount in
Other Currency field.

Instead of clicking the button, you can also press the Return key. You can
double-click the converted amount, copy it (with the Edit menu’s Copy
command) and paste it in another application that takes text. You can tab
between the first two fields. You can do many other things common to OpenStep
applications.

In this tutorial you’ll learn the basic things you must do to create a OpenStep
application. You will discover how to:

¢ Create a project.

e Create an interface.

e Create a custom subclass.

¢ Connect an instance of the custom subclass to the interface.

¢ Design an application using a common object-oriented design paradigm.

17
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By following the steps of this chapter, you will become more familiar with the
two most important OpenStep applications for program development: Interface
Builder and Project Builder. You will also learn the typical work flow of
OpenStep application development:

Note: Although this chapter -
discusses the design of the
application midway through the
tutorial, application design can take
place anytime in the early stages of
a project, and in fact is often
recommended as the first stage.

LTINS TTIIT

fix errors or
change
design.
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Creating the Currency Converter Project

Creating the Currency Converter Project

Launch Project Builder.
In File Viewer navigate to the
/NextDeveloper/Apps directory.

Select ProjectBuilder.app and
double-click its icon (at right).

Make a new project.
Choose New from the Project
menu (Project » New).

In the New Project panel,
select the project location.

Enter “CurrencyConverter” asthe
project name.

Click OK to create the project.

Every OpenStep application starts out as a project. A project is a repository for all
the elements that go into the application, such as source code files, makefiles,
frameworks, libraries, the application’s user interface, sounds, and images. You
use the Project Builder application to create and manage projects.

.

et

5}

When Project Builder starts up, only its main menu appears on the screen. You
must create or open a project to get Project Builder’s main window. The New
Project panel allows you to specify a new project’s name and location.

New Project

Often projects are kept in a common
directory.

g . |53
FaorelgnExchange - 1
GopherBop.
markyenref

i Q.W:Ne Legacy
Z1AlINewLibrary
OrientExpress.

The name specified here becomes the
; name of the project directory and the
. default name of the application itself.

Make sure Application is the project
type.

Project Builder creates a project directory named after the project—in this case
CurrencyConverter—and populates this directory with an assortment of ready-
made files and directories. It then displays its main window.

Note: Here’s a variation on project creation: Create a project directory using File
Viewer and then, in the New Project panel, navigate to that directory, type
“PB.project” in the Name field, and click OK.

19



Chapter 2

Currency Converter Tutorial

A makefile specifies file
dependency relations and
compiler and linker instructions
for building the project. See
OPENSTEP Development: Tips
and Technigues for common
changes to Makefile.preamble and
Makefile.postamble.

20

Command panel: Build,
Find, Loaded Files, Project
Inspector, Launcher/
Graphical Debugger.

Project browser. Each
“suitcase” is a project
resource category.

Done indexing project: Currency Converter.|

Code editor

Go ahead and click an item in the left column of the project browser (a grouping
of project resources sometimes called a “suitcase”); see what some of these

suitcases contain already:

o Other Sources: This suitcase contains CurrencyConverter_main.m, the main() routine
that loads the initial set of resources and runs the application. (Do not modify

this file!)

¢ Interfaces: This suitcase contains CurrencyConverter.nib, the file that contains the

application’s user interface. More on this file in the next step.

Supporting Files: 'This suitcase contains the project’s default makefiles and
template source-code files. You can modify the preamble and postamble
makefiles, but you must leave Makefile unchanged.

; Pfoiébt Inde)'(in'g” :

Usually indexing happens automatically
when you create or open a project. You can
turn off this option if you wish. Choose -
Preferences from the Info menu and then
choose the Indexing display. Turn off the -
“Index when project is opened” switch.

When you create or open a project, after
'some seconds you may notlce trlangular

code files the browser. Pro;ectBuﬂderhas
mdexed these f|Ies

You can also index a project at any time
- choosing Index Source Code from the
. Project menu. If you want to do without
“indexing (maybe you have memory
constramts) choose Purge Indlces from the
Pro;ect menu. :

Project Buﬂde to access pro;e
information quickly. Indexing is -
i md;spensable to such features as

completion and Pro;ect Find. (Mor
featureslater)




Creating the Currency Converter Interface

Creating the Currency Converter Interface

When you create an application project, Project Builder puts the main #ib file in
the Interfaces suitcase. A nib file is primarily a description of a user interface (or
part of a user interface). The main nib file contains the main menu and any
windows and panels you want to appear when your application starts up; at start-
up time, each application loads the main nib file.

At the beginning of a project, the main nib file is like a blank canvas, ready for
you to craft the interface. Look in the Interfaces suitcase for nib files.

Open the main nib file. . o . . .
To open, double-click the nib file name ...or double-click theicon  Palette window

Locate CurrencyConverter.nib in
the project browser.

Infg
Document T~

Double-click to open.

Title itent
il Mo

% ‘Cdmr@tybome ¥

-
v
v
Interfaces L
ages ™
:_§Olher Fasource ™

ContextHeip . 1 |71]
Supporting File © [
el

A nib file contains user-interface
objects, definitions of custom
classes, the connections between
objects, and sounds and images
that are used in the interface.
Besides the main nib file, you can
have nib files that you can load
whenever you need them. These
auxillary nib files, and the L When you first open the application’s main nib file,
techniques related to using them, Nib file window Interface Builder displays a blank window.

are described in the “To Do

Tutorial,” page 118. See By default, the window entitled “My Window” will appear when the application
OPENSTEP Development: Tools is launched.

and Technigues for an overview of
nib files.

Note: The Interface Builder application is located in /NextDeveloper/Apps. The icon
for the application is this:
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area on the screen in which an application displays contrals,
fields, text, and graphics. Windows can be moved around the
screen and stacked on top of each other.like pieces of paper. A
typical OpenStep window has a title bar, a content area, and
several control objects.

title bar
Miniaturize and close
buttons

resize bar

Many user-interface objects other than the standard window
depicted above are windows. Menus, pop-up lists, and pull-down
lists are primarily windows, as are all varieties of panels: attention
panels, inspectors, and tool palettes, to name a few. In fact,
anything drawn on the screen must appear in a window.

NSWindow and the Window Server -

Two interacting systems create and manage OpenStep windows. )
Onthe one hand, a window is created by the Window Server. The

Window Server is a process integrating the NeXT Wlndow
System and Display Postscript. The Window Server draws,
resizes; hides, and moves windows using Postscript primitives.
The Window Server also detects user events (such as mouse
clicks) and forwards them to appllcatlons !

The window that the Window Server creates is palred with an

 object supplied by the Apphcatmn‘;Km aninstance of the
_ . NSWindow class. Each physicalvyindovvin:an object-oriented
-program is managed by an instance of NSWindow (or subclass).

When you create an NSWindow ohject, the Window Server

- creates the physical window that the NSWindow object will

manage. The Window Server references the window by its
window number, the NSWindow by its own identifier.

Application, Window, View

and detect user events. )The NSApplication object keeps a ||st of

Avvindow in OpenStep looks very similarto windows in other user
- environments such as Windows or Macintosh. Itis a rectangular

system and establishes the base coordinate system for the views
of the window. Views draw themselves in coordinate systems
transformed from (and relative to} this base coordinate system.

its windows and tracks the current status of each. Each window,
on the other hand, manages a hierarchy of viewsii in additionto its
PostScript window.

Atthe “top” of this hierarchy is the content view,ywhich fits just

‘within the window's content rectangle. The content view

encloses all other view (its subviews), which come below itin the
hierarchy. The NSWindow distributes events to views in the
hierarchy and regulates coordinate transformations among them.

NSApp =
application object

Another rectangle, the frame rectangle, defines the outer
boundary of the window and includes the title bar and the
window’s controls. The lower-left corner of the frame rectangle
defines the window's location relative to the screen’s coordinate

See page 149 for more on the view hierarchy.

Key and Main Windows

Windows have numerous characteristics. They can be on screen
or off-screen. On-screen windows are Iayered" onthe screenin
tiers managed by the Window Server, On s een wmdows also

can carry a status: keyor mam ;

Key windows respond to key pressesf ] apphcatron and are
the primary recipient of action messages from menus and panels.
Usually a window is made key when the user clicks it. Key
windows have black title bars Each appllcatlon can have only
one key window. !

An application has one main wmdow whlch can often have key
status as well. The main window is the principal focus of user

“actions for an‘application. Often user actions in a modal key

window (typically a panel such as the Font panel or aninspector)
have a direct effect on the main window. In this case, thetrtle bar
of the main wmdow (when itis not key) IS a dark gray.
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2 Resize the window.

3 Setthe window's title and
attributes.
Click the window to selectiit.
Choose Tools» Inspector.

Select the Attributes display from
the pop-up list.

Enter the window title.

Turn off the resize option.

Make the window smaller by
dragging an edge of the window
inward from a resize handle.

Betweenthe two resize handles
is the resize bar, which permits
only vertical resizing.

R Vi e I B

Most objects on an interface have attributes that you can set in the Inspector
panel’s Attributes display.

The title of the major window in
an application is often the
application name.

When this option is turned off,
the windows's resize bar
disappears.
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Put palette objects on the window using the “drag and drop” technique.

Put a text field on the interface
and resize and initialize it.
Click this icon to select the Views
palette. This palette contains an
assortment of commonly used objects.

Select the Views palette.

Drag a text field from the palette

onto the window.
Drag a text field and drop it (that is,
release the mouse button) over the
‘surface” of the window.
To initialize the text field, double- You must get rid of the word “Text” in this field; otherwise, that’s what the field
click “Text” and press Delete. will show when the nib file is loaded.
The text field should be longer so it can hold more digits (you’re dealing with
millions here):
Lengthen the text field.

Drag a resize handle in the direction
you want the object to grow.

Currency Converter needs two more text fields, both the same size as the first.
You have two options: you can drag another object from the palette and make it
the same size; or you can duplicate the first object

24
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5 Duplicate an object. [ currency Converter . =

The new text field appears slightly offset
from the original field, Reposition it under the
first text field.

Select the text field.
Choose Edit » Copy.
Choose Edit » Paste.

Get the third field from the palette and make it the same size as the first field.

6 Make objects the same size. [ currency Converter: -~ > ¢
’ ' The first object you select should have the
dimensions you wantthe other objects in the
selection to take.

Drag a textfield onto the window.
Delete “Text” from the text field.
Select the first text field.

Shift-click to select the new text
field.

Choose Format » Size » Same
Size

Shift-click multiple objectstoinclude themin
the same selection.

You’re not done yet with these text fields. The bottom text field displays the
result of the computation. It should not be editable and therefore should, by
convention, have a gray background.

7 Change the attributes of a text Click these
field. buttons to get
the grayscale

Select the third text field. palette.

Choose Tools» Colors.

Drag the gray color into this well to set
the background color.

Select the grayscale palette of
the Color panel.

Select the gray color that is the
same as the window background.

Click to get the color that blends the text
field into the window background.

Choose Tools ™ Inspector.

Select the Inspector panel's
Attributes display.

With the Editable attribute turned off,
users cannot alter the contents of the
text field.

Drag the gray color fromthe Color
panel into the Background Color
well.

Turn off the Editable and
Scrollable options.

Keep Selectable as an option so the user
can select, copy, and paste the result to
other applications.

The Views palette provides a “Title” object that you can easily adapt to be a

text-field label. (The title object is actually a text field, set to have a gray
background and no border, and to be non-editable and non-selectable.) Text in
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the title object is centered by default, but labels are usually aligned from the
right.

Assign labels to the fields.

Drag a title object onto the
window.

Double-click to select the text
“Title”,

Choose Format »Text » Align
Right to align the text from the
right.

The text is highlighted when it is selected.

The size of the text is rather large for a label, so change it. You set font family,
typeface, and size with the standard OpenStep Font panel.

Make sure the object’s text is
selected.

Choose Format » Font » Font
Panel.

Set the label text to 16 points.
Make two copies of the label.

Position all labels to the left of
their text fields.

The font of this object is 18 point Helvetica.
Click here and then click the Set button to set
the font size to 16 points.

When you cut and paste objects that contain text, like these labels, the object
should be selected and not the text the object contains; if the text is selected,
de-select it by clicking outside the text, then click the object again to select it.

Type the text of each label.

Dallars to : Double-click to selecttitle, then type the text
. of the label in place of the selection.

7

|
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9 Add a button to the interface and
initialize it.

Drag the button object from the
Views palette and putit on the

lower-right corner of the window.

Make the button the same size as
atextfield.

Change the title of the button to
“Convert”.

Select the Images display of the
nib file window.

Drag the NSReturnSign image to
the main window and drop it over
the button.

~ Exchange Rate per$1:]
Dollars ta Convert;

Amount in Other Currency:

[ B B
w Buttan

You can resize buttons the same way you resize
text fields or any other object on a window.

Double-click the title of the button to select it.

You can easily give the button the capacity for responding to carriage returns in

addition to mouse clicks.

Select a display of the nib file window
by clicking a tab.

' Currency Converter T[rx

Exchange Rate per$1: | “““‘"’

After you drop the image
over the button, the image
appears (by default) to the
right of the button title.

If you check the attributes of the button in the Inspector panel, you’ll notice two
things have been added: NSReturnSign is now listed as the button’s icon, and the
Key field contains the escape sequence for a carriage return (\r).

You’ve probably noticed that the final interface for Currency Converter (shown
on the first page of this chapter) has a decorative line between the text fields and

the button. This line is easy to make.
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Create a horizontal decorative
line.

Drag a box abject from the Views
palette onto the interface.

Bring up the Attributes display for
the box (Command-1), select No
Title, and set the Vertical Offset to
zero.

Drag the bottom-middle resize
handle of the box upward until the
horizontal lines meet.

Position the line above the button.

Drag the end points of the line
until the line extends across the
window.

28

Currency Converter

Drag upward until lines merge into one line.

For a black line (instead of white) click here.

Aligning on a Grid

You can align objects on a window by

imposing a grid on the window. When you

- move ob]ects in this grid, they “snap” to the

“of mo

L HSBox Inspectar .

As you might have noticed, the Currency Converter has a main menu that holds,
by default, the commands Info, Hide, and Quit, and the Edit, Services, and
Windows menus. The menus contain ready-made sets of commands. The Edit
menu includes commands for cutting, copying, and pasting text. The Windows
menu lists the titles of open windows as well as common window commands.
The Services menu allows your application to communicate with other
applications, often with no work on the part of your application. For example, if
your application handles text, you can use the Services menu to transfer
information to other applications that accept text.

nearest grid intersection like nails to a

magnet. You set the edges of alignment and
the spacing of the grid (in pixels) in the
Alignment panel. Choose Format » Align »
Alignment to display this panel.

Be su:re the gridis turned on before you move
objects (Format »Align ™ Turn Grid On).

You can move selected user-interface -
objectsin Interface Builder by pressing an -
arrow key Whenthe gridisturned onthe unit
entis whatever the grid s setto {in
pixels). Whenthe gnd isturned off the unitof
movement is one pi
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11 Align the text fields and labels in

rows and columns.

Select the three text fields and
choose Format » Align » Make
Column.

Select the first text field and its
label and choose Format »
Align » Make Row.

Repeat the last step for the
second and third text fields and
their labels.

The nextKeyView variable is an
outlet. An outlet is the identifier of
an object that another object
stores as an instance variable.
Outlets enable communication
between objects. See page 40 for
more information on outlets.

Currency Converter’s interface is almost complete. One finishing touch might
be to align the text fields and labels in neat rows and columns. Interface Builder
gives you several ways to align selected objects on a window.

Dragging objects with the mouse

Pressing arrow keys (with the grid off, the selected objects move one pixel)
Using a reference object to put selected objects in rows and columns
Specifying origin points in the Size display of the Inspector panel

Using a grid (see preceding side bar)

For Currency Converter, use the columns-and-rows technique.

COLUMNS

Firstselect the object whose vertical position
the other objects should adopt (the reference
object).

Exchange Rate per$1:

Dollars to Convert:

Amount in Other Cur rency: Shift-click the other objects to include them in

the selection.

Making a column evens the spacing between
objects in the selection.

Canven

ROWS

When you make a row, the selected objects
rest on a common horizontal baseline.

The final step in composing the Currency Converter interface has more to do
with behavior than appearance. You want the user to be able to tab from the first
editable field to the second, and back again to the first. Many objects on
Interface Builder’s palettes have an instance variable named nextKeyView. This
variable identifies the next object to receive keyboard events when the user
presses the Tab key (or the previous object if Shift-Tab is pressed). If you want
inter-field tabbing you must connect fields through the nextKeyView variable.
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Enable tabbing between text
fields.

Select the first text field.

Control-drag a connection line
from it to the second text field.

In the Inspector panel
(Connections display) select
nextKeyView and click Connect.

Repeat the same procedure,
going from the second to the first
field.

30

When you press Control and drag the mouse
from an object, a connection line is drawn.

When a line encloses the destination object,
release the mouse button.

When you make a visual connection such as this, Interface Builder brings up the
Connections display of the Inspector panel:

HSTextField Inspector

The nextKeyView outltet identifies the next object to
respond to events after the Tab key is pressed.

Connections

TnexikeyView NSTexlField
: ey ;

Be sure to click the Connect button to confirm the
connection (the button title then changes to Disconnect).

Don’t connect the nextKeyView outlet of the “Amount in Other Currency” field;
this field is not supposed to be editable.
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13 Test the interface. . The CurrencyConverter interface is now complete. Interface Builder lets you

test an interface without having to write one line of code.
Choose Document » Save to

save the interface to the nib file. Note: You can also exit from test mode by double-clicking the Interface Buildfer
Choose Document » Test icon, which changes to the following image to represent test mode:

Interface.

Try various operations in the & )

interface (see suggestions on the
following page).

When finished, choose Quit from
the main menu.
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The simplest OpenStep application, even one without a line of could also have setthe a sizing attributes of the window and
code added to it, includes a wealth of features that you get “for its views so that the window’s objects would resize proportionally
free”: You do nothave to program these features yourself. Youcan ~ to the resized window or would retain their initial size (see
see this when you test an interface in Interface Builder. OPENSTEP Programming: Tools and Techniques for details on
auto-resizing).

" To enter test mode, choose Test Interface from the Document
menu. Interface Builder simulates how your application {in this - -
case, Currency Converter) would run, minus the behavior added ~ Controls and Text

by custom classes. Go ahead and try things out: move your :
windows, type in fields, click buttons. The buttons and textfields of Currency Converter come with many

built-in behaviors. Click the Convert button. Notice how the button
Application and Window Behavior is highlighted momentarily
Intest mode Currency Converter behaves almost like any other
application on the screen. Click elsewhere on the screen, and
Currency Converter is deactivated, becoming totally or partially
obscured by the windows of other applications. If you had buttons of a different style, such as radio buttons, they
would also respond in characteristic ways to mouse clicks.

Now click in one of the text fields. See how the cursor blinks in
place. Type some text and selectit. Use the commands in the Edit
menu to copy it and paste it in the other text field.

Do you recall the nextKeyView connections we made between
Currency Converter's text fields? While a cursor is in a textfield,
press the Tab key and watch the cursor jump from field to field.

When You Add Menu Commands

An application you design in Interface Builder can acquire extra
functionality with the simple addition of a menu command or
submenu. You've already seen what you getwith the Services and
Windows menu, both included by default. You can add other
commands and submenus to the main menu for “free”
functionality without compilation. For example:

Reactivate Currency Converter by clicking on its window or by
double-clicking its icon (the default terminal icon) in the
workspace. Move the window around by its title bar.

Here's some other tests you can make: R R S : )
- , ) » The Font submenu adds behavior for applying fonts to text in

* Click the Edit submenu in Currency Converter's main menu. It NSText objects, such as the one in the scroll view object n the
expands and contracts as in any application. DataViews palette. Your apphcatnon gets the Font paneland a

font-managerobject forfree

" Click the miniaturize button or choose the Hide command.

Double-click the document icon to get the window back. o The Text submenu allows youto allgn text anywhere there is

« Click the close box and the Currency Converter Window editable text, and to display a ruler in the NSText objectfor
disappears. (Choose Quit from the main menu and re-entertest tabbing, indentation, and allgnmen
mode to get the window back.)

Many objects that display text or images can print their conte
ata. Later you'll learn how to add the Print menu

if we had configured Currency Converter's window in Interface
' command and have it invoke this capability.

Builder to retain the resize bar, we could also resize it now. We
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An OpenStep Application — The Possibilities

An OpenStep application can do an impressive range of things
without a formidable programming effort on your part.

Document Management

Many applications create and manage semi-autonomous objects
called documents. Documents contain discrete sets of
information and support the entry and maintenance of that
information. A word-processing document is a typical example.
The application coordinates with the user and communicates
with its documents to create, open, save, close and otherwise
manage them.

The final tutorial in this book describes how to create an
application based on a multi-document architecture.

File and Account Management

An application can use the Open panel of the Application Kit to
help the user locate files in the file system and open them. It can
also make the Save panel available for saving information in files.
NeXT's version of OpenStep also provides classes for managing
filesin the file system (creating, comparing, copying, moving, and
so forth} and for managing system-account information and user
defaults.

Communicating With Other Applications

OpenStep gives an application several ways of communicating
information to and from other applications:

* Pastehoard: The pasteboard is a global facility for sharing
information among applications. Applications can use the
pasteboard to hold data that the user has cut or copied and
may paste into another application.

» Services: Any application can avail itself of the services
provided by another application, based on the type of the
selected data (such as text). An application can also provide
services to other applications such as encryption, language
translation, or record-fetching. ;

* Drag-and-drop: If your application implements the proper
protocol, users can drag objects to and from the interfaces of
other applications.

Editing Support

You can get several panels (and associated functionality) when
you add a submenu to your application’s main menu in Interface
Builder. These “add-ons” includes the Font panel (and font

management), the Color panel {and color management), and,
although it's nota panel, the text ruler and the tabbing and
indentation capabilities it provides.

Formatter classes enable your application to format numbers,
dates, and other types of field values. Support for validating the
contents of fields is also available.

Printing and Faxing

With just a simple Interface Builder procedure, OpenStep
automates simple printing and faxing of views that contain text or
graphics. When a user clicks the control, an appropriate panel
helps to configure the print or fax process. The output is
WYSIWYG.

Several Application Kit classes give you greater control over the
printing of documents and forms, including features such as
pagination and page orientation.

Help

You can create a help system for your application using Interface
Builder, Project Builder, and an RTF text editor (such as Edit). The
Application Kitincludes an class for context-sensitive help. If the
user clicks an object onthe application’s interface while pressing
a Help key, a small window is displayed containing concise
information on the object.

Custom Drawing and Animation

OpenStep lets you create your own custom views that draw their
own content and respond to user actions. To assist you in this,
OpenStep provides image-compositing and event-handling API
as well as PostScript operators, operator functions, and chent
library functions.

Plug and Play

You can design some applications so that users can incorporate- -

new modules later on. For example, a drawing program could
have a tools palette: pencil, brush, eraser, and so.on. You could-
create a new tool and have users install it. When the applucatlon
is next started, this tool appears inthe palette.
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Designing the Currency Converter Application

An object-oriented application should be based on a design that identifies the
objects of the application and clearly defines their roles and responsibilities. You
normally work on a design before you write a line of code. You don’t need any
fancy tools for designing many applications; a pencil and a pad of paper will do.

Currency Converter is an extremely simple application, but there’s still a design
behind it. This design is based upon the Model-View-Controller paradigm, a
model behind many designs for object-oriented programs (see “The Model-
View-Controller Paradigm” on page 36). This design paradigm aids in the
development of maintainable, extensible, and understandable systems. But
first, you might want to read the sidebar below to understand the symbol used
in the design diagram.

Note: This design for Currency Converter is intended to illustrate a few points,
and so is perhaps overly designed for something so simple. It is quite possible to
have the application’s controller class, ConverterController, do the computation
and do without the Converter class.

i lee a Jelly Donut

ThlS book deplcts ob;ects as fdled and segmented "donuts i Why and may return data to the requestmg object As the symbol
this unhkely shape? “suggests, an object’s methods do the encapsulating, in effect -
- mediating access to the object's data. An object’s methods are
 also its interface, articulating the ways in which the object
- communicates with the world outside it.

The donut symbol also helps to convey the modularity of objects.
* Because an object encapsulates a defined set of data and logic,
you can easily assign it to parttcular duties with 'a'program
- Conceptually, it |sI|keafunctlonalunlt—for instance, “Customer
- Record"—that you can move around on a design board; you can

: Th'S symbol ullustrates data encapsulation, the essential ~ then plot communication paths to and from other objects based
charactenstm of ob;ects:An object consxsts of both data and " ontheir interfaces.

; Seethe appendlx "Object Oriented Progtamming; forafuller .
% descnp’uon of data encapsulatlon messages, methods and other
' properties ofobjects
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You can divide responsibility within Currency Converter among two custom
objects and the user interface, taken as a collection of ready-made Application
Kit objects. The Converter object is responsible for computing a currency
amount and returning that value. Between the user interface and the Converter
object is a controller object, ConverterController. ConverterController coordinates
the activity between the Converter object and the Ul objects.

Qurvency Converter: >

Exchange Rate per $1

Dollars to Convert:|200

Amount in Qther Currency:|g ] :

ConverterController

Converter

The ConverterController class assumes a central role. Like all controller objects,
it communicates with the interface and with model objects, and it handles tasks
specific to the application, such as managing the cursor. ConverterController
gets the values users enter into fields, passes these values to the Converter
object, gets the result back from Converter, and puts this result in a field in the
interface.

The Converter class merely computes a value from two arguments passed into
it and returns the result. As with any model object, it could also hold data as well
as provide computational services. Thus, objects that represent customer
records (for example) are akin to Converter. By insulating the Converter class
from application-specific details, the design for Currency Converter makes it
more reusable, as you’ll see in the Travel Advisor tutorial.
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- A common and useful paradigm for object-oriented applications,
particularly business applications, is Model-View-Controller

- (MVC). Derived from Smalltalk-80, MVC proposes three types of
objects in an application, separated by abstract boundaries and
communicating with each other across those boundaries.

Model Objects

This type of object represents special knowledge and expertise.
Model objects hold a company’s data and define the logic

that manipulates that data. For example, a Customer object,
common in business applications, is a Mode! object. It holds data
describing the salient facts of a customer and has access to
algorithms that access and calculate new data from those facts.

A more specialized Model class might be one in a meteorological

system called Front; objects of this class would contain the data
and intelligence to represent weather fronts. Model objects are
not displayable. They often are reusable, distributed, persistent,
and portable to a variety of platforms. :

View Objects

5 A View object in the paradigam represents something visible on
the user mterface {a window, for example, or a button). A View
ob|ect is |gnorant of the data |t displays. The Apphcatlon Kit

cts within a wmdow in novel ways specific to an
ew objects especna!ly those in kits, tend to be very
d.so provide consistency between apphcatm,ns
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" ‘establishes and maintains a correspondence between an_
~ enterprise object class and data stored in a relation:

Controller Object

Acting as a mediator between Model objects and View objects in
an application is a Controller object. There is usually one per
application or window. A Controller object communicates data
back and forth between the Model objects and the View objects.
It also performs all the application-specific chores, such as
loading nib files and acting as window and application delegate.
Since what a Controller does is very specific to an application, it
is generally not reusable even though it often comprises much of
an application’s code. (This last statement does not mean,
however, that Controller objects cannotbe reused; with a good
design, they can.)

Because of the Controller's central, mediating role, Model
objects need not know about the state and events of the user
interface, and View objects need not know about the
programmatic interfaces of the Model objects. You can make your
View and Model objects available to others from a palette in
Interface Builder.

Hybrid Models

MVC, strictly observed, is not advisable in all circumstances.
Sometimes its best to combine roles. For instance, in a graphics-
intensive application, such as an arcade game, you might have
several View objects that merge the roles of View and Model.

In some applications, especially simple ones, you can combine
the roles of Controller and Model; these objects join the special
data structures and logic of Model objects with the Controller’s
hooks to the interface.

A Note on Terminology

The Application Kit and Enterprise Objects Framew{jfk reserve
special meanings for “vew object” and * model "AView objectin
the Application Kit denotes a user-lnterface object that inherits

from NSView. In the Enterprise Oblects Fram work, a model

This book uses “model object only within the
Model-View-Controller paradqgm. E




Defining the Classes of Currency Converter

Defining the Classes of Currency Converter

Specify a subclass.
Go to the Classes display of the
nib file window.

Select NSObject, the superclass
of your custom classes.

Choose Subclass from the pull-
down Operations menu.

Class Versus Object

Interface Builder is a versatile tool for application developers. It enables you not
only to compose the application’s graphical user interface, but it gives you a way
to define much of the programmatic interface of the application’s classes and to
connect the objects eventually created from those classes.

You must go to the Classes display of the nib file window to define a class. Once
there, the first thing you must do is select the superclass, the class your new
subclass will inherit from.

Let’s start with the ConverterController class.

Click to select the Classes display.

J IBInspa C
5 IBPalelt

__ B MyNSO

'D W3Amay
o NSCe

‘0 NSFontManager

menu generates a new subclass.

After you choose the Subclass command, “MyNSObject” appears under
“NSObject” highlighted.

To newcomers to the subject, explanations of object-oriented
programming might seem to use the terms “object” and “class”
interchangeably. Are an object and a class the same thing? And if
not, how are they different? How are they related?

An object and a class are both programmatic units. They are
closely related, but serve quite different purposes in a program.

First, classes provide a taxonomy of objects, a useful way of
categorizing them. Just as you can say a particular tree is a pine
tree, you can identify a particular object by its class. You can
thereby know its purpose and what messages you can send it. In
other words, a class describes the type of an object.

Second, you use classes to generate instances —or objects.
Classes define the data structures and behavior of their
instances, and at run time create and initialize these instances.
Inasense, aclassis Ilke afactory, stampmg out mstances of itself

when requested:

What especially differentiates a class from its instance is data. A
instance hasits own unique set of data but its class, strictly
speaking, does not. The class defines the structure of the data its
instances will have, but only instances can hold data.

A class, on the other hand, implements the behavior of all of its
instances in a running program. The donut symbol used to
represent objects is a bit misleading here, because it suggests
that each object contains its own copy of code. This is fortunately
not the case; instead of heing duplicated, this code is shared
among all current mstances inthe program. :

Implicit in the notion of a taxohomy is inheritance, a key property
of classes. Classes exist in a hierarchical relationship to ane
another, with a subclass inheriting behavior and data structures
from its superclass, whlch in turn inherits from its superclass

See the appendix, * Ob]ect-l]nented Programming,” for more on
these and other aspects of classes

NSObject, the root class, is the class that
ConverterController will inherit from.

The Subclass command in this pull-down
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Enter the name of the subclass:

ConverterController. After you name the class, it appears

indented under its superclass in
alphabetical order.

Press Return.

To see subclasses of a class, click a filled
button (ifthe button is unfilled, there are no
subclasses).

NSCell, for example, has several levels of
subclasses; each level is indicated by
indenta_tian.

Now your class is established in the hierarchy of classes within the nib file. Next,
specify the paths for messages travelling between the ConverterController
object and other objects. In Interface Builder you specify these paths as owusless
and actions.

Before You Go On

Here’s some basic terminology:

Outlet An object held as an instance variable and typed as id. Objects in
See Paths for Object applications often hold outlets as part of their data so they can send messages to
Communication: Outless, Targess, the objects referenced by the outlets. An outlet lets you keep track of or

and Actions on page 40. for a more . L.
detailed description of outlets manipulate something in the interface.

and actions. See page 103 for
more on control objects and their
relation to cells and formatters. object).

id The generic (or dynamic) type of objects (technically the address of an

Action Refers both to a message sent to an object when the user clicks a button
or manipulates some other control object and to the method that is invoked.

Control object A user-interface object (a device) with which users can interact to
affect events in the application. Control objects include buttons, text fields,
forms, sliders, and browsers. All control objects inherit from NSControl.
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2 Define your class's outlets.

In the nib file window, click the
electrical-outlet icon to the right
of the class.

Choose Add Outlet from the
Operations pull-down menu

Type the name of the outlet over
the highlighted “myQutlet.” Name
the first outlet rateField.

Press Return.

Repeat the last three steps to
define two other outlets:

dollarField
totalField

3 Define your class’s actions.

In the Classes display of the nib
file window, click the crosshairs
icon.

Choose the Add Action command
from the Operations pull-down
menu.

Type the name of the action
method, convert:.

Press Return.

'8 currency Converter.niy —

-
iR

ConverterController
Qutlets

by Gutie]

Actions
tRaspondsr

CanverterControfler
- Qutiets o
doftarField

IFiel

Click here to begin specifying outlets.

“Outlets” appears indented underneath,
highlighted (not shown).

Instead of choosing Add Outlets from the
Operations menu, you can press Return
when “Outlets” is highlighted to add an
outlet.

ConverterController has one action method, convert.. When the user clicks the
Convert button, a convert: message is sent to the target object, an instance of

ConverterController.

The crosshairs suggest the “target” in the
target/action paradigm.

After you chose Add Action “myAction”
appears indented under “Actions.”

You only need to type convert here—
Interface Builder adds the colon.

Before You Go On

Add an outlet: ConverterController needs to access the text fields of the interface,
so you’ve just provided outlets for that purpose. But ConverterController must
also communicate with the Converter class (yet to be defined). To enable this
communication, add an outlet named converter to ConverterController.
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Outlets r ) : o , ,'When You Make a Connectlon m Interface Bmlder

~ An outletis an instance variable that identifies,ah object. - As with any mstance varlable, outlets must be initialized at run - ’

o o i . time'to some reasonable value—in this case, an object’s ldentlfler )
(id value). Because of Interface Builder, an application can
initialize outlets when it loads a nib file.

outlet

When you make a-connection in Interface Builder, a special
connector object holds information on the source and destination
objects of the connection. (The source object is the object with
the outlet.} This connector object is then stored in the nib file.
When a nib file is loaded, the application uses the connector
object to set the source object’s outlet to the identifier ofthe
destination object.

You can communicate with other objects in an apphcatmn by Itmight help to understand connections by imagining an electrical

sendlng messages to outlets. ~ Sl g outlet (as used in the Classes display of the nib file window)
, ‘embedded in the destination object. Also picture an electrical
An outlet can reference any objectin an application: user- - cord extending from the outlet in the source object Before the -
interface objects such as text fields and buttons, windows and connection is made the cord is unplugged and the value of
panels, instances of custom classes, and even the application destination is undefined; after the connection is made (the cord is
object itself. plugged in), the id value of the destination object is assigned to
the destination outlet

anObject

source destination

Outlets are declared as:

id anObject;

You can use id as the type for any object; objects with id as their
type are dynamically typed, meaning that the class of the objectis
determined at run time. You can statically type an object aska"
pointer to a class name; you can declare these objects as
instance variables, but they are not outlets. What distinguishes
outlets is their relationship to Interface Builder.

Interface Builder can “recognize” outlets in code by their
declarations, and it can initialize outlets. You usually set an
outlet’s value in Interface Builder by drawing connection lines
between objects. There are ways other than outlets to reference
objects in an application, but outlets and. lnterface Bmlders
facmty for initializing them are a convemence
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Target/Action in Interface Builder—What's Going On

As you'll soon find out, you can view (and complete) target/action
connections in Interface Builder's Connections inspector. This
inspector is easy to use, but the relation of target and action in it
might notbe apparent. First, target is an outlet of a cell objectthat
identifies the recipient of an action message. Well (you say)
what’s a cell object and what does it have to do with a button?—
that’s what I'm making the connection from.

One or more cell objects are always associated with a control
object (thatis, an object inheriting from NSControl, such as a
button). Contro! objects “drive” the invocation of action methods,
but they get the target and action from a cell. NSActionCell
defines the target and action outlets, and mostkinds of cells inthe
Application Kit inherit these outlets.

/st S

inherits

(Instance variables:
SEL _action:
id _target;

NSActionCell

i g o, - k

I Revert 1] if Connect v‘cfl

For example, when a user clicks the Convert button of Currency
Converter, the button gets the required information from its cell
and sends the message convert: to the target outlet, which is an
instance of your custom class ConverterController.

In the Actions column of the Connections inspector are all action
methods defined by the class of the target object and known by
Interface Builder. Interface Builder identifies action methods
because their declarations follow the syntax:

-~ {void)doThis: (id) sender;

Itlooks in particular for the argument sender.

Which Direction to Connect?

Usually the outlets and actions that you connectbelongto a
custom subclass of NSObject. For these occasions, you need only
follow a couple simple rules to know which way to draw a
connection line in Interface Builder:

* To make an action connection, draw a line to the custom
instance from a control objectin the user interface, such as a
button or a text field.

* To make an outlet connection, draw a line fromthe custom
instance to another objectin the application.

Another way to clarify connections is to consider who needs to
find whom. With outlets, the custom object needs to find some
other object, so the connection is from the custom objectto the
other object With actions, the control object needs to find the
custom object, so the connection is from the control object.

These are only rules of thumb for the common case, and do not
applyin all circumstances. For instance, many OpenStep objects
have a delegate outlet; to connect these, you draw a connection
line from the OpenStep object to your custom object.

@\ oction
; Convert \ ¢ﬂ[

myController

41




Chapter2 Currency Converter Tutorial

Connecting ConverterController to the Interface

As the final step of defining a class in Interface Builder, you create an instance
of your class and connect its outlets and actions.

} Generate an instance of the ~irterfEnglishiproj [ 30

class.

In the Classes display, select the

Click the class name to collapse outlets and
ConverterController class.

actions. If they are already collapsed, make
sure your subclass is selected.

Choose the Instantiate command
from the Operations pull-down
menu.

Choose this command to generate an
instance of your custom class.

Instantiate

Note: The Instantiate command does not generate a true instance of
ConverterController, but creates a stand-in object used for establishing
connections. When the nib file’s contents are unarchived, Interface Builder will
create true instances of these classes and use the proxy objects to establish the
outlet and action connections.

When you instantiate a class (that is, create an instance of it), Interface Builder
switches to the Instances display and highlights the new instance, which is
named after the class.

Now you can connect this ConverterController object to the user interface. By
connecting it to specific objects in the interface, you initialize your outlets.
ConverterController will use these outlets to get and set values in the interface.
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5 Connect the custom class to the
interface via its outlets.

Inthe Instances display of the nib
file window, Control-drag a
connection line from the
ConverterController instance to
the first text field.

Whenthefield is outlined in black,
release the mouse button.

Inthe Connections display, select
the outlet that corresponds to the
first field (rateField).

Click the Connect button.

Following the same steps,
connect ConverterController's
dollarField and totalField outlets
to the appropriate text fields.

Control-drag from an object with defined
outlets Joften an instance of a custom
class).

Currency Converter

Dollars to Convert: | - |

Amount in Other Currency:

Exchange Rate per$1:|| E———-—

When a blackline encloses an object, it will
be selected as the destination object of the
connection if you release the mouse
button.

Interface Builder brings up the Connections display of the Inspector panel. This
display shows the outlets you have defined for ConverterController.

Custom Object Inspector

Outlets of the destination object appear
under this column of the Connections
display.

When you click Connect the connection
appears here, including the class of the
destination object.

To receive action messages from the user interface—to be notified, for example,
when users click a button—you must connect the control objects that emit those
messages to CurrencyConverter. The procedure for connecting actions is similar
to that for outlets, but with one major difference. When you connect an action,
always start the connection line from a contro/ object (such as a button, text field,
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or form) that sends an action message; you usually end the connection at an
instance of your custom class. That instance is the zz7gef outlet of the control

object.
6 Connect the interface’s controls Qurrency Convertar
to the custom class via its i -
actions.

Control-drag a connection line
from the Convert button to the
ConverterController instance in

the nib file window.
. . . The source object of an action connection
When the instance is outlned in must be a control object

black, release the mouse button..

When a black line encloses an object, it will
be selected as the destination object of the
connection if you release the mouse
button.

The Connections display of the Inspector panel shows the action methods you
have specified for ConverterController.

In the Connections display, make
" sure target in the Outlets column

is selected.

. . L Actions Ifyou had defined other actions for
Select convert: in the Actions [ - onvert: ~ ConverterController, they would have
column. ) Kay appeared in this column.

Click the Connect button.

Save the CurrencyConverter nib
file (Document » Save).

Interface Builder allows you to set these
outlets directly for buttons.

Make sure that you click here to establish
the connection.

You’ve finished defining the classes of Currency Converter—almost.
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Before You Go On

Define the Converter Class: While connecting ConverterController’s outlets, you
probably noticed that one outlet remains unconnected: converter. This outlet
identifies the instance of the Converter class in the Currency Converter
application, which doesn’t exist yet.

Define the Converter class. This should be pretty easy because Converter, as
you might recall, is a model class within the Model-View-Controller paradigm.
Since instances of this type of class don’t communicate directly with the
interface, there is no need for outlets or actions. Here are the steps to be
completed:

1. In the Classes display, make Converter a subclass of NSObject.
2. Instantiate the Converter class.
3. Make an outlet connection between ConverterController and Converter.

When you are finished, save CurrencyConverter.nib.

Optional Exercise

Text fields and action messages: The NSReturnsign image that you embedded carlier in
the Convert button indicates that users can activate this button by pressing the
Return key. In Currency Converter this key event occurs when the cursor is in
a text field. Text fields are control objects just as buttons are; when the user
presses the Return key and the cursor is in a text field, an action message is sent
to a target object if the action is defined and the proper connection is made.

Connect the second text field (that is, the one with the “Dollars to Convert”
label) to the convert: action method of ConverterController. You won’t be
disconnecting the prior action connection because multiple control objects in an
interface can invoke the same action method.
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Implementing the Classes of Currency Converter

Interface Builder generates source code files from the (partial) class definitions
you’ve made. These files are “skeletal,” in the sense that they contain little
more than essential Objective-C directives and the class-definition information.
You’ll usually need to supplement these files with your own code.

In Interface Builder, generate
header impl i .
der and implementation files Click here to bring up the Classes display.
Go to the Classes display of the
nib file window. Make sure your class is selected before

Select the ConverterController choosing Create Files.

class.

Choose Create Files from the -
Operations pull-down menu.

When a Create Files panel is
displayed, click Yes.

Click Yes to confirm that you want the
header and implementation files for the
class created. Interface Builder files have
an extension of .h and implementation files
an extension of .m.

A second Create Files panel is
displayed; click Yes again.

Repeat for the Converter class.
Save the nib file.

Click Yes to confirm that you want the
source code files added to the project in
Project Builder. If, for example, you wanted
to add the files to another project, you
would click No.

Now we leave Interface Builder for this application. You’ll complete the
application using Project Builder.
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2 Examine an interface (header)
file in Project Builder.

Hide Interface Builder and
activate Project Builder.

Click Headers in the project
browser.

Select ConverterController.h.

3 Add a method declaration.
Select Converter.h in the project
browser.

Insert a declaration for
convertAmount:byRate:.

Project Builder imports the
Application Kit header files,
which import the Foundation
header files.

(#import includes files only if
they haven't already been
included.)

Interface definitions begin
with @interface and the class
name. The superclass appears
after the colon.

ginterfece ConverterController : NSObject

1d converter; Instance variables (here the
ig :&eﬁ};{d: —J outlets defined in Interface
1 et Builder) go between the

braces.

Method declarations follow the
second brace. The declaration
of the action method you
specified in Interface Builder is
inserted. The definition ends
srrsenresennsenansnsnssssasasasanrees with @end.

- (void)convert:(id)sender;
gend

You can add instance variables or method declarations to a header file generated
by Interface Builder. This is commonly done, but it isn’t necessary in
ConverterController’s case. But we do need to add a method to the Converter
class that the ConverterController object can invoke to get the result of the
computation. Let’s start with by declaring the method in Converter.h.

#import <AppKit/AppKit.h>
#import <Foundation/Foundation.h>

@interface Converter:NSObject

{

}

- (float)convertAmount: (float)rate byRate: (float)amt;

@end

This declaration states that convertAmount:byRate: takes two arguments of type float,
and returns a float value. When parts of a method name have colons, such as
convertAmount: and byRate:, they are 4gywords which introduce arguments. (These
are keywords in a sense different from keywords in the C language.) Most
method declarations begin with a dash (-), followed by a space.

Now you need to update both implementation files. First examine Converter.m.
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4  Examine an implementation file.
Click Classes in the project 3K[§:I (=7 R L

browser.

_ Converterm

§j-convartAmountt

Select Converter.m. &
Other Sources

The associated header file is
imported automnatically.

a‘o‘mernasouma A
Subprojects 3
¥} context He!

CEREIR

. Class implementations begin
with @implementation and
the class name.

“ simport “Converter.h"

@inpleaentation Converter

Put implementations of
/ methods between
€end @implementation and @end.

For this class, implement the method declared in Converterh. Between
@implementation Converter and @end add the following code:

5 Implement the classes.
- (float)convertAmount: (float)amt byRate: (float)rate

Type the code at right between {
@implementation and @end in return (amt * rate);
Converter.m. }

The method simply multiplies the two arguments and returns the result. Simple
enough. Next update the “empty” implementation of the convert: method that
Interface Builder generated.

Select ConverterController.m in

the project browser - (void)convert: (id) sender

Update the convert: method as { float rate, amt, total;

shown by the example.

Import Converter.h. amt = [dollarField floatValue]; /¥ 1%/
rate = [rateField floatvaluel; ;
total = [converter convertAmount : amt byRate:rate]; /* 2 */
[totalField setFloatValue:total]; /* 3 */
[rateField selectText:self]; /* 4 */

} | i

The convert: method does the following;:

1. Gets the floating-point values typed into the rate and dollar-amount fields
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2. Invokes the convertAmount:byRate: method and gets the returned value.

3. Uses setFloatValue: to write the returned value in the Amount in Other
Currency text field (totalField).

4. Sends selectText: to the rate field; this puts the cursor in the rate field so the
user begin another calculation.

Be sure to #import “Converterh”—ConverterController invokes a method defined
in the Converter class, so it needs to be aware of the method’s declaration.

Before You Go On

Each line of the convert: method shown above, excluding the declaration of floats,
is a message. The “word” on the left side of a message expression identifies the
object receiving the message ( called the “receiver”). These objects are
identified by the outlets you defined and connected. After the receiver comes
the name of the method that the sending object (called the “sender”) wants to
invoke. Messages often result in values being returned; in the above example,
the local variables rate, amt, and total hold these values.

Before you build the project, add a small bit of code to ConverterController.m that
will make life a little easier for your users. When the application starts up, you
want Currency Converter’s window to be selected and the cursor to be in the
Exchange Rate per $1 field. We can do this only after the nib file is unarchived,
which establishes the connection to the text field rateField. To enable set-up
operations like this, awakeFromNib is sent to all objects when unarchiving
concludes. Implement this method to take appropriate action.

6 Implement the awakeFromNib . .
method. = (void)awakeFromNib

Type the code shown atright. : [rateField selectText:selfl; /* 1 */ ;
[[rateField window] makeKeyAndOrderFront:self]; /* 2 */

1. You’ve seen the selectText: message before, in the convert: implementation; it
selects the text in the text field that receives the message, inserting the cursor
if there is no text.

2. The makeKeyAndOrderFront: message does as it says: It makes the receiving
window the key window and puts it before all other windows on the screen.
This message also #eszs another message; [rateField window] returns the window
to which the text field belongs, and the makeKeyAndOrderFront: method is then
sent to this returned object.
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The Objective-C language is a superset of ANSI C with special
syntax and run-time extensions that make object-oriented

- programming possible. Objective-C syntax is uncomplicated, but
powerful in its simplicity. You can mix standard C and even C++

- code with Objective-C code.

The following summarizes some of the more basic aspects of the
language. See Object-Oriented Programming and the Objective-C
Language for complete details. Also, see “Object-Oriented

- Programming” in the appendix for explanations of terms that are
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italicized.

Declarations
* Dynamically type objects by declaring them as id:
id myObject;

Since the class of dynamically typed objects is resolved at run
time, you can refer to them in your code without knowing
beforehand what class they belong to. Type outlets in this way
-aswell as objects that are likely to be involved in polymorphism
and dynamic binding.

* Statically type objects as a pointer to a class:
NSString *mystring;

You statically type objects to obtain better compile-time type
-checking and to make code easier to understand.

* Declarations of instance methods begin with a minus sign {-)*
and for class methods, with a plus sign (+):

‘ (NSStrlng *)countryName;
: +f(NSDate *)calendarDate;

* Putthe type of value returned by a method in parentheses
‘between the minus sign (or plus sign) and the beginning of the
method name. (See above example.) Methods returning no
explicit type are assumed to return id.

¢ Method argument types arein parentheses and go between
the argument’s keyword and the argument itself:

- initwithName:(NSétring *)name
andType: (int) type;

Be sure to terminate all declarations with a semicolon.

» By default, the scope of aninstance variable is protected,

- making that variable directly accessible only to objects of the
class that declares it or of a subclass of that class. To make an
stance variable private (ac le only within the declaring
class), insert the @private directive before the declaration.

Messages and Method Implementations

* Methods are procedures implemented by a class forits objects
(or, in the case of class methods, to provide functionality not
tied to a particular instance). Methods can be public or private;
public methods are declared in the class’s header file (see
above). Messages are invocations of an object’s method that
identify the method by name.

* Message expressions consist of a variable identifying the
receiving object followed by the name of the method you want
to invoke; enclose the expression in brackets.

[anObject doSomethingWithArg:this];

receiver method to invoke

As in standard C, terminate statements with a semicolon.

* Messages often get values returned from the invoked method;
you must have a variable of the proper type to receive this
value on the left side of an assignment.

int result = [anObj calcTotall;

* You can nest message expressions inside other message
expressions. This example gets the window of a form object
and makes it the receiving object of another message.

[ [form window] makeKeyAndOrderFront:self];

* Amethod is structured like a function: After the full declaration
~ of the method comes the body of the implementing code
enclosed by braces.

* Use nil to specify a null object; this is analogous to a null
pointer. Note that some OpenStep methods do not accept nil
objects as arguments.

- Amethod can usefully refer to two implicit identifiers: self and

super. Both identify the object receiving a message, but they -
affect differently how the method implementation is located:
self starts the search in the receiver's class whereas super
starts the search in the receiver’s superclass. Thus

[super init]; o
causes the init method of the superclass to be invoked.

* In methods you can directly access the instance variables of
your class’s instances.:However, accessor methods are
recommendedinstead of directaccess, exceptin caseswhere
performance is of paramount importance. Chapter 4, “Tr ravel
Advisor Tutorial,” describes accessor methods in greater
detail.




Building the Currency Converter Project

Building the Currency Converter Project

Build the project.

Save source code files and any
changes to the project.

Click the Build button on the main
window {icon at right).

Click the Build button on the
Project Build panel {same icon).

You don’t have to maintain
makefiles in Project Builder. It
updates Makefile according to the
variables specified through its
user interface. You can customize
the build process by modifying
the Makefile.preamble and
Makefile.postambe files. For
more information on customizing
these files, see OPENSTEP
Development: Tools and Techniques

The Build process in Project Builder compiles and links the application guided
by the information stored in the project’s makefiles. You must begin builds from
the Project Build panel.

When you click the Build button on the main window, the Project Build panel
is displayed.

QtrreucyConverter -~ Project Build =

Targat app
Status: alrmmyc‘omef{erw-—&/ww

=\

Build, Clean, and Build
Options buttons.

Build error browser.

v

Jdynamic_ oh]/mssleunencndnvemr maino
Min/ee -g -Wall -pipe -O -dynamic -mo-common -1/ProjectHeaders
-1/derivad_src-arch mesk-ObjC -sectereate __ICON __header
CurrencyConverlericonheader-segprot__| JCONT r-sectcreate _ ~ICON app
&% application tiff-o /CurrencyConverter.app/CurrencyConverter.mesk
| § Jdynamic_obymesi/Converter.o /dynamic_objmesk/ConverterControtler.o
‘e § Jdynamic_oblmesk/CurrencyCanventar,_) maln.o- frameworkAppKK
| -framework Foundation
= /bindin JCurrencyConvertsr, app!CutrancyConvenarmsek
A CunsncyConverlarapplCunencyConvener

Detailed build results.

ks
s

When you click the Build button on the Project Build panel, the build process
begins; Project Builder logs the build’s progress in the lower split view. When
Project Builder finishes—and encounters no errors along the way—it displays
“Build succeeded.”

Of course, rare is the project that is flawless from the start. Project Builder is
likely to catch some errors when you first build your project. 'To see the error-
checking features of Project Builder, introduce a mistake into the code.
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y chckmg the But!d button in Project Builde
‘yourunthe build tool. By default the build tool is
- gnumake, but it can be any build utility that you
~specifyas a prolect defaultin Project Builder.
The build tool coordlnates th compilation and
linking processthat results in an executable flle
"It also performs othertasks needed to build an
appllcatlon o

updates files based
lependencies and other information

specified in the project’s makefiles. Every
application project has three makefiles:
Makefile, Makefile. preamble and
Makefile.postamble. Makefile is maintained by
Project Builder—don't edit it directly—but you i
can modify the other two to customize your ; <arch> _obj
buﬂd - ===

The bunld tool mvokes the compllertool cc, |
passing it the source code files of the project. -
‘Compilation of these files (Objective-C, C++,and
tandard C) produces machine-readable object
files for the architecture (or archltectures)

:specmed forthe build. It putsthese flles inan "
" architecture-specific subdlrectory of

~ dynamlc obj.

nkmg phase of the build, the build tool
executes the link editor Id (via cc), passmg itthe
libraries and frameworks to link against ,
object files. Frameworks and libraries contain

“ precompiled code that can be used by any , ~
application. Linking integrates the code in T T - = e T T
libraries, frameworks, and object files to , ; : o
produce the application executable file.If there apphcatlon
are multiple architecture- -specific object files, executable

~ linking also combmes these into'a single “fat™ s

4 Eexecutable. ,

e The build tool a'lso'copies nibfiles, soUnd
- images, and other resources from the pro;ectto E
the appropriate localized or non- Iocahzed
Iocatlons inthe apphcatlon wrap I

~ An apphcatuon wrapperisa flle package w:th an extension of the Workspace M ) : kt(he application wrapper

“.app”. Afile packageis a dlrectory't t the Workspace™ contalns an execu ‘ nberun ("Iaunched");by
‘Manager presents to users as.asimple . I|ck|ng L

hidesthe contents of the directory. The
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2 Build the project after correcting
errors.

Delete a semicalon in the code,
creating an error.

Click the Build button on the
Project Build panel.

Click the error-notification line
that appears in the build error
browser (upper split view).

Fix the error in the code.
Re-build.

= Target: spp

L~ To navigate to an
error in a code file,
click the line

Stadus: CumencyConverter.8op ~ Busid thlked
1 eror oy »
describing the error.

P illegal statement: missing*;" after )’

e

= {

B QunencyConverter — ~/Projects ox

Converform {Zaav=

F’g == Making Cuf
B Exporting head
.1or Currency

B -|/derived_sic
B /dynamic_objA
%! Converter.m:s:
& gnumakef1]): **

S8 minscc-g-Wall

gnumake: “** {4 -

M Converterm > S @Converter

¥ Converarcont F |Gl

, simport “Converter.h”
@ airolenentation converter

(float)convertizmount:(float)sat byRate:(flost)rats

{
TR AN L)) 1

dend
: Project Builder highlights the line that
contains the erro
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Context-Sensitive Application Help

Project Builder and Interface Builder provide context-sensitive
help on the details of their use. To activate context-sensitive help,
Help-click a control, field, menu command, or other areas of the
application. A small window appears that briefly describes the
selected object.

The Help key varies by computer architecture. Consult user
documentation for the Help key on your machine.

Digital Librarian

Digital Librarian is an application that quickly searches for aword
(or other lexical unit) in an on-line manual (or other target) and
lists the documents that contain the word. You click a listed item

- and the document is displayed at the point where the word
occurs. The contents of documents are indexed, making
searching very fast.

OpenStep includes NextDeveloperbshif, a Digital Librarian
bookshelf for developers in /NextLibrary/Bookshelves. This
bookshelf contains most of the targets you are likely to want, and
includes (as the topmost target) instructions on creating your own
bookshelf and customizing it to your needs. When you choose
Help from Project Builder or Interface Builder, a Digital Librarian
bookshelf is opened that contains the on-line version of
OPENSTEP Development: Tools and Techniques.

You can find Digital Librarian as Librarian.app in /NextApps.
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Project Builder

Project Builder gives you several ways to get the information you
need when developing an application.

Project Find: The Project Find panel allows you to search for
definitions of, and references to, classes, methods, functions,
constants, and other symbols in your project. Since itis based on
project indexing, searching is quick and thorough and leads
directly to the relevant code. See OPENSTEP Development: Tools
and Techniques for a complete description of Project Find.

Reference Documentation Lookup: If the results of a search using
Project Find includes OpenStep symbals, you can easily get
related reference documentation that describes that symbol. See
“Finding Information Within Your Project” on page 94 for
instructions on the use of this feature.

Frameworks: Under Frameworks in the project browser, you can
browse the header files related to OpenStep frameworks within
Project Builder. The Application Kit and Foundation frameworks
always are included by default for application projects. See
chapter 5, “Where to Go From Here,” for a fuller description

NeXT's Technical Documentation

Most OpenStep programming documentation is located on-line in
NeXTLibrary/Documentation/NextDev. The document files are in
RTF format, so you can open them in Project Builder, Edit, or in
most word processors. NeXT includes the following manuals
under the /NextDev directory:

Reference

* APl Reference Documentation (specifications of classes,
protocols, functions, types, and constants). This
documentation is divided among, and located in, the
frameworks NeXT provides, except for information that is
common to all frameworks {/Reference).

* Development Tools Reference covering the compiler, the
debugger, and other tools (Reference DevTools).

* NeXT Assembler Manual

Tasks and Concepts

* Discovering OPENSTEP: A Developer Tutorial (this manual)

» Object-Oriented Programming and the Objective-C Language

 Topics in OPENSTEP Programming {concepts and
programming procedures)

e OPENSTEP Development: Tools and Techniques (a task-
oriented approach to using the development tools)

* OPENSTEP Conversion Guide (step-by-step instructions for
converting 3.x NEXTSTEP applications to run on OPENSTEP 4.0.

The /NextDev directory also includes release notes . It also
contains documentation on the following products, if they're
installed: Enterprise Objects Framewark, Distributed Objects
(DO), Portable Distributed Objects (PDO).

See chapter5, “Where to Go From Here,” for more information on
NeXT's technical publications.
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Run Currency Converter

You can use Project Builder’s
graphical debugger orgdb to track
bugs down. See “Using the
Graphical Debugger” on page
104 for an overview of the
graphical debugger.
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Congratulations. You’ve just created your first OpenStep application. Find
CurrencyConverter.app in the Workspace, launch it, and try it out. Enter some rates
and dollar amounts and click Convert. Also, select the text in a field and choose
the Services menu; this menu now lists the other applications that can do

something with the selected text.

Of course, the more complex an application is, the more thoroughly you will
need to test it. You might discover errors or shortcomings that necessitate a
change in overall design, in the interface, in a custom class definition, or in the
implementation of methods and functions.

Although it’s a simple application, Currency Converter still introduced you to
many of the concepts, tools, and skills you’ll need to develop OpenStep
applications. Let’s review what you’ve learned:

Composing a graphical user interface (GUI) with Interface Builder
Testing the interface

Designing an application using the Model-View-Controller paradigm
Specifying a class’s outlets and actions

Connecting the class instance to the interface via its outlets and actions
Class implementation basics

Building an application and error resolution

Optional Exercise

Nesting Messages:You can nest message expressions; in other words, you can use
the value returned by a message as the receiver of another message or as a
message argument. It is thus possible to rewrite the first three messages of the
ConverterController’s convert: method as one statement:

total = [converter conveftAﬁpount :p[dgdwi”ié.rs}?ield fl‘o‘étValue]' : ;,
byRate: [rateField floatValuell; o

It is possible to go even further. Try to incorporate the fourth message (ftotalField
setFloatValue:total]) of the convert: method into the above statement.
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Collection objects allow you to
store, organize, and access data in
different ways. For more
information, see “The Collection
Classes” on page 74.

String objects represent textual
strings in various encodings. See
page 82 for more information.

You can find the TravelAdvisor
project in the AppKit subdirectory
of /NextDeveloper/Examples.

In this chapter you create Travel Advisor, an application that is considerably
more complex than the Currency Converter application you built in the first
tutorial. Travel Advisor is a forms-based application used for entering, viewing,
and maintaining records on countries that the user travels to. Users enter a
country name and information associated with that country. When they click
Add, the country appears in the table below the country name. They can select
countries in the table, and the information on that country appears in the forms.
The application also performs temperature and currency conversions.

- Logistics ———
Airparts:| Sydney International
‘Airlines:] Quantas

i$25 Aus downtown Sydney

v 8/25/95 11:35 SFO Quantas
1r Sydney 6/27 4:14 AM

:{ Aus. Dollar

:JEnglish

ank of Australia, 4th Floor, 2 PM
ring presentation slides

This chapter presents a lot of information on OpenStep programming. Among
other things, you’ll learn how to:

Use several new objects on Interface Builder’s palettes.
Assign an icon to an application.

Print the contents of a view.

¢ Use collection objects (NSArray and NSDictionary).
Use string objects (NSString).

® Archive and unarchive object data.

® Format and validate field contents.

® Manage events through delegation.

e Quickly find information related to your project.

¢ Use Project Builder’s graphical debugger.

Perhaps most interestingly, you will 7exse the Converter class you implemented
in the previous tutorial.
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Creating the Travel Advisor Interfuce

Create the application project.

Start Project Builder.

Choose New from the Project
menu.

Name the application
“TravelAdvisor.”

Open the application’s nib file.

Click Interfaces in the project
browser, select
TravelAdvisor.nib, and double-
click its icon.

Customize the application’s
window.

Resize the window, using the
example at right as a guide.

Inthe Attributes display of the
Inspector panel, entitle the
window “Travel Advisor.”

Turn off the resize bar.
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You should be familiar with many of the objects on the Travel Advisor interface
because you've encountered them in the Currency Converter tutorial. The
following illustration points out the objects that are new to you in this tutorial.

Form
Scroll view Table view Image view Switch (button) Groups
{containing an (Boxes)
NSText object)

The following pages describe the purpose of each new object found on
Interface Builder’s palettes and explain how to set these objects up for Travel
Adpvisor. Before getting to these new objects, start with the familiar ones:
buttons and text fields.



Creating the Travel Advisor Interface

4 Putthe textfields, labels, and
buttons on the window.

Position, re-size, and initialize the
objects as shown.

Set up the switch.

Notes and Itinerary for

Cunency:L

Languages:|
’S!English widely spoken

Dattars: | i Locat|

Celsius:l

Farenheit:

Be sure this label
contains enough
“padding” for the
longest country
name.

Drag the Switch
object from the
Views palette and
drop here.

You might think the “English widely spoken” object is a new kind of object.

It’s actually a button, a special style of button called a switch.

Double-click to select text, then type new label.

N English widely spoken ;
Click to set the initial state of this toggled button (no checkmark).

Varieties of Buttons

If in Interface Builder you select the “English
widely spoken” switch and bring up the
Attributes inspector, you can see that the
switch is a button set up in a special way.

le: English widely spoken

Buttons are two-state control objects. They
are either off or on, and this state can be set by

the user or programmatically (setState:). For INSSwitch

certain types of buttons (especially standard

buttons like Currency Converter's Convert
button), when the state is switched, the button
sends an action message to a target object.
Toggle-type buttons—such as switches and

radio buttons— visually reflect their state.
Applications can learn of this state with the
state message. You can make your own
buttons, associating icons and titles with a
button’s off and on states, and positioning title
and icon relative to each other.
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Place aform on the interface and
prepare it.

Drag the form object from the
Views palette.

Increase the size of the form’s
fields by dragging the middle
resize handle sideways.

Create two more form fields by
Alternate-dragging the bottom-
middle resize handle downward.

Rename the field labels.
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Construct the “Logistics” section of the interface using a form object.

As you Alternate-drag, new form fields
appear underneath the cursor.

o ﬁ Double-click to select label text.

Forms are Iabelled flelds bound vertlcally ina

matrix. The fields are the same size and each

label is to the left of its field. F
objects for applications that
*:capture multiple rows of data, as do many
corporate client-server applications.

- The editable fields in a form are actually cells
hat you programmatically identify through

zero-based indexing; the first cell is at index
~ 0ofthe matrix, the second cell atindex 1,and
so on. NSForm defines the behavior of forms;
mdnwdual cells are instances of NSFormCell.

celIAtInyd,ex.,method. ;

- Form Attributes

_ positions” attribute. Switching this on
 assignstags to.
‘correspond to t

Type the new label text and click outside
the form to set the text.

In addition to the obvious controls in the
orms inspector, there's the “Cell tags =

number a551gned to an object that is used tb
idenitfy and access that object. You'll use
tags extenswely in the nexttutonal )

are entered. N
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6 Group the objects on the

interface.

Select the two Convert buttons
and the Dollars, Local, Celsius,
Fahrenheit labels and text fields.

Choose Format » Group » Group
in Box.

Double-click “Title” to select it.

Choose Format » Font » Bold to
make the title bold face.

Rename “Title” to “Conversions.”

Repeat for the next two groups:
“Logistics” and “Other.”

To make titled sections of the fields, forms, and buttons on the Travel Advisor
interface, group selected objects. By grouping them, you put them in a box.

PRI P . S ] To select the objects as a group, drag
:Dotm Slopalgi i .. EConven & a selection rectangle around them or
. g i, B fp— e Shift-click each object. (To make a
'Celgms: - . !Fare‘\heft- 'i:.:t::ﬁ : 'COfWBf’? :; selection rectangle, start dragging from

an empty spot on the window.)

After you choose the Group in Box
command, the objects are enclosed by
a titled box.

Boxes are a useful way to organize and name sections of an interface. In
Interface Builder you can move, copy, paste, and do other operations with the
box as a unit. For Travel Advisor, you don’t need to change the default box
attributes.

Before You Go On

Programmatically, the box is the superview of all of its grouped objects. (A view,
simply put, is any object visible on a window.) A superview encloses its subviews
and is the next in line to respond to user actions if none of its subviews cannot
handle them.

The scroll view on the DataViews palette encloses a text object (an instance of
NSText). This object allows users to enter, edit, and format text with minimal
programmatic involvement on your part.
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Put the scroll view on the
window and resize it.

Drag the scroll view from the
DataViews palette and drop it on
the lower-left corner of the
window.

Resize the scroll view..
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| Travel Advisor

i

You don’t need to change any of the default attributes of the scroll view (but you
might want to look at the attributes you can set, if you’re curious).

Next, add a table view for displaying the list of countries. .

More About Table Views

A table view is an object for displaying and editing tabular data.
Often that data consists of a set of related records, with rows for
individual records and columns for the common fields (attributes)
of those records, Table views are ideal for applications that have
a database component, such as Enterprise Objects Framework
appllcatlons

he table view on Interface Builder’s TabulationViews palette is
ctually several objects, bound together in a scroll view. Inside
the scroll view is an instance of NSTableView in which data is
dlsplayed and edited. Atthe top of the table viewisan =

~ headers (instance of NSTableColumn).

NSTableColumn

Scroll view
(NSScroliView)

NSTableView

-+ Column identifier. Each column (NSTableColumn) of a table
- NSTableHeaderView object, which contains one or more column '

. Déléﬁéﬂe methods. NSTableView sends several messagesto -

Later in this tutorial you will learn some basic techniques for.
accessing and managing the data in a table view. Here's a qulck
preview of the essential pieces:

* Data source. The data source is any object in your application
- that supplies the NSTableView with data. The elements of data
* (usually records) must be identifiable through zero-based
~“indexing. The data source must implement some or all of the.

methods of the NSTableDataSources informal protacol.

 view has an identifier associated with it, which can be either

- an NSString or a number. You use the identifier as a key to -

 obtain the value of a record field,

its delegate, giving itthe opportunity to control the appearance.
and accessibility of individual cells, and to valldate orden

edmng infields.
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8 Place and configure the table
view.

Drag the table view object from
the TabulationViews palette.

Resize the table view.

Set the title of the first column to
“Countries.”

Make the table header only one
column.

Click to
selectthe
Tabulation
Views
palette.

Alrpas
Airlin
 Tran

Ho

Hotes and Winerary for
o Currer]

‘Languadg

-— Conversions

 Locat|

‘Countrigs -

Double-click column twice (first to select the column,
second to insert the cursor). Type “Countries” then click
anywhere outside the column.

When this cursor appears over the line separating
columns, drag the line so that it's flush with the right
edge.

The other object on the TabulationViews palette is a browser: It is just as suitable
for the Travel Advisor application as a table view. Browsers are ideal for
displaying hierarchically structured information (such as is found in the UNIX
file system) as well as single-level views of data such as the list of countries in
Travel Advisor. A table view can also handle single-column rows of data easily;
it is used instead because it is designed for displaying and editing records from
relational databases, something that Enterprise Objects Framework (EOF)
programmers find very useful .

To configure the table view, you must set attributes of two component objects:
the NSTableView object and the NSTableColumn object.
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Select the NSTableView by
double-clicking the interior of the
table view.

Set the attributes as shown at
right.

Select the column by double-
clicking once (if this inserts the
cursor, click outside the column,
then click the column once).

Setthe NSTableColumn attributes
as shown at right.
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HSTableView

Since this is a single-column view and country names are
of limited length, you need only the verticle scroller, in case
there’s no more countries that can be shown at once.

Whether to show the grid is a matter of personal
preference, but turn off resizing and reordering. The user
shouldn't be able to affect the contents of the column
directly.

The Travel Advisor window is nearly complete. For a decorative touch, you’re
next going to add an image to the interface.
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9 Add an image to the interface.

Drag the image view onto the
window, as shown at right.

In Project Builder:

Double-click Images in the
project browser.

Inthe Open panel, select the file
Airline.eps from the
[AppKit/TravelAdvisor
subdirectory of
/NextDeveloper/Examples

In the Attributes inspector for the
image view, type the name of the
image and set the NSImageView
attributes.

Make the image view {and the
enclosed image) small enough to
fit between the title bar and the
Logistics group.

Add a “velocity” line behind the
airplane.

Alrports:|

L

Transpartation:|

Hotels:|

Before You Go On

Sometimes buttons are the preferred objects for holding images—for instance

when you want a different image for either state of a button. But when buttons
are disabled, any image they display is dimmed. So for decorative images, use

image views (NSImageView) instead of buttons.

When you drop a sound or image over a button or image view, it is added to the
nib file. When you add an image or a sound to a nib file, Interface Builder asks
if you also want to add the resource to the project. Nib files are localized and
their resources are only accessible when the nib file has been loaded. Resources
that are associated with a project can be localized and are always accessible.

HSImageView Inspecto

Enter the name of the image file, minus the extension.
The image can be in TIFF of EPS format, and must be
part of the project.

You can also add an image by dragging it from the
Images display of the nib file window and dropping it
over the image view.

The border of the image should not be visible.

Since the image is larger than the image view, have it
scale proportionally.

Uncheck if you don't want users to affect the image in
any way.
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10 Add commands to the main menu.

Select the Menus palette.

Dragthe Item command and drop
it between Edit and Services.

Change “Item" to “Print Notes...".

Drag the Submenu item and drop
it between Info and Edit.

Double-click Submenu to select
the item text; change the name to
“Records”.

Add three Items to the Records
submenu (making four
altogether).

Change the command names to
those shown at right.

Add key equivalents to the right of
the last two commands.
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Tip: Tomake the “velocity” line behind the airplane, make a title-less black box
with a vertical offset of zero, and run the top and bottom lines together.

Travel Advisor’s main menu has a submenu and a command that do not come
ready-made on the Menus palette. You use the Submenu and the Item cells to
create customized submenus and menu commands, respectively.

. Menus

Print Motes...

Services >

@

Double-click the area to the right of the command and type a letter.
This letter is the Command key equivalent to teh menu command
{Command-r here because Command-p is often reserved for a print
command).

Three dots after a menu command indicates that the command opens a panel:
“Print Notes...” means that clicking this command displays the Print panel.

You can now connect many of the objects on the Travel Advisor interface
through outlets and actions defined by the Application Kit. As you might recall,
text fields have a nextKeyView outlet that you connect so that users can tab from
field to field. Forms also have a nextKeyView outlet for tabbing. (The fields within
a form are already interconnected, so you don’t need to connect them.)
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11 Connect Application Kit outlets
for inter-field tabbing and ,
printing. Country:| _®

[ Countries |17 ©

In top-to-bottom sequence,
connectthe fields and the form

through their nextKeyView aitports:| |
outlets. Airlines: [
When you reach the Languages Transpartation|
field, connect it with the Country Hotels:|

N eeriees QRRBI e
s | i;.jw conoil Rata] l;.m.:.m.i..
When a gray line borders the form, it is selected.
Release the mouse button and set the nextkeyview
outlet connection.

field, making a loop. Hotes and Hinerary for -

The Application Kit also has “pre-set” actions that you can connect your
application to. The NSText object in the scroll view can print its contents as can
all objects that inherit from NSView. To take advantage of this capability, “hook
up” the menu command with the NSText action method for printing.

Travel Advisor.

Connect the Print Notes menu
commandtothe textobjectinthe g ;
scroll view.

Select the print: action method in Record
the Connections display of the Edit.
Inspector panel. Print Notae=—

Click the Connect button in the
Inspector’s Connection display.

Make sure the text
object (the white
rectangle) is
selected and not the
scroll view that
encloses it.

The final step in crafting the Travel Advisor interface has nothing to do with the
main window, but with what users see of your application when they encounter
it in the File Manager: the application’s icon.

n
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12 Add the application icon.

In Project Builder:
Open the Project Inspector.

Go to the Project Attributes
display of the inspector.

Make sure the cursoris in

Click in the Application Icon field. this field before dragging.

1 Fle M TravelAdvisor
n rile Manager , : ish Afteryou drag the image

into the well, the icon is
displayed in the well and
the image file is
automatically added to the
project.

Locate TravelAdvisor.tiff in the
/AppKit/TravelAdvisor
subdirectory of
/NextDeveloper/Examples.

Drag TravelAdvisortiff into the
icon well in the Project Attributes
display.

13 Test the interface. You're finished with the Travel Advisor interface. Test it by choosing Test
Interface from Interface Builder’s Document menu. Try the following:

* Press the Tab key repeatedly. Notice how the cursor jumps between the
fields of the form, and how it loops from the Languages field to the Country
field. Press Shift-Tab to make the cursor go in the reverse direction.

* Enter some text in the scroll view, then click the Print Notes menu item. The
print panel is displayed. Print the text object’s contents.

® Also in the scroll view, press the Return key repeatedly until a slider appears
in the scroller.
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The Design of Travel Advisor

"Travel Advisor is much like Currency Converter in its basic design. Like
Currency Converter, it’s based on the Model-View-Controller paradigm. A
controller object (TAController) manages a user interface comprised of
Application Kit objects. Also as before, the controller sends a message to the
Converter object to get the result of a computation. In other words, the
Converter object is reused.

Teavel Advisor

TAController Converter

Aupors,
Antmex

Hetsls:

S oter
ency

< cun

Germany

Country Country Country NSDictionary

"Travel Advisor’s view objects, in terms of Model-View-Controller, are all off-the-
palette Application Kit objects, so the following discussion concentrates on
those parts of the design distinctive to Travel Advisor.

Model Objects

Travel Advisor’s design is more interesting and dynamic than Currency
Converter’s because it must display a unique set of data depending on the
country the user selects. To make this possible, the data for each country is
stored in a Country object. These objects encapsulate data on a country (in a
sense, they’re like records in a relational database). The application can manage
potentially hundreds of these objects, tracking each without recourse to a
“hardwired” connection.

Another model object in the application is the instance of the Converter class.
This instance does not hold any data, but does provide some specialized
behavior.
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Controller

‘The controller object for the application is TAController. Like all controller
objects, TAController is responsible for mediating the flow of data between the
user interface (the View part of the paradigm) and the model objects that
encapsulate that data: the Country objects. Based on user choices in the
interface, TAController can find and display the requested Country object; it
can also save changes made by users to the appropriate Country object.

What makes this possible is an NSDictionary object (called a dictionary from
here on). A dictionary is a container that stores objects and permits their retrieval
through key-value associations. The key is some identifier paired with an object
in the dictionary (the object often holds the identifier as one of its instance
variables). To get the object, you send a message to the dictionary using the key
as an argument (objectForKey:).

NSColor *aColor = [aDictibnary objectForKey,:@”BaékgfoundColor”];

A Country object holds the name of a country as an instance variable; this
country name also functions as the dictionary key. When you store a Country
object in the dictionary, you also store the country name (in the form of an
NSString) as the object’s key. Later you retrieve the object by sending the
dictionary the message objectForKey: with the country name as argument.

“The Collection classeks s

created (see “Abstract Classes and Class Clusters on page 101)

Several classes in OpenStep S Foundatlon Framework'create
objects whose purpose is to hold other objects. These collectlon@
classes are very useful. Instances of them can store and locate
their contents through a number of mechanisms.

Collection objects also provide a valuable wayto store data.
When you store (or archive) a collection objectin the file system
its constituent objects are also stored.

e Arrays (NSArray) store and retrieve objectsin an ordered ”
through zero-based indexing.

ct naries (NSchtlonary) store and quickly retrieve objects NSObject
sing key/value pairs. For example, the key “red” might be ]
associated with an NSColor object representing red. [ | |

. Sets (NSSet) are unordered collections of distinct elements. NSArray NSDictionary NSSet
Counted sets (NSCountedSet) are sets that can contain I |
duplicate (non-distinct) elements; these duplicates aretracked [ NSMutableArray NSMutableSet

through a counter. Use sets when the speed of membership- NSMutableDictionary
testmg is important. :

The mutable versions of thése'classes allow you to add and NSCountedSet

-_remove objects programmaﬁcallyya,fterthe collection object is
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Sce “Implementing the
TAController Class” on page 90
fora diagram that depicts the data
relationships of TAController as
data source. See page 66 for more
on NSTableView's data source.

See “Getting in on the Action;
Delegation and Notification” on
page 97 for more on delegation.

Storing Data Source Information

TAController also manages the data source for the table view on the interface.
It stores the keys of the dictionary in an array object (NSArray), sorted
alphabetically. When the table view requests data, the TAController “feeds” it
the objects in the array.

Creation of Country Objects

Another important point of design is the manner in which the Country objects
are created. Instead of Interface Builder creating them, the TAController object
creates Country objects in response to users clicking the Add button.

Delegation and Notification

An essential aspect of design not evident from the diagram are the roles
delegation and notification play. The TAController object is the delegate of the
application object and thereby receives messages that enable it to manage the
application, which includes tracking the edited status of Country objects,
initiating object archival upon application termination, and setting up the
application at launch time.
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Chapter3 Travel Advisor Tutorial

Defining the Classes of Travel Advisor

"Travel Advisor has three classes: Country, Converter, and TAController. Only
TAController has outlets and actions. And, rather than defining the Converter
class, you are simply going to add it to the project from the CurrencyConverter
project and reuse it.

Specify the Country and
TAController classes.

In Interface Builder, bring up the
Classes display of the nib file
window.

For each class, select NSObject
as the superclass.

Choose Subclass from the
Operations menu.

Type the class name.

Specify TAController’s outlets. Bix

Add the outlets shown in the nib
file window at right.

Through this outlet, the TAController
object establishes a connection with
the instance of the Converter class.
You will reuse this class later in this
section.
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3

Specify TAController’s actions.

Define the action methods shown
in the nib file window at right.

4 BReuse the Converter class.

In Interface Builder:

Open CurrencyConverter.nib in
the English.Iproj subdirectory of
the CurrencyConverter project
directory.

Inthe Classes display of the nib
file window, select the Converter
class.

Choose Edit » Copy.

Select the nib file window for
TravelAdvisor.nib.

Inthe Classes display, select the
superclass (NSObject).

Choose Edit » Paste.

In Project Builder:

Launch Project Builder.

Select Classes in the project
browser.

Choose Project » Add Files.

In the Add Classes panel,
navigate to the
CurrencyConverter project

directory and select Converter.m.

When asked if you want to
include the header file, click OK.

addRecord:
s blankFlelds: ...
onvertCelsius:

extRecord:
- prevRecord:

A

.} Operstions |

In OpenStep there are many ways to reuse objects through their classes. For
example, subclassing an existing class to obtain slightly different behavior is one
way to reuse the functionality of the superclass. Another way is to integrate an
existing class—like the Converter class—into your project.

Mo NSOt
o Converer

o FirstResponder
PREGE L

Make sure to select the
superclass before pasting.

When you add a
class to a project,
Project Builder
adds the
associated header
file too.

It copies both files
from the source
location.

77



Chapter 3

Travel Advisor Tutorial

5 Generate instances of the
TAController and Converter
classes.

6 Connectthe TAController
instance to its outlets.
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8

You don’t need to instantiate the Country class in the nib file because it is not
involved in any outlet or action connections. TAController interacts behind the
scenes with users as they manipulate the application’s interface. It therefore
needs access to interface objects and to be made the target of action messages.

Outlet Make Connection To
celsius Text field labelled “Celsius”
commentsLabel Label that reads “Notes and Itinerary for”

commentsField

Text object within scroll view

converter

Instance of Converter class (cube in Instances display)

countryField

Text field labelled “Country”

currencyDollarsField

Text field labelled “Dollars”

currencylLocalField

Text field labelled “Local”

currencyNameField

Text field labelled “Currency”

currencyRateField

Text field labelled “Rate”

englishSpokenSwitch

Switch (button) labelled “English widely spoken”

fahrenheit

Text field labelled “Fahrenheit”

languagesField

Text field labelled “Languages”

logisticsForm

Form in group (box) labelled “Logistics”; the form is selected when a

- gray line borders it.

tableView

The area underneath the “Countries” column




Defining the Classes of Travel Advisor

Connect the TAController
instance to the interface via its
actions.

You can assign delegates
programmatically or by using
Interface Builder. For more
information, sec “Getting in on
the Action; Delegation and
Notification” on page 97.

Checking Connections in Qutline Mode

Action Make Connection From
addRecord: “Add” button
blankFields: “Clear” button

convertCelsius:

“Convert” button to the right of the “Fahrenheit” field

convertCurrency:

“Convert” button to the right of the “Local” field

deleteRecord:

“Delete” button

handleTVClick: The table view(the area beneath the “Countries” column header)
nextRecord: The “Next Record” menu command on the Records submenu
prevRecord: The “Prior Record” menu command on the Records submenu
switchChecked: The “English widely spoken” switch

Before You Go On

You're next going to connect objects through an outlet defined by several
OpenStep classes. The value of this outlet, named delegate, is the id of a custom
object. As the delegate of NSApp (the NSApplication object), TAController will
receive messages from it as certain events happen.

The nib file window of Interface Builder gives you two modes in Outline mode, as the phrase suggests, represents objects in a
which to view the objects in a nib file and to make connections hierarchical list: an outline. The advantages of outline mode are
between those objects. So far you've been working in the icon thatit represents all objects and graphically indicates the

mode of the Instances display, which pictorially represents
objects such as windows and custom objects.

Click here for icon mode.

connections between them. You can connect objects through
their outlets and actions in outline mode, as well as disconnect
them by Control-clicking a connection line.

Click here for outline
made.

Connect objects in outline
mode justas youdoinicon
mode: Control-drag a
connection line between
objects.

Click a right-pointing triangle to see connections
out; click a left-pointing triangle to see
connections into the object.

Move the vertical line left or right to see details
(this is a vertical split view).

A connection is identified by name and icon for
type {electrical outlet for outlet, cross-hairs for
action)
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8 Connect the delegate outlet.

Drag a connection line from File's

Owner to the TAController object.

In the Connections display of the
Inspector panel select delegate
and click OK.

9 Generate source code files for
the TAController and Country
classes.

Save TravelAdvisor.nib.

Select the class in the Classes
display of the nib file window.

Choose Create Files from the
Operations pull-down menu.
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Every application has a global NSApplication object (called NSApp) that
coordinates events specific to the application. Among many other messages,
NSApp sends a message to its delegate notifying it that the application is about
to terminate. Later, you will implement TAController so that, when it receives
this message, it archives (saves) the dictionary containing the Country objects.

Notice that the direction of the
connection is from the File's
Owner object (which is the
application object) to the
TAController object.

When you generate the header and implementation files for all classes of
Currency Converter, you are finished with the Interface Builder portion of

development. Be sure you save the nib file before you switch over to Project

Builder.

File's Owner

the File’s Ownericon in a nib file window. The
owner is an object, external to the nib file,
that relays messages between the objects
unarchived from the nib file and the other
objects in your application.

You can specify a file's owner in Interface
Builder or programmatically, with
NSBundie's loadNibNamed:owner:. The
File’s Owner icon for the main nib file always
represents NSApp, the global NSApplication
nt, The main nib file is automatically
d when you create an application

tis loaded in main() when an

on is launched:

Nib files other than the main nib file—
auxillary nib files—contain objectsand
resources that an application may load only
when it needs them {for example, aninfo
panel). You must specify the owner of -
auxillary nib file i o

You can determine or set the class of the
current nib file’s owner in Interface Builder
by selecting the File’s Owner icon in the nib
file window and then displaying the Custom
Class inspector view. You'll get to practice

this technigue when you learn how to create
multi-document applications in the next
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Just Add a Smock: Compiled and Dynamic Palettes

A palette is a display on the Palettes window that holds one or
more reusable objects. You can add these objects to your
application’s interface using the drag-and-drop technique. There
are two types of palettes: dynamic and compiled (also called
“static palettes”). To the user, they seem identical, but the
differences are many.

Static palettes are built as a project and have code defining their
objects; dynamic palettes include no special code—they're
unique configurations of objects found on static palettes.
Consequently, static palettes must be compiled, but you can
create dynamic palettes on the fly, without writing and compiling
code. Objects on static palettes can have inspectors and editors,
which dynamic-palette objects cannot.

You usually create a static palette as a way to distribute your
objects—and the logic informing these objects’ behavior—to
potential users. Many developers of commercial OpenStep
objects make use of static palettes as a distribution media.
Creating static palettes (and their inspectors and editors) is a
more complex process than creating dynamic palettes, but the
resulting product has more value added to it.

Using Dynamic Palettes

Dynamic palettes are a big convenience. You can save groups of
objects, with or without their interconnections, to a dynamic
palette at any time. You can save dynamic palettes and store them
in the file system, just as you do with the traditional compiled
palette. You can remove the palette from the Palette viewer and,
when you need it again, load it back into Interface Builder.

To store objects on a dynamic palette:

* Choose Tools ™ Palettes ™ New to create a blank palette.

Select objects singly or in groups on the interface or in the nib
file window (either icon or outline mode)

Alternate-drag these objects and drop them on the blank
palette.

Alternate-drag to
move objects
onto palettes, to
move objects
around palettes,
and to remove
objects from
palettes.

You can use dynamic palettes to: :

Store collections of often-used View objects configured witl
specific sizes and other attributes. For instance, you coul
have a “standard” text field of a certain length, font, and
background color stored on a dynamic palete.

Hold windows and panels that are replicated in your proji
(such as Info panels). :

Store versions of interfaces.

Keep interconnected objects as a template that you can later
use as-is or modify for particular circumstances. For instance,
you could store a group of text fields and their delegate, or a set
of controls and their connections to a controller object

Assiét in prototyping and group work. For example, you could

~mail a palette file containing an interface to interested parties.
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1

Implementing the Country Class

Although it has no outlets, the Country class defines a number of instance

variables that correspond to the fields of Travel Advisor.

Declare instance variables.

In Project Builder, click Headers { NSString
inthe project browser,then select :
Country.h. NSString
NSString
Add the declarations shgwn NSString
between the braces at right. NSString
NSString
BOOL
NSString
float
NSString

When a class adopts a protocal, it
asserts that it implements the
methods the protocol declares.
Classes that archive or serialize
their data must adopt the
NSCoding protocol. See Obyject-
Oriented Programming and the
Olyjective-C Language for more on
protocols.

NSString: A String for All Countries

NSString objects represent character strings. They're behind
almostalltextin an application, from labels to spreadsheet entries
to word-processing documents. NSStrings (or string objects)
supplant that familiar C programming data type, char®. -

“Butwhy?” you might be saying. “Why not stick with the tried and
true?” By representing strings as objects, you confer on them all
the advantages that belong to objects, such as persistency and
distributability. Moreover, thanks to data encapsulation, string
objects can use whatever encodingis needed and can choose the
most efﬂcuent storage for themselves ;

The most lmportant rationale for stnng objectsisthe rolethey play :

in internationalization. String objects contain Unicode characters

rather than the;narrow range of characters afforded by the ASCII

@interface Country :

NSObject <NSCoding> /* 1 x/

*name;
*airports;

/x 2%/

*airlines;
*trahsportation;
*hotels;
*languages;
englishSpoken;
*currencyName;
currencyRate;
*comments;

/* 3%/

1. Declares that the Country class adopts the NSCoding protocol

2. Explicitly types the instance variable as “a pointer to class NSString”—or a
NSString object. See below for more about the NSString class.

3. Declare non-object instance variables the same way you declare them in C
programs. In this case, currencyRate is of type float.

character set. Hence they can réprésent words in Chinese,
Japanese, Arabic,and many other Ianguages

‘The NSString and NSMutableString classes prowde APlto create
static and dynamic strings, respectively, and to ‘perform string

~ operations such as substring searchlng, strmg companson and
concatenation. ‘x :

None of this prevents you from using char * strings, and there are
occasions where for performance or other reasons you should.
However, the public interfaces of OpenStep classes now use
string objects almast exclusively. A number of NSString methods
~enable you to convert string objects to char * strmgs and back
again. ,




Implementing the Country Class

2 Declare methods.

After the instance variables, add
the declarations listed here.

Country.h also declares a dozen or more methods. Most of these are accessor
methods. Accessor methods fetch and set the values of instance variables. They
are a critical part of an object’s interface.

/* initializtion and de-allocation */
(id)init; /* 1 */
~ (void)dealloc;
/* archiving and unarchiving */
- (void)encodeWithCoder: (NSCoder *)coder; /* 2 x/
- (id) initWithCoder: (NSCoder *)coder;
/* accessor methods */
- {(NSString *)name; /* 3 %/
- (void)setName: (NSString *)str;
- (NSString *)airports;
- (void)setAirports: (NSString *)str;
- (NSString *)airlines;
- (void)setAirlines: (NSString *)str;
/* ...other accessor method declarations follow... */

1. Object initialization and deallocation. In OpenStep you usually create an object by
allocating it (alloc) and then initializing it (init or init... variant):

Country *aCountry = [[Country alloc] init];

When Country’s init method is invoked, it initializes its instance variables to
known values and completes other start-up tasks. Similarly, when an object
is deallocated, its dealloc method is invoked, giving it the opportunity to
release objects it’s created, free malloc’d memory, and so on. You’ll learn more
about init and dealloc shortly.

2. Object archiving and unarchiving. The encodeWithCoder: declaration indicates that
objects of this class are to be archived. Archiving encodes an object’s class and
state (typically instance variables) in a file that is often stored within the
application wrapper (that is, the “hidden” application directory).
Unarchiving, through initWithCoder:, reads the encoded class and state data and
restores the object to its previous state. There’s more on this topic in the
following pages.

3. Accessor methods. The declaration for accessor methods that rezurn values is, by
convention, the name of the instance variable preceded by the type of the
returned value in parentheses. Accessor methods that sez the value of instance
variables begin with “set” prepended to the name of the instance variable
(initial letter capitalized). The “set” method’s argument takes the type of the
instance variable and the method itself returns void.
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undatmn Framewaork consists of a base layer of classes

that specify fundamental object behavior plus a number of utlhty

: classes. It also introduces several paradigms that define

f functionality not covered by the Oblectlve -C language. Nntably,
- the Foundation Framework e

; mformatron see "NSStnng A String for All Countnes on page 82..

Makes software developmenteasrer by introducing consrstent ‘ You use NSBundle ob;ects toload code and localized resources
conventmns for things such as abject deallocatron SR dynamrcally (see “Only When Needed: Dynamically Loadmg ot
' . Resources and Code” on page 118). The NSUserDefaults class
nables you to store and access default values based on locale.

i de strlngs object persrstence and object

distribution

* Providesa Ievel"of'operating-system independence, b;ect Persistence and Dnstnhutlon

enhancing application portabili ,
~~l:9 ppl: P Y NSSerlalrzermakes|tpossmletorepresentthedatathatanohlect

: contains in an architecture-dependent way. NSCoder and its .
Root Class :

EEER N : subclasses take this process a step further by storing class
NSObject, the principal root class, provides the fundamental information along with the data, thereby enabling archiving and
behavior and interface for objects. It includes methods for - distribution. Archiving (NSArchiver) stores encoded objects and
... creating, initializing, deallocating, copying, comparing, and OthEl' data in files. Distribution denotes the transmrssmn of
“‘querying objects. Almost all OpenStep objects mhent ultlmately *encoded object data between different pracesses and threads ;
from NSOblect S ~. (NSPortCoder, NSConnectlon, NSDlstanIObject and others). . ;

_ . Other Functionality

The Foundation Framework ntroduces a mechanism for ensunng Date and time. The NSDate, NSCalendarDate and NSTimeZone
that objects are properly deallocated when they're no | nger classes generate objects that represent dates and times. They

needed This mechanism, which depends on gener offer methods for calculating temporal differences, for displaying -~
conformance to a policy of ohject ownership, autom ydates andtlmes in any desired format, and for adjustxng times and - :

tracks objects that are marked for release within a loop and dates based on location in the world . , o
deallocates them atthe close of the loop. See “Object Ownershi
Retentlon and Disposal” on page 88 for more mformatlon '

Deallocatnon of Objects

~; Appllcatlon coordmatlon NSNotlflcatlon NSNotlflcauonCenter,
and NSNotlflcatronQueue implement a system for broadcasting
notifications of changes within an application. Any object can

. ‘specrfy and post a notification, and.any other object can register
-itself as an observer of that notification. You can use an NSTimer
: Ob]ECttD send a message to another object at specrflc intervals.

Data Storage and Access

Foundation Framewcrk prowdés cbject-criented

an characters (NSStrlng
services. Many Foundation classes helpto

from the peculiarities of dlsparate cpera’ung

. ,:,Slmple C data values (NSVaIue and NSNumber)

; E- Ob;ectrve -C objects of any class (NSArray, NSchtmna
- NSSet, and NSPPL)

kNSArray, NSDictio 'ry, an SSet(and related mutable classes) e
are collection classesthat also allo :ycu to organize and access
objectsin certain ways (see “The Coll tion Classes” on page 74).': -

: appllcatlons and querythe e
ppllcatlon runs.

Text and Internationalization

ng internally represents text
lmportantly Unicode, making appllcatlons inhe
expressing a variety ( ofwntten languages NSStrir

Tmampulate a user's def
< globally, per applrcatron a

perlanguage.
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Implementing the Country Class

Implement the accessor
methods.

Select Country.min the project
browser.

Write the code that obtains and
sets the values of instance
variables.

In many situations you can send
retain instead of copy to keep an
object around. But for “value”
type objects, such as Country’s
instance variables, copy is better.
For the reason why, and for more
on autorelease, retain, copy, and
related messages for object
disposal and object retention, see
“Object Ownership, Retention,
and Disposal” on page 88.

Before You Go On

If you don’t want to allow an instance variable's value to be changed by anyone outside of your
class, don 't provide a set method for the instance variable. If you do provide a set method, make
sure objects of your own class use it when specifying a value for the instance variables. This has
important implications for subclasses of your class.

Exercise: The previous example shows the declarations for only a few accessor
methods. Every instance variable of the Country class should have an accessor
method that returns a value and one that sets a value. Complete the remaining
declarations.

Now that you’ve declared the Country class’s accessor methods, implement
them.

- (NSString *)name /* 1 %/
{

return name;

- (void)setName: (NSString *)str /* 2 */
{

[name autorelease];
name = [str copyl;

/* more accessor method implementations follow */

1. For “get” accessor methods (at least when the instance variables, like Travel
Advisor’s, hold immutable objects) simply return the instance variable.

2. For accessor methods that set odject values, first send autorelease to the current
instance variable, then copy (or retain) the passed-in value to the variable. The
autorelease message causes the previously assigned object to be released at the
end of the current event loop, keeping current references to the object valid
until then.

If che instance variable has a non-object value (such as an integer or float
value), you don’t need to autorelease and copy; just assign the new value.

Before You Go On

Exercise: The example above shows the implementation of the accessor methods
for the name instance variable. Implement the remaining accessor methods.
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Write the object-initialization
and object-deallocation code.

Implement the init method, as
shown here.

Implement the dealloc method,
following the suggestions in the
Required Exercise, below.

Don’t substitute nil when empty
objects are expected, and vice
versa. The Objective-C keyword
nil represents an “object” with an
id (value) of zero. An empty
object (such as @“”) is a true
object; it just has no content of its
given type. To learn more about
Objective-C keywords, see
Obyject-Oriented Programming and
the Objective-C Language.

Note that release itself doesn’t
deallocate objects, but it leads to
their deallocation. For more on
release and autorelease, sce
“Object Ownership, Retention,
and Disposal” on page 88.
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- (id)init

{

[super init]; /* 1 */

name = @""; [x2 %)
airports = @"";

airlines = @"";

transportation = @"";

hotels = @"";

languages = @"";

currencyName = @"";

comments = @"";

return self; /* 3 */

N . e
1. Invokes super’s (the superclass’s) init method to have inherited instance
variables initialized. Always do this first in an init method.

2. Initializes an NSString instance variable to an empty string. @"" is a compiler-
supported construction that creates an immutable NSString object from the
text enclosed by the quotes. You could have just as well typed:

name = @”Howdy Doody”;

But that wouldn’t have been practical as an initial value. You don’t need to
initialize instance variables to null values because the run-time system does
it for you, it assigns nil to objects, zeroes to integers and floats, and NULL to
char *’s if they’re not explicitly initialized. However, you should initialize
instance variables that take other starting values.

3. By returning self you’re returning a true instance of your object; up until this
point, the instance is considered undefined.

Before You Go On

Implement the dealloc method. In this method you release (that is, send release
or autorelease to) objects that you’ve created, copied, or retained (which don’t
have an impending autorelease). For the Country class, release all objects held as
instance variables. If you had other retained objects, you would release them,
and if you had dynamically allocated data, you would free it. When this method
completes, the Country object is deallocated. The dealloc method should send
dealloc to super as the /zsz thing it does, so that the Country object isn’t released
by its superclass before it’s had the chance to release all objects it owns.
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5

Implement the methods that
archive and unarchive the object.

Implement the
encodeWithCoder: method, as
shown at right.

Implement the initWithCoder:
method, as shown at right.

The NSCoder class provides a
number of methods for encoding
and decoding objects and data of
standard C types. See the
specification of the NSCoder
class in the Foundation
framework reference
documentation.

You want the Country objects created by the Travel Advisor application to be
persistent. That is, you want them to “remember” their state between sessions.
Archiving lets you do this by encoding the state of application objects in a file
along with their class membership. The NSCoding protocol defines two
methods that enable archiving for a class: encodeWithCoder: and initWithCoder:.

{

(void)encodeWithCoder:

(NSCoder *)coder
[coder encodeObject:namel; /* 1 */
[coder encodeObject:airports];

[ceder encodeObject:airlines];

[coder encodeObject:transportation];

[coder encodeObject:hotels];

[coder encodeObject:languages];

[coder encodeValueOfObjCType:"s" at:&englishSpoken];
[coder encodeObject:currencyName] ;

[coder encodeValueOfObjCType:"f" at:&currencyRatel];
[coder encodeObject:comments];

/* 2 x/

1. The encodeObject: method encodes a single object in the archival file.

2. For both object and non-object types, you can use encodeValue0OfObjCType:at:.

{

}

(1d) initWithCoder: (NSCoder *)coder

[ [coder decodeObject] copyl:; /* 1 */
airports = [[coder decodeObject] copyl;

airlines = [[coder decodeObject] copyl;

transportation = [[coder decodeObject] copyl;

hotels = [[coder decodeObject] copyl;

languages = [[coder decodeObject] copyl;

[coder decodeValueOfObjCType:"s" at:&englishSpoken];
currencyName = [[coder decodeObject] copy];

[coder decodeValueOfObjCType:"f" at:&currencyRatel;

[ [coder decodeObject] copyl];

name =

comments =

return self; - /* 2 %/

1. The order of decoding should be the same as the order of encoding; since
name is encoded first it should be decoded first. Use copy when you assign
value-type objects to instance variables (see “Object Ownership, Retention,
and Disposal” on page 88 ). NSCoder defines decode... methods that
correspond the encode... methods, which you should use.

2. As in any init.. method, end by returning self—an initialized instance.
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assume its extst'

The problem of object ownersh |p and disposal is a natural
concern in object-oriented programming When an objectis

- created and passed around various “consumer' objects in an

nppllca'uonﬁE

which object is responsible for dispos q of it?And

" when? If the object is not deallocated, memoryleaks Ifthe object p
- 0K, but now another question arises. Ifthe ownerofan object }

,must release the object within its programmatlc scope, how can

is deallocated

oon, problems may occur in other objects that
and the appllcatmn may crash,

The Foundatuon Framework introduces a mechamsm and a pohcy
that helps to ensure that abjects are deallocated when——and only
when—they are no longer needed

Who Owns Which Object?

The pelicy is quite simple: You are responsible for disposing oféll
objects that you own. You own objects that you create, either by

HowAutoreIease - myObj

Pools Work:
- An Example

retention count

A. myObj creates an object
anObj = [[MyClass alloc] 1n1t],

.+ B. myObj returns the ob ect to yourOhj, autoreleased

return [anObj autorelease]

rts trackmg the object.

: your0b| retams the oh]ect

,[anObj retaln] ;

ent event cycle.

: ,The oblect ts;' put” in the autorelease pool; that is, the autorelease

'objects that you retam, since retain increments an object’s

reference count (see facmg page). The flip side of this rule is: If
you don't own an object, you need notworry about releasing it.

t give that object to other ob]ects? The short answer is: the
autorelease method, which marks the receiver for later release,

. enabling it to live beyond the scope of the owning ob]ect S0 that

other objects can useit,

The autorelease method must be understood in‘a larger context =
of the autorelease mechanism for object deallocation. Through
this programmatic mechanism, you implement the policy of object
ownership and disposal.

Autorelease
pool

yourObj ‘

yourObj

~ Autorelease pool

the end of the event cycle, the autorelease pool sends release to
all of its objects, thereby decrementing their reference counts. Now
with a reference count of 1, anObj staysinthe autorelease pool

Autorelease pool
. ,yourObl sends autoreleas to the object. Atthe end of the event Po2

cycle, the autorelease pool sends release to its objectS' smce
refe ount i is now.zero, it's deallocated

For a fuller description of 0b|ect ownershlp and dlsposal see the
mtroductuon to the Foundation Framewo ference documen
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Reference Counts, Autorelease Pools, and Deallocation

Each object in the Foundation Framework has an associated
reference count. When you allocate or copy an object, its
reference count is set at 1. You send release to an object to
decrement its reference count. When the reference count
reaches zero, NSObject invokes the object’s dealloc method, and
the object is destroyed. However, successive consumers of the
object can delay its destruction by sending it retain, which
increments the reference count. You retain objects to ensure that
they won't be deallocated until you're done with them.

Each application has an autorelease pool. An autorelease pool
tracks objects marked for eventual release and releases them at
the appropriate time. You put an objectin the pool by sending the
object an autorelease message. When your code finishes
executing and control returns to the application object (typically
atthe end of the event cycle), the application object sends
release to the autorelease pool, and the pool releases each
object it contains. If afterwards the reference count of an object
in the pool is zero, the object is deallocated.

Putting the Policy Into Practice

When an object is used solely within the scope of the method that
creates it, you can deallocate itimmediately by sending it release.
Otherwise, send autorelease to all created objects that you no
longer need but will return or pass to other objects.

You shouldn't release objects that you receive from other objects
{unless you precede the release or autorelease with a retain). You
don't own these objects, and can assume that their owner has
seen to their eventual deallocation. You can also assume that
(with some exceptions, described below) a received object
remains valid within the method it was received in. That method
can also safely return the object to its invoker.

You should send release or autorelease to an object only as many
times as are allowed by its creation (one) plus the number of

retain messages you have sentit. You should never send free to a

- OpenStep object.

Implications of Retained Objects

When you retain an object you're sharing it with its owner and
other objects that have retained it. While this might be what you
want, itcanlead to some undesirable consequences. Ifthe owner
isreleased, any objectyou received fromit and retainedis usually
invalid. If you had retained an instance variable of the owning
object, and that instance variable is reassigned, your reference
would also become invalid.

copy Versus retain

When deciding whether to retain or copy objects, it helps to
categorize them as value abjects or entity objects. Value objects
are objects such as NSNumbers or NSStrings that encapsulate a
discrete, limited set of data. Entity objects, such as NSViews and
NSWindows, tend to be larger objects that manage and
coordinate subordinate objects. For value objects, use copy when
youwantyour own “snapshot” of the object; use retain when you
intend to share it. Always retain entity objects.

Inaccessor methodsthat set value-objectinstance variables, you
usually (but not always) want to make your own copy of the object
and not share it. (Otherwise it might change without your
knowing.) Send autorelease to the old object and then send
copy—not retain—to the new one:

- {(void)setTitle: (NSString *)newTitle
{
[title autorelease];
title = [newTitle copyl;
}
OpenStep framework classes can, for reasons of efficiency,

return objects cast as immutable when to the owner (the
framework class) they are mutable. Thus there is no guarantee

that a vended framework object won't change, evenifitisofan
_ immutable type. The precaution you should take is evident: copy =~

objects obtained from framework classes if it's importantthe
object shouldn‘t change from under you.
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The TAController class plays a central role in the Travel Advisor application. As
the application’s controller object, it transfers data from the model objects
(Country instances) to the fields of the interface and, when users enter or modify
data, back to the correct Country object. The TAController must also coordinate
the data displayed in the table view with the current object, and it must do the
right thing when users select an item in the table view or click the Add or Delete
button. All custom code specific to the user interface resides in TAController.

The mechanics of this activity require an array (NSMutableArray) and a
dictionary (NSMutableDictionary) for storing and accessing Country data. The
following diagram illustrates the relationship among interface components,
TAController, and the sources of data.

Key Value

Ol England _| ees. /0[] France _: Country _
1| France _England_; Country _
2| Germany___ _Germany ; Country _
I . . EN . [
al R R
5 o

Array TAController Dictionary

The dictionary contains Country objects (values) that are identified by the
names of countries (keys). The dictionary is the source of data for the fields of
"Travel Advisor. The array derives from the dictionary and is sorted. It is the
source of data for the table view.

After describing what other instance variables you must add to TAController,
this section covers the following implementation tasks:

Getting the data from Country objects to the interface and back
Getting the table view to work, including updating Country records
Adding and deleting “records” (Country objects)

Formatting and validating field values

“Housekeeping” tasks (application management)
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1

Update TAController.h.

Import Country.h.

Add the instance-variable
declarations shown at right.

Add the enum declaration shown
at right between the last #import
directive and the @interface
directive.

NSMutableDictionary *countryDict;
NSMutableArray *countryKeys;
BOOL recordNeedsSaving;

The variables countryDict and countryKeys identify the array and the dictionary
discussed on the previous page. The boolean recordNeedsSaving flags that record
if the user modifies the information in any field.

enum LogisticsFormTags {
LGairports=0,
LGairlines,
LGtransportation,
LGhotels

}i

"This declaration is not essential, but the enum constants provide a clear and
convenient way to identify the cells in the Logistics form. Methods such as
cellAtindex: identify the editable cells in a form through zero-based indexing.
This declaration gives each cell in the Logistics form a meaningful designation.

Turbo Coding With Project Builder

When you write code with Project Builder you have a set of
“workbench” tools at your disposal, among them:

Indentation

In Preferences you can setthe characters at which indentation
automatically occurs, the number of spaces per indentation, and
other global indentation characteristics. The Edit menu includes
the Indentation submenu, which allows you to indent lines or
blocks of code on a case-by-case basis.

Brace and Bracket Checking

Double-click a brace (left or right, it doesn’t matter) to locate the
matching brace; the code in-between the braces is highlighted. n
anidentical fashion, double-click a square bracket in a message
expression to locate the matching bracket.

" Name completion

‘ ‘Name completion is a facility that, given a partial name,
completes it from all symbols known by the project. You activate it

by pressing Escape (or Tab, if that key is bound in Preferences).
You can use name completion in the code editor and in all panels
where you are finding information or searching for files to open.

As an example: you know there's a certain constant to use with
fonts, but you cannot remember it. In your code, type NSFont.
Then press the Escape key several times. These symbols appear
in succession (the found portion is underlined):

NSFontidentityMatrix
NSFontManager
NSFontPanel

Emacs Bindings

You can issue the most common Emacs commands in Project
Builder's code editor. {Emacs is a popular editor for writing code.)
For example,‘there are the commands page-forward (Control-v),
word-forward (Meta-f), delete-word (Meta-d), kill-forward
(Control-k), and yank from kill ring (Cantrol-y). You can also
perform an incremental search by pressing Control-s; this
command displays a small search panel and takes you to the next
occurrence of whatever you type.
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Implement the methods that
transfer data to and from the
application’s fields.

Implement the populateFields:

method as shown at right.

92

Data Mediation

"TAController acts as the mediator of data exchanged between a source of data
and the display of that data. Data mediation involves taking data from fields,
storing it somewhere, and putting it back into the fields later. TAController has
two methods related to data mediation: populateFields: puts Country instance data
into the fields of Travel Advisor and extractFields: updates a Country object with
the information in the fields.

- (void)populateFields: (Country *)aRec
{ ) ) :
[countryField setStringValue: [aRec namel]; /* 1 */

[[logisticsForm cellAtIndex:LGairports] setStringValue:
[aRec airports]]; /* 2%/
[[logisticsForm cellAtIndex:LGairlines] setStringValue:
[aRec alrllnes]], : :
[[logisticsForm cellAtIndex: LGtransportatlon] setStringValue:
[aRec transportation]];
[[logisticsForm cellAtIndex LGhotels] setStringValue:
[aRec hotels]],ﬂ ' .

[currencyName 1eld setstrlngValue [aRec currencyName]],

[currencyRateFleld setFloatValue: [aRec currencyRate]l:;

[languagesField setStringValue:[aR languages]l;
lenglishSpokenSwitch setState:[aRe ﬁglishSpoken]{i

3y

1. Causes the Country field to display the value of the name instance variable of
the Country record (aRec) passed into the method. Since [aRec name] is nested,
the object it returns is used as the argument of setStringValue:, which sets the
textual content of the receiver (in this case, an NSTextFieldCell).

2. The cellAtindex: message is sent to the form and returns the cell identified by
the enum constant LGairports.

3. Selects the text in the Country field or, if there is no text, inserts the cursor.

Although it doesn’t do anything with data, the blankFields: method is similar in
structure to populateFields:. The blankFields: method clears whatever appears in
Travel Advisor’s fields by inserting empty string objects and zeros.
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Implement the blankFields:
method as shown at right.

- (void)blankFields: (id)sender
{
[countryField setStringvalue:@""};

[[logisticsForm cellAtIndex:LGairports] setStringValue:@""];
[[logisticsForm cellAtIndex:LGairlines] setStringValue:@""];
[[logisticsForm cellAtIndex:LGtransportation] setStringValue:@"
[[logisticsForm cellAtIndex:LGhotels] setStringValue:@""];

[currencyNameField setStringValue:@""];

[currencyRateField setFloatValue:0.000];

[languagesField setStringValue:@""];

[englishSpokenSwitch setState:NO]J; /* 1 */

[currencyDollarsField setFloatvalue:0.00];
[currencyLocalField setFloatValue:0.00];
[celsius setIntValue:0];

[commentsField setString:@"" ]; /* 2 */
[countryField selectText:self];

1. The setState: message affects the appearance of two-state toggled controls,
such as a switch button. With an argument of YES, the checkmark appears;
with an argument of NO, the checkmark is removed.

2. The setString: message sets the textual contents of NSText objects (such as the
one enclosed by the scroll view).

Before You Go On

Exercise: Implement the extractFields: method. In this method set the values of the

passed-in Country record’s instance variables with the contents of the associated
fields.

Tip: Use the stringValue method to get field contents and use Country’s accessor
methods to set the values of instance variables.
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The Project Find Panel

The Project Find panel lets you find any symbol defined or referenced in your project. It
also allows you to look up related reference documentation, search for text project-
wide using regular expressions, and replace symbols or strings of text. To use the full
power of Project Find, your project must be indexed; once it is, you have access to all
symbols that the project references, including symbols defined in the frameworks and

libraries linked into the project.

TravelAdvnsor — Pru;ect Find

£ -1n1tW1thFrame

Search for: symbol definition,
symbol reference, textual
strings (with or without
regular expressions)

Lists the targets of recent
find operations; selecting one
re-displays the results in the
browser.

Clicka baak icon to see the
related reference .
documentation.

Symbol Definition Search Syhtax

~ You can narrow your search for definitions of symbols by

indicating type inthe Find field of the Project Find panel along with
the symbol name. Once the symbolitems are listed in the browser,

~ you can click an item to navigate to the definition in the header
file, or click a book icon to display the relevant reference
documentation.

The following table hsts examples of searchmg for symbol
: deflnmons by type:

E’Sample §? mds DEﬁnltion For o

@NSArray -
<NSCoding>

f-objectAtIndéx:
-FstringWithForma

' NSArray class
,;NSCoding proto ol
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Find and replace buttons.

~ Search results.

- Click an item to display
the relevant code

Other Ways of Finding Information

Project Builder includes other facilities for finding information:

* Incremental search:Control-s brings up the incremental-

search panel for the currently edited file. As you type, the

cursor advances to the next sequence of characters in the file
that match what you type. Click Next {or press Control-s) to go
to the next occurrence; click Prev (or press Control-r) to go to
the previous occurrence. ‘

Man pages: Choose Edit » Find ™ Man Page to bring up the
“Show man page” panel. Enter the name of a tonl in the panel
to get the man page on that tool.

ibrarian vna Servuces Select a symbol or any word (for
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Implement the behavior of the
table view's data source.

In TAController's awakeFromNib
method, create and sort the array
of country names.

In the same method, designate
self as the data source.

If users are supposed to edit the
cells of the table view, you would
also make TAController the
delegate of the table view at this
point (with setDelegate:). The
delegate receives messages
relating to the editing and
validation of cell contents. For
details, see the specification on
NSTableView in the Application
Kit reference documentation.

Getting the Table View to Work

Table views are objects that display data as records (rows) with attributes
(columns). The table view in Travel Advisor displays the simplest kind of
record, with each record having only one attribute: a country name.

Table views get the data they display from a data source. A data source is an
object that implements the informal NSTableDataSource protocol to respond to
NSTableView requests for data. Since the NSTableView organizes records by
zero-based indexing, it is essential that the data source organizes the data it
provides to the NSTableView similarly: in an array.

- (void)awakeFromNib

{
NSArray *tmpArray = [[countryDict allKeys] /* 1 %/
sortedArrayUsingSelector:@selector (compare:)];

countryKeys = [[NSMutableArray alloc] initWithArray:tmpArray];

[tableView setDataSource:self]; /r 2 %

[[[tableView tableColumns] objectAtIndex:0] /* 3 */
setIdentifier:@"Countries"];

[tableView sizeLastColumnToFit];

1. The [countryDictallKeys] message returns an array of keys (country names) from
the unarchived dictionary that contains Country objects as values. The
sortedArrayUsingSelector: message sorts the items in this “raw” array using the
compare: method defined by the class of the objects in the array, in this case
NSString (this is an example of polymorphism and dynamic binding). The
sorted names go into a temporary NSArray—since that is the type of the
returned value—and this temporary array is used to create a mutable array,
which is then assigned to countryKeys. A mutable array is necessary because
users may add or delete countries from the application.

2. The [tableView setDataSource:selfl message identifies the TAController object as
the table view’s data source. The table view will commence sending
NSTableDataSource messages to TAController. (You can effect the same
thing by setting the NSTableView’s dataSource outlet in Interface Builder.)

3. Every column has an identifier to associate it with a column, which is itself
usually associated with an attribute. By default, the identifier is a number: the
first column is 0, the second column is 1, and so on. This compound message
makes the identifier a string object and thus binds it semantically to the
attribute. The tableColumns method returns all NSTableColumns in a array; in
this case, only the single column of this table view. The setldentifier: message
sets the value.
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Implement two methods of the
NSTableDataSource informal
protocol:

—numberOfRowsInTableView:

—tableView:

objectValueForTableColumn:

row:

96

To fulfill its role as data source, TAController must implement two methods of
the NSTableDataSource informal protocol.

leView

{ _ : /* 1%/
return [countryKeys count]; .

) .

- {id)tableView: (NSTableView *)theTableView: /* 2 %/

objectValueForTableColumn: (NSTableColumn *)theColumn
row: (int)rowIndex :

if ([[theColumn identifier] isEqualToString:@"Countries"])
return [countryKeys objectAtIndex:rowIndex];

else
return nil;

1. Returns the number of country names in the countryKeys array.

If you had an application with multiple table views, each would invoke this
NSTableView delegation method (as well as the others). By evaluating the
theTableView argument, you could distinguish which table view was involved.

2. This method first evaluates the column identifier to determine if it’s the right
column (it should always return “Countries”). If it is, the method returns the
country name from the countryKeys array that is associated with rowindex. This
name is then displayed at rowlIndex of the column. (Remember, the array and
the cells of the column are synchronized in terms of their indexing,)

The NSTableDataSource informal protocol has a another method,
tableView:setObjectValue:forTableColumn:row;, that you won'’t implement in this
tutorial. This method allows the data source to extract data entered by users into
table-view cells; since Travel Advisor’s table view is read-only, there is no need
to implement it.
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Getting in on the Action: Delegation and Notification

Alot goes on in a running application: events are being
interpreted, files are being read, views are being drawn. Because
your custom objects might be interested in any of these activities,
OpenStep offer two mechanisms through which your abjects can
participate or be kept informed of events going on in the
application: delegation and notification.

Delegation

Many OpenStep framework objects hold a delegate as an
instance variable. A delegate is a object that receives messages
from the framework object when specific events occur.
Delegation messages are of several types, depending on the
expected role of the delegate:

* Some messages are purely informational, occurring after an
event has happened. They allow a delegate to coordinate its
actions with the other object.

* Some messages are sent before an action will occur, allowing
the delegate to veto or permit the action.

» Other delegation messages assign a specific taskto a
delegate, like filling a browser with cells.

Notification

A notificationis a message that is broadcast to all objects in an
application that are interested in the event the notification
represents. As does the informational delegation message, the
notification informs these observersthat this event took place. It
can also pass along relevant data about the event.

notification center

o ©\ posts
‘delegate:
1 C )

0OddBallDidActSillyNotification

You can setyour custom object to be the delegate of a framework
object pragrammatically or in Interface Builder. Your custom
classes can also define their own delegate variables and
delegation protocols for client objects.

Here's the way the notification process works:

* QObjects who are interested in an event that happens
elsewhere in the application — say the addition of a record to
a database — register themselves with a notification center
(an instance of NSNotificationCenter) as observers of that
event. Delegates of an object that posts notifications are
automatically registered as observers of those notifications.

¢ The object that adds the object to the database (or some such
event) posts a natification (an instance of NSNotification) to a
notification center. The notification contains a tag identifying
the notification, the id of the associated object, and, optionally,
a dictionary of supplemental data.

* The notification center then sends a message to each
observer, invoking the method specified by each, and passing
in the notification.

Notifications hold some advantages over delegation messages as
ameans of inter-application communication. They allow an object
to synchronize its behavior and state with muitiple objects in an
application, and without having to know the identity of those
objects. With notification queues, it is also possible to post
notifications asynchronously and coalesce similar notifications.
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The final thing you need to do to get the table view working is to respond to
mouse clicks in it. As you recall, you defined in Interface Builder the
handleTVClick: action for this purpose. This method must do a number of things:

¢ Save the current Country object or create a new one.
o If there’s a new record, re-sort the array providing data to the table view.
¢ Display the selected record.

4 Update records. " - (void)handleTvClick: (id)sender

Implement the method that { :
respondstouserselectionsinthe . Country *aRec, *newRec, *newerRec;

table view. int index;

. /* does current obj need to be saved? */
if (recordNeedsSaving) { /x 1 %/
/* is current object already in dictionary? */
if (aRec:[countryDict;objectForKey:[countryField stringValuell])

/* remove if it's been changed */

if (aRec) { g
NSString *country = [aRec name];
[countryDictkremoveObjectForKey:country];
[countryKeys removeObject:country];

}

/* Create Country Obj,‘add to dict, add name to keys array */
newRec = [[Country allbc] init];

[self extractFlelds newRec] ;

[countrychtsetObject newRecforKey [countryFleldstrlngValue]],
[countryKeys addObject: [countryFleld stringValuell;

ff* sort array here */
QIcountryKeys sortU51ngSelector @selector(compare )1:
‘[tableview tile]l;
}
index = [sender selectedRow]; i o
if (index >= 0 && index < [countryKeys count]) { /* 2 */

ﬁgWithFormat:
@“Notes‘ nd Itinerary for %@", [countryField stringValuell];
recordNe dsSav1ng NO; e " o

This method has two major sections, each introduced by an if statement.
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1. When any Country-object data is added or altered, Travel Advisor sets the
recordNeedsSaving flag to YES (you’ll learn how to do this on later on). If
recordNeedsSaving is YES, first delete any existing Country record for that
country from the dictionary and also remove the country name from the table
view’s array. (Upon removal, the objects are automatically released by the
array.) Then create a new Country instance and initialize it with the values
currently on the screen; add the instance to the dictionary, add the country
name to the table view’s array, sort the array, and reset the recordNeedsSaving
flag. At the end, invoke the tile method , which (among other things) causes
the table view to request data from its data source.

2. The selectedRow message queries the table view for the row index of the cell
that was clicked. If this index is within expected bounds, use it to get the
country name from the array, and then use the country name as the key to get
the associated Country instance. Write the instance-variable values of this
instance to the fields of the application, update the “Notes and Itinerary for”
label.

Optional Exercise

Application developers often like to have key alternatives to mouse actions such
as clicking a table view. One way of acquiring a key alternative is to add a menu
cell in Interface Builder, specify a key as an attribute of the cell, define an action
method that will be invoked, and then implement that method.

The methods nextRecord: and prevRecord: should be invoked when users chose
Next Record and Prev Record or type the key equivalents Command-n and
Command-r. In TAControllerm, implement these methods, keeping the following
hints in mind: '

1. Get the index of the selected row (selectedRow).

2. Increment or decrement this index, according to which key is pressed (or
which command is clicked).

3. If the start or end of the table view is encountered, “wrap” the selection.
(Hint: Use the index of the last object in the countryKeys array.)

4. Using the index, select the new row, but don’t extend the selection.

5. Simulate a mouse click on the new row by sending handleTVClick: to self.
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Adding and Deleting Records

When users click Add Record to enter a Country “record,” the addRecord:
method is invoked. You want this method to do a few things besides adding a
Country object to the application’s dictionary:

* Ensure that a country name has been entered.
® Make the table view reflect the new record.
e If the record already exists, update it (but only if it’s been modified).

5 Implement the method that adds
a Country object to the

- (void)addRecord: (id) sender

NSDictionary “database.” ¢
! Country *aCountry;
; NSString *countryName = [countryField stringValue];
/* 1 */ Ti9 i
if (countryName && (! [countryName isEqualToString:@" "])) {
| .~ aCountry = [countryDict objectForKey:countryName];

if (aCountry && recordNeedsSaving) {
/*'remoVe 0ld Country object from dictionary */
[countryDict removeObjectForKey:countryName];
~ [countryKeys removeObject:countryName];
aCountry = nil; )
}
if (!aCountry) /* record is new or has been removed */
aCountry [ [Country alloc] 1n1t], : R :

Celes

/* record lready ex1sts and hasn t changed‘*/ B

'[self extractFlelds aCountry],
[countryDict setObject:aCountry forKey [aCountry

[countryKeys addObject: [aCountry namel];
-[countryKeys sortUsingSelector:@selector (compar
/* 3 %/

recordNeedsSaving=NO;.
[commentsLabel setStringValue: [NSString strlngwlthFormat

@"Notes and Itinerary for %@",[countryFleld strlngValue]
[countryField selectText: self],

*/

[tableView tile];
[tableView selectRow: [coun Ke Ok
[aCountry name]]. byExtendlngSel tlon NO]

1. 'This section of code verifies that a country name has been entered and sees
if there is a Country object in the dictionary. If there’s no object for the key,
objectForKey: returns nil. If the object exists and it’s flagged as modified, the
code removes it from the dictionary and removes the country name from the
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countryKeys array. Note that removing an object from a dictionary or array also
releases it, so the code sets aCountry to nil. It then tests aCountry and, if it’s nil,
creates a new object; otherwise it just returns, because an object already exists
for this country and it hasn’t been modified.

2. After updating the new Country object with the information on the
application’s fields (extractFields:), this code adds the Country object to the
dictionary and the country name to the countryKeys array.

3. This section of code performs some things that have to be done, such as
resetting the recordNeedsSaving flag and updating the label over the scroll view
to reflect the just-added country.

4. The tile message forces the table view to update its contents. The
selectRow:byExtendingSelection: message highlights the new record in the table
view.

Before You Go On

Exercise: Implement the deleteRecord: method. Although similar in structure to
addRecord: this method is much simpler, because you don’t need to worry about
whether a Country record has been modified. Once you’ve deleted the record,
remember to update the table view and clear the fields of the application.

Abstract Classes and Class Clusters

appropriate private subclass. What's
appropriate depends on the creation

Many of the classes in the Foundation
Framework fall into functional constellations

of public and private classes called class
clusters. Class clusters simplify the
programming interface and permit more
efficient storage of data.

An abstract class (such as NSArray) defines
the public interface for objects vended from
class clusters. Abstract classes declare
methods common to private, concrete
subclasses, but do not declare any instance
variables to hold data—that's done by the
private classes. When you send an object-
creation message to an abstract class, it
instantiates and returns an instance of the

method, which indicates the type of storage
required. The class membership of the
returned objectis hidden, butits interface, as
declared by the abstract superclass, is
public. o

Many OpenStep class clusters have two or
more abstract classes. Usually one class
provides the interface for obtaining ;
immutable objects (for example, NSArray)
and another class, which inherits from the
mutable class, vends mutable versions of the
same type of object (NSMutableArray). -
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Field Formatting and Validation

Travel Advisor has several numeric fields. Some display temperatures while
others display currency amounts. In this stage, you’ll enable these fields to
format their contents by using a formatting API defined in the Application Kit.

6 Format and validate numeric - (void)awakeFromNib
fields. (

[[currencyRateField cell] setEntryType:NSFloatTypel;

point format of some TAController [[currencyRateField cell] setFloatingPointFormat:YES

fields in the awakeFromNib left:2 right:1];

method. [[currencyDollarsField cell] setEntryType:NSFloatType];

[[currencyDollarsField cell] setFloatingPointFormat:YES left:5
right:2];

[[currencylLocalField cell] setEntryType:NSFloatType];

[ [currencyLocalField cell] setFloatingPointFormat:YES left:5
right:21};

[[celsius cell] setEntryType:NSFloatTypel;

[[celsius cell] setFloatingPointFormat:YES left:2 right:1];

Set the entry type and floating-

The NSCell class provides methods for specifying how cell values are
formatted. In this instance, setEntryType: sets the type of value as a float and
setFloatingPointFormatleftright: specifies the number of digits on each side of the
decimal point.

The NSControl'class gives you an API for validating the contents of cells.
Validation verifies that the values of cells fall within certain limits or meet
certain criteria. In Travel Advisor, we want to make sure that the user does not
enter a negative value in the Rate field.

The request for validation is a message—control:isValidObject—that a control
sends to its delegate. The control, in this case, is the Rate field.

In awakeFromNib, make
TAController a delegate of the
field to be validated.

[currencyRateField setDelegate:self];

Implement the - (BOOL) control: (NSControl *)control isValidObject: (id)obj
control:isValidObject: method to g o o
validate the value of the field. % if (control == currencyRateField) { /* L x/
if (lobj floatvalue] < 0.0) { -
NSRunAlertPanel (@"Travel Advisor", /* 2 %/

@"Rate cannot be negative.", nil, nil, nil);
return NO; i
}

return YES;
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Behind “Click Here": Controls, Cells, and Formatters

Controls and cells lie behind the appearance and behavior of
most user-interface objects in OpenStep, including buttons, text
fields, sliders, and browsers. Although they are quite different
types of objects—controls inherit from NSControl while cells
inherit from NSCell—they interact closely.

Controls enable users to signal their intentions to an application,
and thus to contro/what is happening. By interpreting mouse and
keyboard events and asking another object to respond to them,
controls implement the target/action paradigm described in
“Paths for Object Communication: Outlets, Targets, and Actions”
on page 38. Controls themselves can hold targets and actions as
instance variables, but usually they get this data from the affected
cell (which must inherit from NSActionCell).

Cells are rectangular areas “embedded” within a control. A
control can hold multiple cells as a way to partition its surface into
active areas. Cells can draw their own contents either as text or
image (and sometimes as hoth), and they can respond individually
to user actions. Since cells are typically more frugal consumers of
memory than controls, they help applications be more efficient.

cell
(NSButtonCell)

control
(NSMatrix)

control
cell {NSTextField)
{NSTextFieldCell)

Controls act as managers of their cells, telling them when and
where to draw, and notifying them when a user event (mouse
clicks, keystrokes) occurs in their areas. This division of labor,
given the relative “weight” of cells and controls, provides a great
boost to application performance.

tracking messages

Control

Cell

drawing messages

A control does not have to have a cell associated with it, but most
user-interface objects available on Interface Builder's standard
palettes are cell-control combinations. Even a simple button—
from Interface Builder or programmatically created—is a control
(an NSButton instance) associated with an NSButtonCell. The
cellsin a control such as a matrix must be the same size, but they
can be of different classes. More complex controls, such as table
views and browsers, can incorporate various types of cells.

Cells and Formatters

When one thinks of the contents of cells, it's natural to consider
only text {(NSString) and images (NSImage). The content seems to
be whatever is displayed. However, cells can hold other kinds of
objects, such as dates (NSDate), numbers {NSNumber), and
custom objects (say, phone-number objects).

Formatter objects handle the textual representation of the objects
associated with cells and translate what is typed into a cell into
the underlying object. Using NSCell’s setFormatter:, you must
programmatically associate a formatter with a cell to get this
behavior.

NSDateFormatter

translates the
textual
contents... #

..into the
underlying
object...

NSDate

...and vice
versa

The Foundation Framework provides the NSDateFormatter class
to generate date formatters and will release other specialized
formatter classes in the future. You can make a custom subclass
of NSFormatter to derive your own formatters.
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For more information on
NSRunAlertPanell(), see the
“Functions” section of the
Application Kit (framework)
reference documentation.
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1. Because you might have more than one field’s value to validate, this example
first determines which field is sending the message. It then checks the field’s
value (passed in as the second object); if it is negative, it displays an attention
panel and returns NO, blocking the entry of the value. Otherwise, it returns
YES and the field accepts the value.

2. 'The NSRunAlertPanel() function allows you to display a modal attention panel
from any point in your code. The above example calls this function simply to
inform the user why the value cannot be accepted.

Although Travel Advisor doesn’t evaluate it, the NSRunAlertPanel() function
returns a constant indicating which button the user clicks on the panel. The
logic of your code could therefore branch according to user input. In
addition, the function allows you to insert variable information (using printf()-
style conversion specifiers) into the body of the message.
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Application Management

By now you’ve finished the major coding tasks for Travel Advisor. All that
remains to implement are a half dozen or so methods. Some of these methods
perform tasks that every application should do. Others provide bits of
functionality that Travel Advisor requires. In this section you’ll:

Archive and unarchive the TAController object.
Implement TAController’s init and dealloc methods.
Save data when the application terminates.

e Mark the current record when users make a change.
Obtain and display converted currency values.

The data that users enter into Travel Advisor should be saved in the file system,
or archived. The best time to initiate archiving in Travel Advisor is when the
application is about to terminate. Earlier you made TAController the delegate
of the application object (NSApp). Now respond to the delegate message
applicationShouldTerminate:, which is sent just before the application terminates.

7  Archive the application’s objects

when it terminates. - (BOOL)applicationShouldTerminate: (id)sender

{ /* 1 %/
Implement the delegate method NSString *storePath = [[[NSBundle mainBundle] bundlePath]
applicationShouldTerminate:, as stringByAppendingPathComponent:@"TravelData"];
shown at right. /* save current record if it is new or changed */

[self addRecord:self];
/* 2 */
if (countryDict && [countryDict count])
[NSArchiver archiveRootObject:countryDict toFile:storePath]

return YES;

1. Constructs a pathname to the application wrapper in which to store the
archive file “TravelData.” The application wrapper—the “hidden” directory
holding the application executable and required resources—is a bundle, so
NSBundle methods are used to get the bundie path.

2. If the countryDict dictionary holds Country objects, TAController archives it
with the NSArchiver class method archiveRootObject:toFile:. Since the dictionary
is designated as the root object for archiving, all objects that the dictionary
references (that is, the Country objects it contains) will be archived too.
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8 Implement TAController's
methods for initializing and
deallocating itself.

Implement the init method, as
shown at right.

Implement the dealloc method to

release objectinstance variables.
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- (id)init

.
Al 1 %/ f
.~ NSString *storePath = [[NSBundle mainBundle]
pathEorResource:@"Tf&ﬁeiData“ ofType:nil];
[super init]; k
/* 2 %/
countryDict = [NSUnarchiver unarchiveObjectWithFile:storePath];
/* 3 %/
if (!countryDict) {
countryDict = [[NSMutableDictionary alloc] init];
countryKeys = [[NSMutableArray alloc] initWithCapacity:10];
} else . :
countryDict = [countryDict retain];
recordNeedsSaving=NO;
return self;
}

1. Using NSBundle methods, locates the archive file “TravelData” in the applicati

wrapper and returns the path to it.

2. The unarchiveObjectWithFile: message unarchives (that is, restores) the object whos:

attributes are encoded in the specified file. The object that is unarchived and
returned is the NSDictionary of Country objects (countryDict).

3. If no NSDictionary is unarchived, the countryDictinstance variable remains nil. If tl

is the case, TAController creates an empty countryDict dictionary and an empty
countryKeys array. Otherwise, it retains the instance variable.

,Flatte‘ﬁ‘ing the Object Network: Coding and Archiving

Co‘ding, as implemented by NSCoder, takes _  the encodeWithCoder: and mltWIthCoder
a network of objects such as,,emst inan  methods.
, apphcatlon and serializes th data, - '

ﬁ 'Thus sending archweRootOb]ect toFile: to
and class membershlps ofthe oblects Asa NSArchiver leads to the invocation of

subclass ofNSCoder NSArchwe : ... encodeWithCoder: in the root object and in.

all referenced objects thatimplementit.

* Similarly, sending unarchiveObjectWithFile:
to NSUnarchiver results in initWithCoder:

- being invoked in those objects referenced in

- the archive file. These objects reconstitute .
themselves from the instance datain the file.
In thts way, the network of Oh]ECtS, three-
dlmensmnal in abstractuon is converted to

a two-dimensional stream of data and

back agam
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9

Write the code that marks
records as modified.

In the awakeFromNib method,
make TAController an observer of
NSControlTextDidChangeNotification.

Implement textDidChange: to set
the recordNeedsSaving flag.

You post notifications and add
objects as observers of
notifications with methods
defined in the
NSNotificationCenter class.
NSNotification defines methods
for creating notification objects
and for accessing their attributes.
See the specifications of these
classes in the Foundation
Framework reference
documentation.

Implement the method that
responds to a request for a
currency conversion.

When users modify data in fields of Travel Advisor, you want to mark the current
record as modified so later you’ll know to save it. The Application Kit broadcasts
a notification whenever text in the application is altered. To receive this
notification, add TAController to the list of the notification’s observers.

[[NSNotificationCenter defaultCenter] addObserver:self
selector:@selector (textDidChange:)
name:NSControlTextDidChangeNotification object:nil];

Next, implement the method that you indicated would respond to the
notification; this method sets a flag, thereby marking the record as changed.

- (void)textDidChange: (NSNotification *)notification

{
if ([notification object] == currencyDollarsField ||
[notification object] == celsius) return;

recordNeedsSaving=YES;

"Two of the editable fields of Travel Advisor hold temporary values used in
conversions and so are not saved. This statement checks if these fields are the
ones originating the notification and, if they are, returns without setting the flag.
(The object message obtains the object associated with the notification.)

The final method to implement is almost identical to the one you wrote for
Currency Converter to display the results of a currency conversion when the
user clicks the Convert button for currency conversion.

- (void)convertCurrency: (id) sender
{
[currencylocalField setFloatValue:
[converter convertAmount: [currencyDollarsField floatValue]
byRate: [currencyRateField floatValuelll;

Optional Exercise

Convert Celsius to Fahrenheit: Implement the convertCelsius: method. You’ve already
specified and connected the necessary outlets (celsius, fahrenheit) and action
(convertCelsius:), so all that remains is the method implementation. The formula
you’ll need is:

F° =9/5C° + 32
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Project Builder's graphical debugger provides an
easy-to-use, intuitive user interface to gdb, the
GNU debugger. ‘

ountrym y verpmerre Launch program; run debugger; inspect
AController.m /2 task (breakpoints, stack, etc.)

| W TR Run the application being debugged;
interrupt and continue the application.

i

TravelAdvisor — Lau

- Print value, print referenced value, print
object description (select variable first).

Step over, step into statement.

0x14000000 offset Ox@
Reading symbols from loaded file'
/NextLibrary/Frameworks/System. framework /Versions/A/System at 9x5000000
offset 0x@

Reading symbols from loaded file...done.

Apr 10 21:18:59 TravelAdvisor[8549] Could not connect the action
switchedChecked: to target of class TAController

Launch options (see below)

- (BOOL)t|
¢ !

Breakpoint 1, -[TAController awakeFromNib] (self=8x14848c.

recori L&Y cmd=Bx626ef58) at TAController.m:255

retur

You can also issue gdb commands on the
command line.

- (BOOL)spplicationShouldTerminate: (id)sender
{

NSString *storePath = [[[NSBundle mainBundle] bundlePath]
stringByAppendingPathComponent:@"TravelData"]:
- n *

Launch Options

Launch options affect both
launched and debugged programs.
The inspector displays allow you to
set target executables,
environment variables, and source
directories.
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Building and Running Travel Advisor

When Travel Advisor is built, start it up by double-clicking the icon in the File
Manager. Then put the application through the following tests:

* Enter a few records. Make up geographical information if you have to—
you’re not trusting your future travels to this application. Not yet, anyway.

e (Click the items in the table view and notice how the selected records are
displayed. Press Command-n and Command-r and observe what happens.

* Enter values in the conversion fields to see how they’re automatically
formatted. Tty to enter a negative value in the Rate field.

* Quit the application and then start it up again. Notice how the application
displays the same records that you entered.

Tips for Eliminating Deallocation Bugs

Problems in object deallocation are not unusual in OpenStep
applications under development. You might release an objecttoo
many times or you might not release an object as many times as
is needed to deallocate it. Both situations lead to nasty problems
—inthe first case, to run-time errars when your code references
non-existent objects; the second case leads to memory leaks.

If you're releasing an object too many times, you'll get run-time
error messages telling you that a message was sent to a freed
object. To find which methods were releasing the object, in gdb or
the graphical debugger::

1 Send enableFreedOhjectCheck: to NSAutoreleasePool with
an argument of YES.

2 Set a breakpoint on _NSAutoreleaseFreedObject.
3 Runthe program under the debugger.

4 When the program hits the breakpoint, do a backtrace and
check the stack to find the method releasing the object.

Other tools help you track down problems related to release and
autorelease:

* The oh command records allocation and deallocation events
related to a specific process. It produces a report showing the
stack frame for an object each time the object is allocated,
copied, retained or released.

The AnalyzeAllocation tool compiles statistics on memory
allocation during the time a program executes.

See the man pages on these tools for more information.

Avoiding Deallocation Errors

Here’s a few things to remember that might help you avoid
deallocation bugs in OpenStep code:

Make sure there’s an alloc, copy, mutableCopy, or retain
message sent to an object for each release or autorelease
senttoit.

When you release a collection abject {such as an NSArray),
you release all objects stored in it as well. When you request
an object stored in a collection object, it's returned to you
autoreleased.

Superviews retain subviews as you add them to the view
hierarchy and release subviews as you release them. If you
want to keep swapped-out views, you should retain them.
Similarly, when you replace a window's or box’s content view,
the old view is released and the new view is retained.

To avoid retain cycles, objects should not retain their
delegates. Objects also should not retain their outlets, since
they do not own them. :
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Many kinds of applications—word processors and spreadsheets, to name a
couple—are designed with the notion of a document in mind. A document is a
body of information, usually contained by a window, that is self-contained and
repeatable. Users can create, modify, store, and access a document as a discrete
unit. Multi-document applications (as these programs are called) can generate
an almost unlimited number of documents.

The To Do application presented in this chapter is a multi-document
application, It is a fairly simple personal information manager (PIM). Each To
Do document captures the daily “must-do” items for a particular purpose. For
instance, one could have a To Do list for work and another one for home. To Do
allows users to:

¢ Enter appointments or actions that they must complete on particular days.
Specify the times those items are due.

* Receive notifications at a specified interval before the due time.

¢ Associate notes with to-do items. '

¢ Mark items as complete or deferred.

;T E Work Schedule.td — ~/Misc

-« January 1996 P

Sun. Mon Tue Wed Thu Fri Sat

s/Dug To Do on'Tue January 30 1836
00AM |[ooard meeting

As with 'Travel Advisor, you’re going to cover a lot of OpenStep territory by
completing this tutorial. It explores two major areas:

¢ Muldi-document architecture: The design of applications that can create
multiple documents, save and restore those documents, and do the right
thing on certain events, such as application termination.
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¢ Strategies for subclassing: Reuse of existing classes by adding behavior and
data, by overriding existing behavior, or by doing both things.

You will also learn about other aspects of OpenStep programming:

* Opening and saving files

® Loading nib files (and other bundles) programmatically

* Creating and managing inspectors

¢ Programmatic creation and manipulation of user-interface objects
¢ Time and date manipulation

® Declaring informal protocols

¢ Using timers

And you’ll be introduced to these important OpenStep concepts:

¢ Event handling
* The core program framework
® Drawing and image composition

When you complete this tutorial, you should be ready to tackle OpenStep
programming on your own.

Starting Up — What Happens in NSApplicationMain()

Every OpenStep application project created through Project 2 Gets the Class object for NSApplication and invokes its
Builder has the same main() function (in the file sharedApplication class method, creating an instance of
ApplicationName_main.m). When users double-click an NSApplication, which is stored in the global variable, NSApp.
application or document icon in the File Viewer, main{) (the entry Creating the NSApplication object connects the application to
point) is called first; main(), in turn, calls NSApplicationMain(}— the window system and the Display PostScript server, and
and that's all it does. initializes its PostScript environment.

3 Loads the main nib file, specifying NSApp as the owner.
The NSApplicationMain() function does what's necessary to get Loading unarchives and re-creates application objects and
an OpenStep application up and running—responding to events, restores the connections between objects.

coordinating the activity of its objects, and so on. The function o ) ) .
starts the network of objects inthe application sending messages 4 Runsthe application by starting the main event loop. Eachtime

to each other. Specifically, NSApplicationMain(): , through the loop, the application abject gets the next available
event from the Window Server and dispatches it to the most

appropriate object in the application. The loop continues until
the application object receives a stop: or terminate: message,
after which the application is released and the program exits.

1 Gets the application’s attributes, which are stored in the
application wrapper as a property list. From this property list,
itgets the names of the main nib file and the principal class (for

_applications, this is NSAppIicatioh or a custom subclass of You can add your own code tomain() to customize application
_NSApplication). s start-up or termination behavior.
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The Design of To Do

The ToDolnspector instance in
the above diagram is an offshoot
of the application controller,
ToDoController. By breaking
down a problem domain into
distinct areas of responsibility,
and assigning certain types of
objects to each area, you increase
the modularity and reusability of
the object, and make
maintenance and trouble-
shooting easier. See “Object-
Oriented Programming” in the
appendix for more on this.

The To Do application vaults past Travel Advisor in terms of complexity.
Instead of Travel Advisor’s one nib file, To Do has three nib files. Instead of
three custom classes, To Do has seven. This diagram shows the
interrelationships among instances of some of those classes and the nib files that
they load:

. o ToDaoDoc.nib

e ToDolnspector.nib < ”KWJ*; wms " ’

- - .} Loads | ]|
o rows nare.
Do
el e - Croates
ToDoController ToDoDoc A ToDoltem
(Controller) {Controller) B {(Model)

]
1

ToDolnspector
(Controller)

1 ToDo.nib

Some of the objects in this diagram are familiar, ficting as they do into the
Model-View-Controller paradigm. The ToDoltem class provides the model
objects for the application; instances of this class encapsulate the data associated
with the items appearing in documents. They also offer functions for computing
subsets of that data. And then there’s the controller object...actually, there is
more than one controller object.

To Do’s Multi-Document Design

Two types of controller objects are at the heart of multi-document application
design. They claim different areas of responsibility within an application.
ToDoController is the application controller; it manages events that affect the
application as a whole. Each ToDoDoc object is a document controller, and
manages a single document, including all the ToDoltems that belong to the
document. Naturally, it’s essential that the application controller be able to
communicate with its (potentially) numerous document controllers, and they
with it.
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As any developer knows well, performance is a key consideration
in program design. One factor is the timing of resource allocation.
. If an application loads all code and resources that it might use
when it starts up, it will probably be a sluggish, bloated
application—and one that takes awhile to launch.

You can strategically store the resources of an application
(including user-interface objects) in several nib files. You can also
putcode that might be used among one or more /loadable bundles.
When the application needs a resource or piece of code, it loads
the nib file or loadable bundle that contains it. This technigue of
deferred allocation benefits an application greatly. By conserving
memory, itimproves program efficiency. It also speeds up the time
it takes to launch the application.

Auxiliary Nib Files

When more sophisticated applications start up, they load only a
minimum of resources in the main nib file—the main menu and
perhaps a window. They display other windows (and load other

nib files) only when users request it or when conditions warrant it.

Nib files other than an application’s main nib file are sometimes
called auxiliary nib files. There are two general types of auxiliary
nib files: special-use and document.

Special-use nib files contain objects (and other resources)

that might be used in the normal operation of the application.
Examples of special-use nib files are those containing inspector
panels and Info panels.

Document nib files contain objects that represent some
repeatable entity, such as a word-processor document. A
document nib file is a template for documents: it contains the Ul
objects and other resources needed to make a document.

The Owner of an Auxiliary Nib File

The object that loads a nib file is usually the bbiect that owns
it. A nib file’s owner must be external to the file. Objects
unarchived from the nib file communicate with other ob]ects in

the apphcatlon only through the owner.

In Interface Builder, the File’s Owner iconrepresents thls external
object. The File's Owner is typically the application controller for
spe ial-use nib files, and the document controller for document

2 Loadable bundles usually have an extension of “.
(althuugh that's a convention, not a ‘requirement). Each Ioadable

nib files. The File's Owner object is not really appeanng twnce, it's
created in one file and referenced in the other

The File's Owner object dynamlcally loads a nib file and makes
itself the owner of that file by sending loadNibNamed:owner: to
NSBundle, specifying self as the second argument.

NSBundleand Bundles

A bundle is a location in the file system that stores code and the
resources that go with that code, including images, sounds, and
archived objects. A bundle is also identified with an instance of
NSBundle, which makes the contents of the bundle avallable to
other objects that request it.

The generic notion of bundles is pervasive throughout OpenStep.
Applications are bundles, as are frameworks and palettes. Every
application has at least one bundle—its main bundle—which is
the “.app” directory {or application wrapper) where its
executable file is located. This file is loaded into memory when
the application is launched.

Loadable Bundles

You can organize an application into any number of other bundles
in addition to the main bundle and the bundles of linked-in
frameworks. Although these loadable bundles usually reside
inside the application wrapper, they can be anywhere in the file
system. Project Builder allows you to build Loadable Bundle
projects.

Loadable bundles differ from nib files inthatthey don’t require you
to use Interface Builder to build them. Instead of containing
mostly archived objects, they usually containmostly code..
Loadable bundles are especially useful for incorporating extra - -
behaviorinto an application upon demand. An economic-forecast -
application for example, might load a bundle containing the code
defining an economic model, but only when users request that
model. You could also use Ioadable bundlesto mtegrate
play compenents into an eX|st|ng framework

bundle must have a principal class that mediates between bundle
objects and external objects. :




The Design of To Do

The rationale behind, and
process of, constructing
multi-document applications is
discussed in “The Structure of
Multi-Document Applications”
on page 141.

As multi-document applications typically do, To Do includes the Document
menu found on Interface Builder’s Menus palette. When users choose New
from the Document menu, the application controller allocates and initializes an
instance of the ToDoDoc class. When the ToDoDoc instance initializes itself,, it
loads the ToDoDoc.nib file. When the user has finished entering items into the
document, and chooses Save from the Document menu, a Save panel appears
and the user saves the document in the file system under an assigned name.
Later, the user can open the document using the Open menu command, which
causes the Open panel to be displayed.

The controller objects of To Do respond to a variety of delegation messages sent
when certain events occur—primarily from windows and NSApp—in order to
save and store object state. One example of such an event is when the user
closes a document window; another is when data is entered into a document.
Often when these events happen, one controller sends a message to the other
controller to keep it informed.

How To Do Stores and Accesses its Data

The data elements of a To Do document (ToDoDoc) are ToDoltems. When a
user enters an item in a document’s list, the ToDoDoc creates a ToDoltem and
inserts that object in a mutable array (NSMutableArray); the ToDoltem
occupies the same position in the array as the item in the matrix’s text field. This
positional correspondence of objects in the array and items in the matrix is an
essential part of the design. For instance, when users delete the first entry in the
document’s list, the document removes the corresponding ToDoltem (at index
0) from the array.

Work Schedule.td — ~/Misc

ToDoltem (*item one*)

ToDoltem (*item one*)

ToDoltem (*item one*)

item three
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The array of "ToDoltems is associated with a particular day. Thus the data for a
document consists of a (mutable) dictionary with arrays of ToDoltems for values
and dates for keys.

NSMutableDictionary

Key 15 Nov 1996 16 Nov 1996 17 Nov 1996

ToDoltem “ToDoltem ToDoltem
ToDoltem

ToDoltem
ToDoltem

ToDoltem ToDoltem

Value ToDoltem

ToDoltem

When users select a day in the calendar, the application computes the date,
which it then uses as the key to locate an array of ToDoltems in the dictionary.

To Do’s Custom Views

"The discussion so far has touched on model objects and controller objects, but
has said nothing about the second member of the Model-View-Controller triad:
view objects. Unlike Travel Advisor, which uses only “off-the-shelf” views, To
Do’s interface features objects from three custom Application Kit subclasses.

B Work Schedule.td — ~/Misc

CalendarMatrix: a

subclass of NSMatrix,

this is a dynamic

calendar that notifies

the delegate about

selected dates.
SelectionNotifMatrix:
madifies NSMatrix to
notify observers when a

ToDoCell: a subclass of selection in a text field

NSButtonCell, this is a tri-
state control with
different images for each
state. It also displays
times items are due.

occurs.

You’ll learn much more about these custom subclasses in the pages that follow.
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Setting up the To Do

Create the application project.

Start Project Builder.

Choose New from the Project
menu.

Name the application “ToDo.”

Add the application icon.

The ToDo icon (ToDo.tiff) is
located in the ToDo project in the
AppKit subdirectory of
[NextDeveloper/Examples.

Specify the To Do document type.

Click Add.

Double-click the new cell under
the Extension column.

Type the extension of To Do
documents: “td”.

Drag into the image well the file
calendar.tiff from the ToDo
projectin
/NextDeveloper/Examples/
AppKit.

Project

Create the To Do project almost in the same way you created the Travel Advisor

" application. There are a few differences; each, of course, has a different name

and icon. But the most important difference is that To Do has its own document

type.

500" Project Inspe

PojectName:jToDo

Language:|English

Application Class:|[NSApplication

Main Nib File:| ToDo

:TOPENSTEF' for Mach

HelpFile

: I

. Applicalio'n
" | ToDo it

' Documenticons

Jicon Namea*»

Project Name:{ ToDo

Language:[English

Application Class:NSApplication

Maln Nib File:{ ToDo

|[OPENSTEP forMach

{HelpFile
ZApplicaﬂanlcon k S
| Toaiff

| Document icons

You can have different icons and other project
attributes for OpenStep for Mach and
OpenStep for Windows.

Instead of dragging the image-file icon into
the well, you can add the image file to the
project and then just type the name of the
image here.

Document types specify the kinds of files the
application can open and "understand."” They
appear in the workspace with the assigned icon
and may be opened by double-clicking.

As with the application icon, when you drag
the document icon into the image well, the image
file is added to the project.

Before Project Builder accepts the document icon,
you must assign the extension (if the type is new)
and select the row.

If the document type is well-known (for example,
“.c"), just drag a document of that type into the well.
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Creating the Model Class (ToDoltem)

Add the ToDoltem class to the
project.

Select Classes in the project
browser.

Choose New In Project from the
File menu.

In the New File In ToDo panel,
type “ToDoltem” in the Name
field.

Make sure the “Create header”
switch is checked.

Click the OK button.

Declare ToDoltem’s instance
variables and methods.

Type the instance variables as
shown at right.

Indicate the protocols adopted by
this class.
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The ToDoltem class provides the model objects for the To Do application. Its
instance variables hold the data that defines tasks that should be done or
appointments that have to be kept. Its methods allow access to this data. In
addition, it provides functions that perform helpful calculations with that data.
ToDoltem thus encapsulates both data and behavior that goes beyond accessing
data,

Since ToDoltem is a model class, it has no user-interface duties and so the
expedient course is to create the class without using Interface Builder. We first
add the class to the project; Project Builder helps out by generating template
source-code files.

As you’ve done before with Travel Advisor, start by declaring instance variables
and methods in the header file, ToDoltem.h.

@interface ToDoItem:NSObject<NSCoding, NSCopying>
{ :
NSsCalendarDate *day;
NSString *itemName;
NSString *notes;

NSTimer *itemTimer;

long secsUntilDue;

long secsUntilNotif;.
ToDoItemStatus itemStatus;

You are adopting the NSCopying protocol in addition to the NSCoding protocol
because you are going to implement a method that makes “snapshot” copies of
ToDoltem instances.



Creating the Model Class (ToDoltem)

3 Define enum constants for use in
ToDoltem's methods.

Definethese constants before the
@interface directive.

4 Declare two time-conversion
functions.

Instance Variable What it Holds
day The day (a date resolved to 12:00 AM) of the to-do item
itemName The name of the to-do item {the content’s of a document text field)
notes The contents of the inspector’s Notes display; this could be any
’ information related to the to-do item, such as an agenda to discuss at
ameeting.
itemTimer A timer for notification messages.

secsUntilDue

The seconds after day at which the item comes due

secsUntilNotif

secsUntilDue)

The seconds after day at which a natification is sent {before

itemStatus

" u

Either “incomplete,

complete,” or “deferToNextDay”

typedef enum _ToDoltemStatus {

incomplete=0,
complete,
deferToNextDay

} ToDoItemStatus;

enum {

Y

The first set of constants are values for the itemStatus instance variable. The

minInSecs = 60,

hrInSecs = (minInSecs * 60),
dayInSecs = (hrInSecs * 24),
weekInSecs = (dayInSecs * 7)

second set of constants are for convenience and clarity in the methods that deal
with temporal values.

BOOL ConvertSecondsToTime(long secs, int *hour) int *minute);
long ConvertTimeToSeconds{int hr, int min, BOOL flag):

These functions provide computational services to clients of this class,
converting time in seconds to hours and minutes (as required by the user

interface), and back again to seconds (as stored by ToDoltem).
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Type the method declarations
shown at right.

Implement accessor methads.

Open ToDoltem.m in the code
editor.

Implement methods that get and
set the values of ToDoltem’s
instance variables.

Implement the setitemTimer:
method as shown at right.

Timers (instances of NSTimer)
are always associated with a run
loop (an instance of

NSRunLoop). See “Tick Tock

Brrrring: Run Loops and Timer”

on page 190 for more on timers
and run loops.
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k('d ynltW1thName (NSStrl

1) dealloc; -

- (BOOL) isEqual: (id) anObject;

{ coplechone.(NSZone;,)zone,'

) initWithCoder: (NSCoder *)coder;

27 (void) encodeWithCoder: (NSCoder *)coder;
- (void) set ay (NSCalendarDate “*)newDay;

il (NSCalendarDate *)day:

- (v01d)setItemName (Nsstrlhg'*)newName,
- (Nsstrlng *)itemName; :
- (void) setNotes: (NSStrlng *)notes;

- (NSString’ *)notes"*~ :

' (v01d)setItemT1mer (NSTimer *)aTlmer,

- (NSTimer: *)1temT1mer,_@

- (v01d)setSechnt11Due (1ong)secs,

i —,(1ong)sechnt11Due, B

- (v01d)setSechnt11Notif:(long)secs;

- (1ong)sechntllNot1f

- {void)setItemStatus: (ToDoItemStatus)newstatus,.

(ToDoItemStatus)itemStatus; .

)name‘andDate;(NSéalendarDate

{

[1temT1mer 1nva11date],

The setltemTimer: method is slightly different from the other “set” accessor
methods. It sends invalidate to itemTimer to disable the timer before it autoreleases
it.

In this application, you want client objects to be able to copy your ToDoltem
objects and test them for equality. You must define this behavior yourself.
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Creating the Model Class (ToDoltem)

Implement the isEqual: method.

Implement the copyWithZone:
method.

Copies of objects can be either
deep or shallow. In deep copies
(like ToDoltem’s) every copied
instance variable is an
independent replicate, including
the values referenced by
pointers. In shallow copies,
pointers are copied but the
referenced objects are the same.
For more on this topic, see the
description of the NSCopying
protocol in the Foundation
reference documentation.

- (BOOL) isEqual: (id) anObj
{
if ([anObj isKindOfClass:[ToDoItem classl] &&
[itemName isEqualToString:[anObj itemName]] &&
[day isEqualToDate:[anObj dayl])
return YES;
else
return NO;

The default implementation of isEqual: (in NSObject) is based on pointer
equality. However, ToDoltem has a different basis for equality; any two
ToDoltem objects for the same calendar day and having the same item name are
considered equal. The implementation of isEqual: overrides NSObject to make
these tests. (Note that it invokes NSString’s and NSDate’s own isEqual...
methods for the specific tests.)

Before You Go On

There is a specific as well as a general need for the isEqual: override. In the To
Do application, an NSArray contains a day’s ToDoltems. To access them, other
objects in the application invoke several NSArray methods that, in turn, invoke
the isEqual: method of each object in the array.

- (id)copyWithZone: (NSZone *)zone

ToDoItem *newobj =
andDate:dayl;

[newobj setNotes:notes];

[newobj setItemStatus:itemStatus];

[newobj setSecsUntilDue:secsUntilDuel;

[newobj setSecsUntilNotif:secsUntilNotif];

[{ToDoItem alloc] initWithName:itemName

return newobj;

‘This implementation of the copyWithZone: protocol method makes a copy of a

“ToDoltem instance that is an independent replicate of the original (self). It does

this by allocating a new ToDoltem object and initializing it with the essential
instance variables held by self. Copying is often implemented for va/ue objects—
objects that represent attributes such as numbers, dates, and to-do items.

The next method you’ll implement—description—assists you and other
developers in debugging the To Do application with gdb. When you enter the po
(print object) command in gdb with a ToDoltem as the argument, this description
method is invoked and essential debugging information is printed.
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8 Implement the description i
method. :

;gWithForﬁat:@“%@\n\tName: %@\n\tDate:i
@\n\tSecngntil'Due' d\n\tSecs Until

%@\n\tCompleted

dlv
[super descrlptlon],

[self day] i

[se . :
([  1£ 1temStatus]==comp1ete)9@"Yes" @"No"),
[self sechntllDue], : e
[selfisechntllyotlf]];

reﬁﬁrn (desc);

9 ImplementToDoltem'sinitializing ~ Here are some things to remember as you implement initWithName:andDate: and
and deallocation methods. dealloc:

¢ If the first argument of initWithName:andDate: (the item name) is not a valid
string, return nil. If the second argument (the date) is nil, set the related
instance variable to some reasonable value (such as today’s date). Also, be sure
to invoke super’s init method.

¢ The instance variables to initialize are day, itemName, notes, and itemStatus (to
“incomplete”).

® In dealloc, release those object instance variables initialized in
initWithName:andDate: plus any object instance variables that were initialized
later. Also invalidate any timer before you release it.

10 Implement ToDoltem’s archiving When you implement encodeWithCoder: and initWithCoder:, keep the following in
and unarchiving methods. mind:

* Encode and decode instance variables in the same order.
¢ Copy the object instance variables after you decode them.

* You don’t need to archive the itemTimer instance variable since timers are re-
set when a document is opened.

The final step in creating the ToDoltem class is to implement the functions that
furnish “value-added” behavior.
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11 Implement ToDoltem's time- long ConvertTimeToSeconds(int hr, int min, BOOL flag) /* 1 %/
conversion functions. {
if (flag) { /* PM */
if (hr >= 1 && hr < 12)

hr += 12;
} else {
if (hr == 12)
hr = 0;

}

return ((hr * hrInSecs) + (min * minInSecs));

BOOL ConvertSecondsToTime (long secs, int *hour, int *minute) /* 2 */
{

int hr=0;

BOOL pm=NO;

if (secs) (
hr = secs / hrInSecs;
if (hr > 12) {

*hour = (hr -= 12);
pm = YES;
} else {
pm = NO;
if (hr == 0)
hr = 12;

*hour = hr;

}

*minute =i((secs%hrInSecs) / minInSecs);

}

return pmjy

1. This expression, as well as others in these two methods, uses the enum constants
for time-values-as seconds that you defined earlier.

2. The ConvertSecondsToTime() function uses indirection as a means for returning
multiple values and directly returns a Boolean to indicate AM or PM.
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Subclass Example: Adding Data and Behavior (CalendarMatrix)

The calendar on "To Do’s interface is an instance of a custom subclass of
NSMatrix. CalendarMatrix dynamically updates itself as users select new
months, notifies a delegate when users select a day, and reflects the current day
(today) and the current selection by setting button attributes.

Creating a subclass of a class that is farther down the inheritance tree poses more
of a challenge for a developer than a simple sublcass of NSObject. A class such
as NSMatrix is more specialized than NSObject and carries with it more
baggage: It inherits from NSResponder, NSView, and NSControl, all fairly
complex Application Kit classes. And since CalendarMatrix inherits from
NSView, it appears on the user interface; it is an example of a view object in the
Model-View-Controller paradigm, and as such it is highly reusable.

Why NSMatrix?

When you select a specialized superclass as the basis for your subclass, it is
important to consider what your requirements are and to understand what the
superclass has to offer. To Do’s dynamic calendar should:

® Arrange numbers (days) sequentially in rows and columns.
® Respond to and communicate selections of days.
Understand dates.

Enable navigation between months.

If you then started to peruse the reference documentation on Application Kit
classes, and looked at the section on NSMatrix, you’d read this:

NSMatrix is a class used for creating groups of NSCells that work together in various
ways. 1t includes methods for arranging NSCells in rows and columns.... An
NSMatrix adds to NSControl's targetlaction paradigm by allowing a separate target
and action for each of its NSCells in addition to its own target and action.
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Define the CalendarMatrix class
in Interface Builder.

From Project Builder, open
ToDo.nib.

In Interface Builder, choose
Document » New Module »
New Empty to create a new nib
file.

Save the nib file as ToDoDec.nib.

Inthe Classes display of the nib
file window, select NSMatrix.

Choose Subclass from the pull-
down list.

Name the new class
“CalendarMatrix”.

Select the new class.

Add the outlets and actions
shown in the example at right.

So NSMatrix has an inherent capability for the first of the requirements listed

above, and part of the second (responding to selections). Our CalendarMatrix

subclass thus does not need to alter anything in its superclass. It just needs to

supplement NSMatrix with additional data and behavior so it can understand

dates (and update itself appropriately), navigate between months, and notify a
delegate that a selection was made.

o Hoimage
o NEResponder
o MSApplication
O NSView
o MSBox
‘9 N3Control
o NEErowser

MEButton

o

o NiColoriell ot 2O - Locate NSMatrix several levels down in the
o MSlmageYiew 2@ class hierarchy.

0 NSMa

Outlets Outlets and actions already defined by the
lefiBution superclass (or its superclasses) appear in
- gray text. Add the outlets and actions shown
_ monthName 1 in black text.

When you created subclasses of NSObject in the previous two tutorials, the next
step was to instantiate the subclass. Because CalendarMatrix is a view (that s, it
inherits from NSView), the procedure for generating an instance for making
connections is different.
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Put a custom NSView object
(CalendarMatrix) on the user
interface.

Drag a window from the Windows
palette.

Resize the window, using the
example atright as a guide.

Turn off the window's resize
handle.

Drag a CustomView from the
Views palette onto the window.

Resize and position the
CustomView, using the example
atright as a guide.

In the Attributes display of the
inspector, select CalendarMatrix
from the list of available classes.

130

CustomView

The CustomView object is a "proxy" object,
representing any custom NSView object on
the interface.

Assign a class to the CustomView by
selecting a class here. Custom classes
must be defined in the nib file.

The selection of the class for the CustomView creates an instance of it that you
can connect to other objects in the nib file. Now put the controls and fields

associated with CalendarMatrix on the window.
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3 Putthe objects related to This label contains the month and year. Initialize by

CalendarMatrix on the window. o o ’ / ’ |" [ 4 l{x typing "September 9999" (the longest possible string),
set text to Helvetica 18, center it, then delete it.

Drag a label object for the month-
year from the Views palette and
put it over the CalendarMatrix.

Type the days of the week as individual labels, arrange
as a row, then distribute the fields evenly over columns
(this may take some trial and error).

Make seven small labels for each

To make the button enclose the image as tightly as
day of the week. possible, select the button and choose
Drag a button onto the interface CalendarMatrix | Format eSize pSize To Fit.
and setits attributes to
unbordered and image only.

Drag left_arrow.tiff from
/NextDeveloper/Examples
/AppKit/ToDo and drop it over the
button.

To the attention panel that asks
“Insert image left_arrow in
project?” click Yes.

Repeat the same button
procedure for right_arrow.tiff.

Next connect CalendarMatrix to its satellite objects.

4 Connect CalendarMatrix to its Name Connection Type
:g::::lal::;:;gzzontrols sending monthName From CalendarMatrix to the label field above it outlet

5 Finish up in Interface Builder. leftButton From CalendarMatrix to the left-pointing arrow outlet
Save ToDoDoc.nib. rightButton From CalendarMatrix to the right-pointing arrow outlet
Select CalendarMatrix and in the monthChanged: From both arrows to CalendarMatrix _ action

Classes display and choose
Create Files from the Operations

pull-down menu. You might have noticed that there’s an action message left unconnected:

Confirmthatyouwantthe source-  chpseDay:. Because it is impossible in Interface Builder to connect an object with
code files added to the project. . . . . .
itself, you will make this connection programmatically.
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Add declarations to the header
file CalendarMatrix.h.

(Existing declarations are
indicted by ellipsis.)
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v01d)refreshCalendar ; ;
-ame : (NSRect)frameRz

- (v01d)setSelectedDay (NSCalendarDate *)newDay
- (NSCalendarDate *)selectedDay,

@interface NSObject (CalendarMatrixDelegate)
7x—k(ﬁoid)célendarMatrlxi(CalendarMatrix *)obj
o dldchangeToDate (NSDate. *)date;

- (v01d)ca1endarMatr1x (CalendarMatrix -*)obj
dldChangeToMon:h (int)mo year: (int)yr;

@end

There are a couple of interesting things to note about these declarations:

1. The cells in CalendarMatrix are sequentially ordered by tag number, left to right,
going downward. startOffset marks the cell (by its tag) on which the first day of the
month falls.

2. CalendarMatrixDelegate is a category on NSObject that declares the
methods to be implemented by the delegate. This technique creates what is
called an snformal protocol, which is commonly used for delegation methods.
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Implement CalendarMatrix's
initialization methods.

Select CalendarMatrix.min the
project browser.

Write the implementation of
initWithFrame: (at right).

Implement dealloc.

- (id)initWithFrame: (NSRect) frameRect

{
int i, j, cnt=0;
id cell = [[NSButtonCell alloc] initTextCell:@""];
NSCalendarDate *now = [NSCalendarDate date]; /* 1 %/

[super initWithFrame:frameRect /* 2 */
mode :NSRadioModeMatrix
prototype:cell
numberOfRows : 6
numberOfColumns:7] ;
// set cell tags /* 3 */
for (i=0; i<6; i++) {
for (3=0; j<7; j++) {
[[self cellAtRow:i column:j] setTag:cnt++];

}
[cell release];
selectedDay = [[NSCalendarDate dateWithYear: [now yearOfCommonEral
month: [now monthOfYear] /* 4 */
day: [now dayOfMonth]
hour:0 minute:0 second:0
. timeZone: [NSTimeZone localTimeZonel] copyl:;

return self;

The initWithFrame: method is an initializer of NSMatrix, NSControl and NSView.

1. This invocation of date, a class method declared by NSDate, returns the current
date (“today”) as an NSCalendarDate. (NSCalendarDate is a subclass of NSDate.)

2. This message to super (NSMatrix) sets the physical and cell dimensions of the
matrix, identifies the type of cell using a prototype (an NSButtonCell), and
specifies the general behavior of the matrix: radio mode, which means that
only one button can be selected at any time.

3. Set the tag number of each cell sequentially left to right and down. Tags are
the mechanism by which CalendarMatrix sets and retrieves the day numbers
of cells.

4. This NSCalendarDate class method initializes the selectedDay instance
variable to midnight of the current day, using the year, month, and day
elements of the current date. The localTimeZone message obtains an
NSTimeZone object with an suitable offset from Greenwich Mean Time.
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Implement awakeFromNib as B

(void) aWéiéé'F'rbmmio

shown at right. (
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[monthName setAllgnment NSCenterTextAllgnment],”

[self
[self
[self
[self

setTarget: selfl]
setAction: @selector(choseDay ) 1;
setAutosizesCells:YES];
refreshCalendarl;

The awakeFromNib method performs additional initializations (some of which
could just have easily been done in initWithFrame:). Most importantly, it sets self as
its own target object and specifies an action method for this target, choseDay:,
something that couldn’t be done in Interface Builder. Other methods to note:

* setAutosizesCells: causes the matrix to resize its cclls on every redraw.
e refreshCalendar (which you’ll write next) updates the calendar.

The refreshCalendar method is fairly long and complex—it is the workhorse of the
class—so you’ll approach it in sections.

Daies and Times in OpenStep

In OpenStep you representdates and times as objects thatinherit
from NSDate. The major advantage of dates and times as objects
is common to all objects that represent basic values: they yield

functionality that, aithough commonly found in most operating

operating- - - Because of this, you cantrack an NSCyalendarDate objectacross

systems, is not tied to the internals of any pamcul'
system. e

NSDates hold dates and times as values of type NSTimelnterval
and express the alues as seconds. The NSTimelnterval type
makes possmle a wide and fine-grained range of date and time
values, glvmg accuracyWIthln mllhseco‘nds fordates 10 000 years

,NSDate provudes methodsfor obtammg NSDate objects

(mcludlng date, which returns the current date and time as an

- NSDate), for comparing dates, for computmg r Iatlve tnme values
-and for representlng dates as strings.

The NSCalendarDate class, which inherits from NSDate,
generates objects that represent dates conforming to western
calendrical systems. NSCalendarDate oblects also adjust the
representations of datesto reflect thelr assoclated time zones.

different time zones. You can also present date information from
time-zone vnewpomts otherthan the one forthe current locale.

Each NSCaIendarDate object‘also has a calendarformat stnng
bound to it. This format strlhg contams ite-conversion specifiers
that are very smnlarto those used in the standard C library
function strftlme(). NSCalendarDate can interpret user-entered
dates that conform ta this format string.

fi‘f&NSCaIendar has methods for creating NSCalendarDate objects
*’from formatted stnngs and from component time values (suchas




8

Subclass Example: Adding Data and Behavior (CalendarMatrix)

Implement the code that updates
the calendar.

Initialize the MonthDays[] array
and write the isLeap() macro.

Determine the day of the week at
the start of the month and the
number of days in the month.

static short MonthDays[] =
{31, 28, 31, 30, 31, 30, 31, 31, 30, 31, 30, 31 };
#define isLeap(year) (((((year) % 4) == 0 && (((year) % 100) != 0))
|| ((year) % 400) == 0))

- (void)refreshCalendar
{
NSCalendarDate *firstOfMonth, *selDate = [self selectedDay],
*now = [NSCalendarDate date];
int i, j, currentMonth = [selDate monthOfvear];
unsigned int currentYear = [selDate yearOfCommonEra];
short daysInMonth;
id cell;

firstOfMonth = [NSCalendarDate dateWithYear:currentYear /* 1 */
month:currentMonth
day:1 hour:0 minute:0 second:0
timeZone: [NSTimeZone localTimeZone]];

[monthName setStringValue:[firstOfMonth /* 2 */
descriptionWithCalendarFormat:@"%B $Y"]1];

daysInMonth = MonthDays|[currentMonth-1]1+1; /* 3 */

/* correct Feb for leap year */

if ((currentMonth == 2) && (isLeap(currentYear))) daysInMonth++;

startOffset = [firstOfMonth dayOfWeek]; /* 4 */

Before it can start writing day numbers to the calendar for a given month,
CalendarMatrix must know what cell to start with and how many cells to fill with
numbers. The refreshCalendar method begins by calculating these values.

1. Creates an NSCalendarDate for the first day of the currently selected month and
year (computed from the selectedDay instance variable).

2. Writes the month and year (for example, “February 1997”) to the label above
the calendar.

3. Gets from the MonthDays static array the number of days for that month; if the
month is February and it is a leap year, this number is adjusted.

4. Gets the day of the week for the first day of the month and stores this in the
startOffset instance variable.
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Write the refreshCalendarcode oy (120; i<startOffset; i++)
that writes day numbers to the ' cell -

4 = [self cellWithTag:i];
cells and sets cell attributes. [cell setBordered:NOJ;

[cell setEnabled¥NO];
[cell setTitle:@""]; ; o
[cell setCellAttrlbute NSCellnghllghted to:NO],

{

cfor (j=1; o< daysInMonth; i++, J++) {
cell = [self cellWithTag:1i];

[cell setBordered:YES];

[cell setEnabled:YES];

‘[cell setFont:[NSFont systemFontOfSize:12]];

[cell setTitle:[NSString stringWithFormat:@"$d", j11;

[cell setCellAttribute:NSCellHighlighted to:NOJ;

for:(;i<42;i++) {
cell = [self cellWithTag:il;:
[cell setBordered:NOJ];
[cell setEnabied :NOJ;
. [cell setTitle:@""];
I 11" setC 11Attr1bute NSCellnghllghted to:NOJ;

The first and third for-loops in this section of code clear the leading and trailing
cells that aren’t part of the month’s days. Because the current day is indicated by
highlighting, they also turn off the highlighted attribute. The second for-loop
writes the day numbers of the month, starting at startOffset and continuing until
daysInMonth, and resets the font (since the selected day is in bold face) and other
cell attributes.

Complete the refreshCalendar
method implementation by
resetting the “today” cell
attribute.

(currentYear == [now yearOfCommonEra]f
(currentMont == [now monthOfYear]))

This final section of refreshCalendar determines if the newly selected month and
year are the same as today’s, and if so highlights the cell corresponding to today.
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9 Implement the monthChanged: -

: (void)monthChanged:sender
action method. {

NSCalendarDate *thisDate = [self selectedDay];
int currentYear = [thisDate yearOfCommonEral;
unsigned int currentMonth = [thisDate monthOfYear];

if (sender == rightButton) { /* 1 */
if (currentMonth == 12) { )
currentMonth = 1;
currentYear++;
} else {
currentMonth++;
}
} else {
if (currentMonth == 1) {
currentMonth = 12;
currentYear--;
} else {
currentMonth-~;
}
} /* 2 */

[self setSelectedDay: [NSCalendarDate dateWithYear:currentYear
month:currentMonth
day:1 hour:0 minute:0 second:0
timeZone: [NSTimeZone localTimeZone]l];
[self refreshCalendar]; )
[[self delegate] calendarMatrix:self /* 3 */
didChangeToMonth:currentMonth year:currentYear];

The arrow buttons above CalendarMatrix send it the monthChanged: message
when they are clicked. This method causes the calendar to go forward or
backward a month.

1. Determines which button is sending the message, then increments or decrements
the month accordingly. If it goes past the end or beginning of the year, it
increments or decrements the year and adjusts the month.

2. Resets the selectedDay instance variable with the new month (and perhaps
year) numbers and invokes refreshCalendar to display the new month.

3. Sends the calendarMatrix:didChangeToMonth:year: message to its delegate (which
in this application, as you’ll soon see, is a ToDoDoc controller object).
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10 Implement the choseDay: action
method.

11 Implement accessor methods for
the selectedDay instance
variable.
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-~ -(void)choseDay:sender =
{ : o
NSCalendarDatekfsngate, *thisDate = [self selectedDay];
/X1 %/
unsigned inti'selDay = [[self selectedCell] tag]-startOffset+1;
Ry i )
selDate = [NSCalendarDate dateWithYear:[thisDate yearOfCommonEral]
month: [thisDate monthOfYear]
day:selDay
hour:0
minute:0
second: 0
timeZone: [NSTimeZone localTimeZone]];
/* 3 %/ :
[[self cellWithTag: [thisDate dayOfMonth]+startOffset-1]
setFont: [NSFont systemFontOfSize:12]];
[[self cellWithTag:selDay+startOffset-1] setFont:
[NSFont boldSystemFontOfSize:12]];
/* 4 */
[self setSelectedDay:selDate];
[[self delegate] calendarMatrix:self didChangeToDate:selDate];

This method is invoked when users click a day of the calendar.

1. Gets the tag number of the selected cell and subtracts the offset from it (plus one
to adjust for zero-based indexing) to find the number of the selected day.

2. Derives an NSCalendarDate that represents the selected date.

3. Sets the font of the previously selected cell to the normal system font
(removing the bold attribute) and puts the number of the currently selected
cell in bold face. ’

4. Sets the selectedDay instance variable to the new date and sends the
calendarMatrix:didChangeToDate: message to the delegate.

You are finished with CalendarMatrix. If you loaded ToDoDoc.nib right now, the
calendar would work, up to a point. If you clicked the arrow buttons,
CalendarMatrix would display the next or previous months. The days of the
month would be propetly set out on the window, and the current day would be
highlighted. '

But not much else would happen. That’s because CalendarMatrix has not yet
been hooked up to its delegate.
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The Basics of a Multi-Document Application

Customize the application’s main
menu.

Open ToDo.nib in Interface
Builder.

Drag the Document item from the
Menus palette and drop it
between the Info and the Edit
submenus.

- Drag the ltem item from the
Menus palette and drop it
between the Edit and Windows
menus.

Change the title of “Item” to
“Inspector.”

Define the application-controller
class.

Create ToDoController as a
subclass of NSObject.

Add the outlet and actions (listed
atright) to the class.

Make the action connections
from the appropriate Document
menu commands.

A multi-document application, as described on page 141, has at least one
application controller and a document controller for each document opened.
The application controller also responds to user commands relating to
documents and either creates, opens, closes, or saves a document.

Do Customize the Document submenu by deleting
——— the Save As, Save To, Save All, and Revert To
finfo 7T Saved commands.
Document
Edit |
(fnspector... ]
Windows_ T
[Seivices ™ | Append an ellipsis (three dots) to the command
de. .. h | name to indicate that the command displays a
}W‘ ~q panel. Also enter "i" as the key equivalent.

Note: The Info submenu, which you get by default, includes the Info Panel,
Preferences, and Help commands. Although this tutorial does not cover
implementing Info and Preferences panels specifically, it does give you enough
information (which it will supplement with tips) so that you can try to
implement these panels on your own. You may delete the Help command from
the Info submenu if you wish; if you leave it in and users click it, they get a
message informing them that Help is not available.

Now that you’ve defined the application-controller class, define the document-
controller class, ToDoDoc. Remember, since the ToDoDoc controller must own
the nib file containing the document, it must be external to it; although it is
defined in the main nib file (ToDo.nib) and in ToDoDoc.nib, it’s instantiated before
its nib file is loaded.
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Define the document-controller
class.

ToDo.nib — ~/Projects/ToDo-3/English.Iproj

Create ToDoDoc as a subclass of
NSObject.

Add to the class the outlets and
action listed at right.

Instantiate ToDoController and
ToDoDoc.

Save ToDo.nib.

Complete the document
interface.

Open ToDoDoc.nib.

Add the matrices of text fields.

Add the labels above the
matrices.

Make the labels 14 points in the
user's application font.

Make the itemtext 12 points in the
user's application font.

CalendarMatrix

Set the text color of this
label to dark gray.
Add padding to this label,

Save ToDoDoc.nib. extending it acrss the
column.
To assist alignment, these
cells are text fields of the
same size as the cells of the Remember, create a matrix
other matrix. However, you by Alternate-dragging a
will at run time substitute handle of a suitable object.
your own custom cell Before Alternate-dragging,
(ToDoCell). make the initial text field
scrollable.

Connect the outlets and actions Name Connection Type

of ToDoDoc. . .
calendar From File’s Owner to the CalendarMatrix object outlet

Select File’s Owner in the - ,, .. :

Instances display of daylabel From File’s Owner to label “To Do on outlet

ToDoDog.nib. itemMatrix From File’s Owner (ToDoDoc) to matrix of long text fields outlet

Choose ToDoDac from the list of

classes in the Attributes display markMatrix From File’s Owner to matrix of short text fields outlet

of the inspector. - - - - ;
itemChecked: From matrix of short text fields to File’s Qwner action

Make the connections described
in the table at right.
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The Structure of Multi-Document Applications

From a user’s perspective, a document is a unique body of
information usually contained by its own window. Users can
create an unlimited number of documents and save each to a file.
Common documents are word-processing documents and
spreadsheets.

From a programming perspective, a document comprises the
objects and resources unarchived from an auxiliary nib file and
the controller object that loads and manages these things. This
document controlleris the owner of the auxiliary nib file
containing the document interface and related resources.To
manage a document, the document controller makes itself the
delegate of its window and its “content” objects. It tracks edited
status, handles window-close events, and responds to other
conditions.

When users choose the New {or equivalent) command, a method
isinvoked inthe application’s controller object. In this method, the
application controller creates a document-controller ohject,
which loads the document nib file inthe course of initializing itself.
Adocumentthus remains independent of the application’s “core”
abjects, storing state data in the document controller. If the
application needs information about a document's state, it can

query the document controller.

When users chose the Save command, the application displays a
Save panel and enables users to save the document in the file
system. When users chose the Open command, the application
displays an Open panel, allowing users to select a document file
and open it.

Document Management Techniques

When you make the application controller and the document

Do::umqnt Creation Sequence .

Document ES

creates

controller delegates of the application (NSApp) and the document
window, they can receive messages sent at critical moments of a
running application. These moments include the closure of
windows (windowShouldClose:), window selection
{windowDidResignMain:), application start-up
(applicationWillFinishLaunching:) and application termination
(applicationShouldTerminate:). In the methods handling these
messages, the controllers can then do the appropriate thing, such
as saving a document’s data or displaying an empty document.

Several NSViews also have delegation messages that facilitate
document management, particularly text fields, forms, and other
controls with editable text (controlText...) and NSText objects
{text...). One important such message is textDidChange: (or
controiTextDidChange:), which signals that the document's
textual content was modified. In responding to this message,
controllers can set the window's close button to have a “broken”
X with the setDocumentEdited: message; later, they can
determine whether the document needs to be saved by sending
isDocumentEdited to the window.

Document controllers often need to communicate with the
application controller or other objects in the application. One way
to do this is by posting notifications. Another way is to use the key
relationships within the core program framework (see page 149)
to find the other object {(assuming it's a delegate of an Application
Kit object). For example, the application controller can send the
following message to locate the current document controller:

[ [NSApp mainWindow] delegate]
The document controller can find the application contraller with:

[NSApp delegate]

M
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Connect ToDoDoc and
ToDoController to other objects
as their delegates.

6 Create source-code files for
ToDoDoc and ToDoController.

In Project Builder:

7 Add declarations of methods and
instance variables to the
ToDaDoc class.

“Select ToDoDoc.h in the project
browser.
Add the declarations at right.

{Ellipses indicate existing
declarations.)
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Text fields in a matrix, just like a form’s cells, are connected for inter-field
tabbing when you create the matrix. But you must also connect ToDoDoc and
ToDoController to the delegate outlets of other objects in the application—this
step is critical to the multi-document design.

Name Connection

textDelegate From the CalendarMatrix object to File’s Owner (ToDoDoc)

delegate From the document window's title bar to File's Owner (ToDoDoc)
delegate In ToDo.nib, from File’s Owner {NSApp) to the ToDoController instance

The ToDoDoc class needs supplemental data and behavior to get the multi-
document mechanism working right.

@interface ToDoDoc:NSObject

AE Y}
NSMutableDictionary *activeDays;

rray *currentItems;

SMutableArray *)currentItems,
= (v01d)setCurrentItems (NSMutableArray *)newltems,
(NSMatrlx *)itemMatrix;

(NSMatrlx *)markMatrix;

(NSMutablechtlonary *)la tlveDays,

- (v01d)saVeDoc,
- (1d)1n1tW1thF11e (NSStrlng *)aFlle,,
- (v01d)dealloc,

- (vo;d)actlvateDoc; o4
- (void)selectItem: (int)item;

The activeDays and currentitems instance variables hold the collection objects that
store and organize the data of the application. (You’ll deal with these instance
variables much more in the next section of this tutorial.) Many of the methods
declared are accessor methods that set or return these instance Vanables or one
of the matrices of the document.

You’ll be switching between ToDoDoc.m and ToDoControllerm in the next few tasks.
The intent is not to confuse, but to show the close interaction between these
two classes.
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8 Write the code
documents.

that creates
{

Select ToDoControllermin the
project browser.

Implement ToDoController's

newDoc: method.

id currentDoc =
[currentDoc activateDoc];

- (void)newDoc: (id) sender

[[ToDoDoc alloc] initWithFile:nil];

The newDoc: method is invoked when the user chooses New from the

Document menu. The method allocates and initializes an instance of the
document controller, ToDoDoc, thereby creating a document. (See the

implementation of initWithFile: on the following page to see what happens in this
process.) It then updates the document interface by invoking activateDoc..

Coordinate Systems in OpenStep

The screen's coordinate system is the basis for all other
coordinate systems used for positioning, sizing, drawing, and
event handling. You can think of the entire screen as occupying
the upper-right quadrant of a two-dimensional coordinate grid.
The other three quadrants, which are invisible to users, take
negative values along their x-axis, their y-axis, or both axes. The
screen’s quadrant has its origin in the lower left corner; the
positive x-axis extends horizontally to the right and the positive y-
axis extends vertically upward. A unit along either axis is
expressed as a pixel.

The screen coordinate system has just one function: to position
windows on the screen. When your application creates a new
window, it must specify the window's initial size and location in
screen coordinates.You can “hide” windows by specifying their
origin paints well within one of the invisible quadrants. This
technique is often used in off-screen rendering in buffered
windows.
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The location of the window is

expressed relative to the

screen’s origin, and its coord-
' “inate system begins here too.

The origin§ and dimensions of
‘windows and panels are based
‘on the screen origin.

The reference coardinate system for a window is known as the
base coordinate system. It differs from the screen coordinate
system in only two ways:

* ltappliesonlyto a particular window; each window has its own
base coordinate system.

* lIts origin is at the lower left corner of the window, rather than
the lower left corner of the screen. If the window moves, the
origin and the entire coordinate system move with it.

For drawing, each NSView uses a coordinate system transformed
fromthe base coordinate system or fromthe coordinate system of
its superview. This coordinate system also hasitorigin pointatthe
lower-left corner of the NSView, making it more convenient for
drawing operations. NSView has several methods for converting
between base and local coordinate systems. When you draw,
coordinates are expressed in the application's currentcoordinate
system, the system reflecting the last coordinate transformations
to have taken place within the current window.

A view's location is specified
relative to the coordinate

- .system of its window or
superview. The coordinate
origin for drawing begins at
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Select ToDoDoc.m in the project
browser.

Implement ToDoDoc’s
initWithFile: method.

144

initWithFile: (NSString *)aFile

gNSEhUmefétor *dayenum;
NSDate *itemDate; -

[super init]; ) : R
if (aFile) ( ST /% 1
activeDays = [NSUnarchiver unarchiveObjectWithFile:aFilel;
if (activeDays) Co A :
activeDays = [activeDays retain];
else L SRt -
NSRunAlertPanel (8"To Do", @"Couldn't unarchive file s@",
nil, nil, nil, aFile);
} else { L /* 2
activeDays = [[NSMutableDictionary alloc] init]:;
[self setCurrentlItems:nil];

}

if (! [NSBundle loadNibNamed:@"ToDoDoc.nib" owner:self] ) = /* 3
return nil;
if (aFile) ) ) /* 4

; [[itemMatrix window] setTitleWithRebréSéntedFilename:aFile];
© else -
: [[itemMatrix window} setTitle:@"UNTITLED"];
[[itemMatrix window] makeKeyAndOrderFront:self];
return self;

This method, which initializes and loads the document, has the following steps:

1. Restores the document’s archived objects if the aFile argument is the pathname of
a file containing the archived objects (that is, the document is opened). If objects
are unarchived, it retains the activeDays dictionary; otherwise it displays an
attention panel.

2. Initializes the activeDays and currentltems instance variables. A aFile argument
with a nil value indicates that the user is requesting a new document.

3. Loads the nib file containing the document interface, specifying self as owner.

4. Sets the title of the window; this is either the file name on the left of the title
barand the pathname on the right, or “UNTITLED” if the document is new.

Before You Go On

Note the [itemMatrix window] message nested in the last message. Every object
that inherits from NSView “knows” its window and will return that NSWindow
object if you send it a window message.

*/

*/

*/

*/
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9  Implement the document-

. - (void)openDoc: (id) sender
opening method.

{
int result;
NSString *selected, *startDir;
NSArray *fileTypes = [NSArray arrayWithObject:@"td"];
Write the code for openDac:. NSOpenPanel *oPanel = [NSOpenPanel openPanell; /* 1 */

Select ToDoController.m in the
project browser.

[oPanel setAllowsMultipleSelection:YES];
if ([[[NSApp keyWindow] delegate] isKindOfClass:[ToDoDoc class]])
startDir = [[[NSApp keyWindow] representedFilename] /* 2 */
stringByDeletingLastPathComponent] ;

else
startDir = NSHomeDirectory();
result = [oPanel runModalForDirectory:startDir file:nil /* 3 %/
types:fileTypes];
if (result == NSOKButton) {
NSArray *filesToOpen = [oPanel filenames];
int i, count = [filesToOpen count];
for (i=0; i<count; i++) { /* 4 */
NSString *aFile = [filesToOpen cbjectAtIndex:i];
id currentDoc = [[ToDoDoc alloc] initWithFile:aFile];

[currentDoc activateDoc];

The openDoc: method displays the modal Open panel, gets the user’s response
(which can be multiple selections) and opens the file (or files) selected.

1. Creates or gets the NSOpenPanel instance (an instance shared among objects of
an application). The previous message specifies the file types (that is, the
extensions) of the files that will appear in the Open panel browser. The next
message enables selection of multiple file in the panel’s browser.

2. Scts the directory at which the NSOpenPanel starts displaying files either to
the directory of any document window currently key or, if there is none, to
the user’s home directory.

3. Runs the NSOpenPanel and obtains the key clicked.

4. 1f the key is NSOKButton, cycles through the selected files and, for each,
creates a document by allocating and initializing a ToDoDoc instance,
passing in a file name.

The methods invoked by the Document menu’s Close and Save commands
both simply send a message to another object. How they locate these objects
exemplify important techniques using the core program framework.
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Write the code that closes
documents.

In ToDoController.m, implement
the closeDoc: method.

Wirite the code that saves
documents.

In ToDoController.m, implement
the saveDoc: method.
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(Void)cioseDdc:(1d)sender

[ [NSApp mainWindow] performClose:selfl;

NSApp, the global NSApplication instance, keeps track of the application’s
windows, including their status. Because only one window can have main status,
the mainWindow message returns that NSWindow object— which is, of course,
the one the user chose the Close command for. The closeDoc: method sends
performClose: to that window to simulate a mouse click in the window’s close
button. (See the following section, “Managing Documents Through
Delegation,” to learn how the document handles this user event.)

o

- (void) saveDoc: (id) sender
id currentDoc = [ [NSApp mainWindow] delegate];
Cif (currentbhoc)
[currentDoc saveDoc]:;

As did cleseDoc:, this method sends mainWindow to NSApp to get the main
window, but then it sends delegate to the returned window to get its delegate, the
ToDoDoc instance that is managing the document. It then sends the ToDoDoc-
defined message saveDoc to this instance. ’

Note: You could implement closeDoc: and saveDoc: in the ToDoDoc class, but the
‘ToDoController approach was chosen to make the division of responsibility
clearer.
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Select ToDoDoc.m in the project
browser.

Implement the saveDoc: method.

12 Implementthe accessor methods
for ToDoController and ToDoDoc.

{

(void)saveDoc

NSString *fn;

if (![[[itemMatrix window] title] hasPrefix:@"UNTITLED"]) ({
fn = [[itemMatrix window] representedFilename]; /* 1 */
} else {
int result; /* 2 %/
NSSavePanel *sPanel = [NSSavePanel savePanell;

[sPanel setRequiredFileType:@"td"];
result = [sPanel runModalForDirectory:NSHomeDirectory() file:nil];
if (result == NSOKButton) {
fn = [sPanel filename];
[[itemMatrix window] setTitleWithRepresentedFilename: fn];
} else
return;

if (![NSArchiver archiveRootObject:activeDays toFile:fn]) /* 3 */
NSRunAlertPanel (@"To Do", @"Couldn't archive file %@-,
nil, nil, nil, fn);
else
[[itemMatrix window] setDocumentEdited:NO};

ToDoDoc’s saveDoc method complements ToDoController’s openDoc: method in
that it runs the modal Save panel for users.

1

. The title method returns the text that appears in the window’s title bar. If the title
doesn’t begin with “UNTITLED” (what new document windows are initialized
with), then a file name and directory location has already been chosen, and is
stored as the representedFilename.

. If the window title begins with “UNTITLED” then the document needs to
be saved under a user-specified file name and directory location. This part of
the code creates or gets the shared NSSavePanel instance and sets the file
type, which is the extension that’s automatically appended. Then it runs the
Save panel, specifying the user’s home directory as the starting location.

. Archives the document under the chosen directory path and file name and,
with the setDocumentEdited: message, changes the window’s close button to an

“unbroken X” image (more on this in the next section).

Don’t implement setCurrentitems: yet. This method does something special for
the application that will be covered in “Managing the Data and Coordinating its
Display (ToDoDoc)” on page 154.
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_interface devucgg, NSText underlies all text operations, ‘and
“NSMenu has obvious significance. But four classes are atthe

“interaction is sometimes called the core program framework.

;;‘:NSWindow and NSView. Each of these classes plays a critica
* rale in the two primary activities of an application: drawing the

core of a running application: NSResponder, NSApplication

user interface and responding to events. The structure of their

NSWlndow

An NSWindow object manages each physical window (that is, :
each window created by the Window Server) on the screen. It -
draws the title bar and window frame and responds to user
actions that close, move, resize, and otherwise mampulate the
window. .

'The main purpose of an NSWindow is to display an application’s

_user interface (or part of it} in its content area. that space below
 the title bar and within the window frame. A window's contentis

- the NSViews it encloses, and at the root of this view hierarchyis

the content view, which fills the content area. Based on the

~location of a user event, NSWindows assigns an NSView inits

148

content area to act as first responder.

‘An NSWindow allows you to as5|gn a custom object as its

delegate and so participate in its activities.

‘The NSEvent class is also
involved in event processing. For
more about NSEvent and the
event cycle, see “Events and the
Event Cycle” on page 163.

NSObject

NSResponder

~~chainto each next responder until the event is handled. See the

_global variable NSApp. To coordinate your own code with NSApp,

~ (Actually, since NSView is an abstract class, these objects are
. instances of NSView subclasses.) NSView objects are
- responsible for drawing and for responding to mouse and

for more information). An NSView references its window, its

- frame and bounds are rectangl
. screen, its dlmensmn and its coordmate system for drawmg

invoked wheri ;fferent mouse and keyboard events occur. It also
defines the mechanics of gvent processing among objectsinan -
application, espemally the passing of events up the responder

“Events and the Event Cycle” on page 163 for more onthe
responder cham and a descnptlon of first responder

NSAppIication

Every application must have one NSApplication object to act as
its interface with the Window Server and to supervise and
coordinate the overall b:ehavior of the application. This object -
receives events from the Window Server and dispatches them to

~ the appropriate NSWindows (which, in turn, distribute them to

their NSViews). The NSApplication object manages its windows
and detects and handles changes in their status as well asin its
own status: hidden and unhidden, active and inactive. The
NSApplication object is represented in each application by the

you can,assigkn;,y'ou,r own custom object as its delegate.
NSView

Any object you see in a window's content area is an NSView.

keyboard events. Each NSView owns a rectangular reglon :
associated with a particular window; it produces images within -
this region and responds to events occurrmg wuthm the rectangle.

NSViews in a window are Ioglcally arranged ina wewh/erarch A
with the content view atthe top of the h|erarchy (see facmg pagef

superview, and its subviews. It ca bethe ﬂrst responderfor 2
events orthe next responder inthe

NSWindow NSApplication

NSView
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The View Hierarchy

Justinside each window's content area—the area enclosed by
the title bar and the other three sides of the frame—lies the
content view. The content view is the root {or top) NSView in the
window's view hierarchy. Conceptually like a tree, one or more
NSViews may branch from the content view, one one or more
other NSViews may branch fromthese subordinate NSViews, and
so on. Except for the content view, each NSView has one {and
only one) NSView above it in the hierarchy. An NSView's
subordinate views are called its subviews; its superior view is
known as the superview.

On the screen enclosure determines the relationship between
superview and subview: a superview encloses its subviews. This
relationship has several implications for drawing:

* |t permits construction of a superview simply by arrangement
of subviews. (An NSBrowser is an instance of a compound
NSView.)

= Subviews are positioned in the coordinates of their superview,
so when you move an NSView or transform its coordinate
system, all subviews are moved and transformed in concert.

* Because an NSView has its own coordinate system for
drawing, its drawing instructions remain constant regardless
of any change in position in itself or of its superview.

Fitting Your Application In

The core program framework provides ways for your application
to access the participating abjects and so to enter into the action.

» The global variable NSAppidentifies the NSApplication object.
By sendingthe appropriate message to NSApp, you can obtain
the application’s NSWindow objects {(windows), the key and
main windows (keyWindow and mainWindow), the current
event {currentEvent), the main menu {mainMenu), and the
application’s delegate (delegate).

* Once you've identified an NSWindow object, you can get its
contentview (by sending it contentView) and from that you can
get all subviews of the window. By sending messages to the
NSWindow object you can also get the current event
{currentEvent), the current first responder (firstResponder),
and the delegate (delegate). ’

* You can obtain from an NSView most objects it references. You
can discover its window, its superview, and its subviews.
Some NSView subclasses can also have delegates, which you
can access with delegate.

By making your custom objects delegates of the NSApplication
object, your application’s NSWindows, and NSViews that have
delegates, you can integrate your application into the core
program framework and participate in what's going on.

contentView
delegate

windows » -
delegate i v |4 window
contentView superview
delegate - subviews
< window
superview (nil)
subviews

window
superview
subviews
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Managing Documents Through Delegation

Mark a document as edited.

Open ToDoDoc.m.

Implement the
controlTextDidChange: method
to mark the document.
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At certain points while an application is running you want to ensure that a
document’s data is preserved or that a document’s edited status is tracked.
These events occur when users:

Edit a document.

Close a window.

Quit the application.

Hide the application.

Switch to another application or window.

Several classes of the Application Kit send messages to their delegates when
these events occur, giving the delegate the opportunity to do the appropriate
thing, whether that be saving a document to the file system or marking a
document as edited.

- (void)controlTekXtDidChérikge: (NSNotification *)notif

[[itemMatrix window] setDocumentEdited:YES];

When a control that contains editable text—such as a text field or a matrix of text
fields—detects editing in a field, it posts the controlTextDidChange: notification
which, like all notifications, is sent to the control’s delegate as well as to all
observers. The setDocumentEdited: message causes the document’s window to
change the image in its close button to a broken X.

[window setDocumentEdited:NO] ;
[window setDocumentEdited:YES];

Note: The ToDo object that, by notification, invokes the controlTextDidChange:
method is itemMatrix, the matrix of to-do items (text fields). You will
programmatically set ToDoDoc to be the delegate of this object later in this
tutorial.
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2 Save edited documents when
windows are closed.

Implementthe delegation method
windowShouldClose:.

(BOOL)windowShouldClose: (id) sender

int result;
/* 1 */
if (![[itemMatrix window]
/* 2 */
[[itemMatrix window] makeFirstResponder: [itemMatrix window]];
result = NSRunAlertPanel(@"Close", @"Document has been edited.
Save changes before closing?", @"Save", @"Don't Save",
@"Cancel");

isDocumentEdited]) return YES;

/* 3 */
switch(result) {
case NSAlertDefaultReturn: {
[self saveDocItems];
[self saveDoc];
return YES;

case NSAlertAlternateReturn: {
return YES;

}
case NSAlertOtherReturn: {
return NO;

}

return NO;

When users click a window’s close button, the window sends windowShouldClose:
to its delegate. It expects a response directing it either to close the window or
leave it open.

1

. Returns YES (meaning: go ahead, close the window) if the document hasn’t been

edited.

. Makes the window its own first responder. This has the effect of forcing the

validation of cells, flushing currently entered text to the method that handles
it (more on this in the next section).

. Identifies the clicked button by evaluating the constant returned from

NSRunAlertPanel{) and returns the appropriate boolean value: If the user clicks
the Save button, this method also updates internal storage with the currently
displayed items (saveDocltems) and then sends saveDoc to itself to archive
application data to 3 file. (saveDocltems is described in the following section.)

Note: Do you recall the performClose: method that ToDoController sends the
document window when the user chooses the Close command? This method
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Save edited documents when the
user quits the application.

In ToDoController.m, implement

the delegation method
applicationShouldTerminate:.
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simulates a mouse click on the window’s close button, causing windowShouldClose:
to be invoked.

-‘(BOOL)appllcat1onshouldTerm1nate (id)sendég‘

while ([NSApp keyWindow]) {
int result;
id doc = [[NSApp keyWindow] delegatel];

if (! [[NSApp keyWindow] isDocumentEdited])  {
[[NSApp keyWindoW] close];
if (doc) [doc autorelease];
continue;
) )
if ([doc isKindOfClass:[ToDoDoc class]]) {
NSString *repfile = [[NSApp keyWindow] representedFilename];
result = NSRunAlertPanel(@"To Do", @"Save %@?", @"Save”,
@"Don't Save", @"Cancel", .
([repflle isEqualToString: @"“]9@“UNTITLED“ repflle)),
sw1tch(resu1t) { ’
 case NSAlertDefaultReturn.
[doc saveDocItems]:
[doc saveDocl;
break; )
case NSAlertAlternateReturn."
[ [NSApp keyWindow] close]
break; o
case NSAlertOtherReturn."
return NO; :

}

if (doc) [doc autoreleasel;

}
else
[[NSApp keywlndow] close],

return YES;

NSApplication sends several message to its delegate. One of these messages—
applicationShouldTerminate—notifies the delegate that the application is about to
terminate. The implementation of this method is similar to that for
windowShouldClose:. What’s different is that this method cycles through all
windows of the application and, if the window is managed by "ToDoDoc, puts
up an attention panel and responds according to the user’s choice.
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Managing the Data and Coordinating its Display (ToDoDoc)

If you recall the discussion on To Do’s design earlier in this chapter (“How To
Do Stores and Accesses its Data” on page 119), you’ll remember that the
application’s real data consists of instances of the model class, ToDoltem. To Do
stores these objects in arrays and stores the arrays in a dictionary; it uses dates as
the keys for accessing specific arrays. (Both the dictionary and its arrays are
mutable, of course.) You might also recall that this design depends on a
positional correspondence between the text fields of the document interface
and the “slots” of the arrays.

"To lend clarity to this design’s implementation, this section follows the process
from start to finish through which the ToDoDoc class handles entered data, and
organizes, displays, and stores it. [t also shows how the display and manipulation
of data is driven by the selections made in the CalendarMatrix object.

Start by revisiting a portion of code you wrote earlier for ToDoDoc’s initWithFile:
method.

- initWithFile: (NSString *)aFile

{
/* .. %/
if (aFile) {
activeDays = [NSUnarchiver unarchiveObjectWithFile:aFilel;
if (activeDays)
activeDays = [activeDays retain];
else . ) :
NSRunAlertPanel (@"To Do", @"Couldn't unarchive file %@",
nil, nil, nil, aFile);
} else {
activeDays = [[NSMutableDictionary alloc] init];
[self setCurrentItems:nil];
}
/* ... %)/

Assume the user has chosen the New command from the Document menu.
Since there is no archive file (aFile is nil), the activeDays dictionary is created but
is left empty. Then initWithFile: invokes its own setCurrentltems: method, passing in
nil.
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Set the current items or, if
necessary, create and prepare
the array that holds them.

Implement setCurrentltems:.
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_;(vbid)seth rentItems:(NSMutabiéArray'*}ﬁewrtems
o . .

if (currentItems) [currentItems autorelease];

E":i?f,(newkiylft."ems)

‘currentTtems = [newItems mutableCopy];
else { ’ i )
int numRows = [[itemMatrix cells] count]:;

currentItems = [[NSMutableArray alloc]
initwithCapacity:numRows];

while (--numRows >= 0)
[currentItems addObject:@""};

This “set” accessor method is like other such methods, except in how it handles
a nil argument. In this case, nil signifies that the array does not exist, and so it
must be created. Not only does setCurrentltems: create the array, but it “initializes”
it with empty string objects. It does this because NSMutableArray’s methods
cannot tolerate nil objects within the bounds of the array.

So there’s now a currentltems array ready to accept ToDoltems. Imagine yourself
using the application. What are the user events that cause a ToDoltem to be
added to the currentitems array? To Do allows entry of items “on the fly,” and thus
does not require the user to click a button to add a ToDoltem to the array.
Specifically,.items are added when users type something and then:

® Press the Tab key.
® Press the Enter key.
e Click outside the text field.

"The controlTextDidEndEditing: delegation method makes these scenarios possible.
The matrix of editable text fields (itemMatrix) invokes this method when the
cursor leaves a text field that has been edited.
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As items are entered in the
interface, add ToDoltems to
internal storage, delete them, or
modify them, as appropriate.

Implement
controlTextDidEndEditing:.

- (void)controlTextDidEndEditing: (NSNotification *)notif
{
id curltem, newltem;
int row = [itemMatrix selectedRow];
NSString *selName = [[itemMatrix selectedCell] stringValue];
/* L */
if (![[itemMatrix window] isDocumentEdited] ||
(row >= [currentItems count])) return;
if (!currentItems)
[self setCurrentlItems:nil];

/* 2 %/
if ([selName isEqualToString:@""] &&
([[currentItems objectAtIndex:row] isKindOfClass:
[ToDoItem class]]) &&
(![[[currentIitems objectAtIndex:row] itemNamel]
isEqualToString:@""1))
[currentItems replaceObjectAtIndex:row withObject:@""];
/* 3 %/

else i1f ([[currentItems objectAtIndex:row] isKindOfClass:
[ToDoItem class]] &&

(![[[currentItems objectAtIndex:row] itemName]
isEqualToString:selName]) )

[[currentItems objectAtIndex:row] setltemName:selName];
/* 4 %/
else 1f (![selName isEqualToString:@""]) {
newItem = [[ToDoItem alloc] initWithName:selName
andDate: [calendar selectedDayl];
[currentItems replaceObjectAtIndex:row withObject:newlItem];
[newItem release];
}
/* 5 */
[self updateMatrix];

A control sends controlTextDidEndEditing: to its delegate when the cursor /eaves a text
field. In addition to creating new ToDoltems, this implementation of
controfTextDidEndEditing: removes ToDoltems from arrays and modifies item text.
What it does is appropriate to what the user does. ’

1. If the document hasn’t been edited (see controlTextDidChange:) or if the selected row
exceeds the array bounds, it returns because there’s no reason to proceed. It
initializes a currentitems array if one doesn’t exist.

2. If the user deletes the text of an existing item, it removes the ToDoltem that
positionally corresponds to the row of that deleted text.

3. It changes the name of an item if the text entered in a field doesn’t match the
name of the corresponding item in the currentitems array.
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4. If either of the two previous conditions don’t apply, and text has been
entered, it creates a new ToDoltem and inserts it in the currentltems array.

5. Updates the list of items in the document interface.

3 Update the document interface
with the current items.

"(§6id)up6ateMatrix':' '

ImpIementupdateMatrix- . [currentItems count], rows = [[itemMatrix cells) count] ;,)

i

for (i=0; i<cnt, i<rows;
NSDate *due; :
“thisItem = [currentItems objectAtIndex il; : Coe
~if ([thisItem isKindofClass: [ToDoItem class]]) (G R R Ak RV
if( [thlsItem sechntllDue] ) o ¢ R
‘due = [[thisItem day] addTimeInterval:
: ‘ {thisItem secsUntilDuell;

else .
due = nil; S
[[itemMatrix cellAtRow
[thlsItem 1temName]]; e
[[markMatrix cellAtRow:i column:0] setTimeDue:duel;
[ [markMatrix, cellAtRow:i column:0] setTriState: -
f[tbisltem itémStatus]]:

setStringValue:

[[1temMatr1x cellAtRow:i column:O]
[ImarkMatrix cellAtRow:i column:0] setTitle: “"],
‘[[markMatrix cellAtRow:i column:0} setImage nll],

The updateMatrix method writes the names of the items (ToDoltems) in the
currentitems array to the text fields of itemMatrix. It also updates the visual
appearance of the cells in the matrix (markMatrix) next to itemMatrix. These cells
are instances of a custom subclass of NSButtonCell that you will create later in
this tutorial. For now, just type all the code above; later, when you create the cell
class, ToDoCell, you can refer back to this example to see what is happening.

Basically, this method cycles through the array of items, doing the following:

1. If an object in the array is a ToDoltem, it writes the item name to the text field
corresponding to the array slot and updates the button cell next to the field.

2. If an object isn’t a ToDoltem, it blanks the corresponding text field and cell.
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4 Respond to user actions in the

- (void)calendarMatrix: (CalendarMatrix *)matrix /* 1 */
calendar.

didChangeToDate: (NSDate *)date

Implement CalendarMatrix’s

. [[itemMatrix window] makeFirstResponder:[itemMatrix window]];
delegation methods.

[self saveDocItems];

[self setCurrentItems:[activeDays objectForKey:datel];

[dayLabel setStringValue:[date descriptionWithCalendarFormat:
@"To Do on %a %B %d %Y" timeZone: [NSTimeZone defaultTimeZone]
locale:nil]];

[self updateMatrix];

}

- (void)calendarMatrix: {CalendarMatrix *)matrix /* 2 */
didChangeToMonth: (int)mo year: (int)yr

[self saveDocItems];
[self setCurrentItems:nil};
[self updateMatrix]:;

As you recall, CalendarMatrix declared two methods to allow delegates to “hook
into” its behavior. Its delegate for this application is ToDoDoc.

1. The calendar sends calendarMatrix:didChangeToDate: when users click a new day of
the month. This implementation saves the current items to the activeDays
dictionary. It then sets the current items to be those corresponding to the selected
date (if there are no items for that date, the objectForKey: message returns nil and the
currentitems array is initialized with empty strings). Finally it updates the matrix
with the new data.

2. The calendar sends calendarMatrix:didChangeToMonth:year: when users go to a new
month and (possibly) a new year. This implementation responds by saving
the current items to internal storage and presenting a blank list of items.
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Save the data to internal storage.

Implement saveDocltems:.

Archive and unarchive the
document’s data.

Implement encodeWithCoder:
and initWithCoder:to archive and
unarchive the dictionary holding
the arrays of ToDoltems.
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- (void)saveDocItems
{ i ‘
ToDoItem *ahItem;
int=if‘cnt‘==[¢urrentltems count] ;
// save day's current items (array) to document dictionary
for (i=0; i<cnt; i++) { o
if ( (anItem = [currentItems objectAtIndex:1]) &&
([anItem isKindOfClass:[ToDoItem class]]) ) {
[activeDays setObject:currentItems forKey:
[anItem day]l];
break;

This method inspects the currentltems array and, if it contains at least one
ToDoltem, puts the array in the activeDays dictionary with a key corresponding
to the date.

Now that you’ve completed the methods for saving and archiving the collection
objects holding ToDoltems, assume that the user has saved his document and
then opens it.
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7 Perform set-up tasks when the - (void)awakeFromNib
document’s nib file is unarchived. (
int 1i;

Implement awakeFromNib as NSDate *date;

shown at right.

date = [calendar selectedDayl];

[self setCurrentItems:[activeDays cbjectForKey:datell];
/* set up self as delegates */

[[itemMatrix window] setDelegate:self];

[itemMatrix setDelegate:self];

[[itemMatrix window] makeKeyAndOrderFront:self];

When the ToDoDoc.nib file is completely unarchived, awakeFromNib is invoked. It
sets the current items for today, sets a couple of delegates, and puts the
document window in front of all other windows.

Note: This method sets some delegates programmatically, which is redundant
since you set these delegates in Interface Builder. However, this code
demonstrates the programmatic route—and no harm done.

8 Setup the document once it's

- (void)activateDoc
created or opened.

{

. if ([currentItems count]) [self updateMatrix];
Implement activateDoc as shown .
atﬁght [dayLabel setStringValue:[[calendar selectedDay]
) descriptionWithCalendarFormat:@"To Do on %a %B %d %Y"
timeZone: [NSTimeZone defaultTimeZone] locale:nilll];

The activateDoc method is invoked right after a ToDo document is created or

opened. It starts the ball rolling by updating the list matrices of the document
and writing the current date to the “To Do on <date>" label.

159



Chapter 4 To Do Tutorial

Subclass Example: Overriding Behavior (SelectionNotifMatrix)

You can often achieve significant gains in object behavior by making a subclass
that adds only a small amount of code to its superclass. Such is the case with the
subclass you’ll create in this section: SelectionNotifMatrix.

The need for this class is this: An instance of NSMatrix is a control and thus can
send action messages to its cell’s targets; but when it contains
NSTextFieldCells, action messages are sent only when users press the Return
key in a cell. You want the inspector to synchronize its displays when the user
selects a new item by clicking a text field. To do this, you will override the
method in NSMatrix that is invoked when users click the matrix; in your
implementation, you’ll invoke the superclass method, detect the selected row,
and then post a notification to interested observers.

1 Create template source-code ~ #import <‘Ap1$Kit“/Aprit.h‘>‘ h
files and add to the project.

extern NSString *SelectlonInMatrlxNotlflcatlon = /* 1%/

Choose File » New In Project. -~ @"SelectionInMatrixNotification";
Inthe New File In ToDo panel, ‘ :

select the Class suitcase. turn on @interface SelectionNotifMatrix : NSMatrix
the Create header switch, and S O ; i

type “SelectionNotifMatrix” after }

Name.

—'(voia)mouseDown:(NSEvent *)theEvent; /* 2 */
2 Add declarations to the header : o L -
file. @end

1. Declares a string constant identifying the notification that will be posted.

2. Declares mouseDown:, the method implemented by the superclass that
SelectionNotifMatrix overrides.

3 Override mouseDown:

- (void)mouse

{

In SelectionNotifMatrix.m,
implement mouseDown: as
shown here.

int row;
[super mouse

Down:theEvent];

row = [self selectedRow];
fQif (row != —l) {
> [[NSNotlflcatlonCenter defaultCenter]
postNotlflcatlonName @"Selectlonln
object: self userInfo: [NSchtlonarykdl
[NSNumber numberWithInt:row k '
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4 Replace the class of the matrix
object.

In Interface Builder:

Open ToDoDaoc.nib.

Select the matrix of editable text
cells.

Open the inspector and choose
Custom Class from the pop-up
menu.

Select SelectionNotifMatrix in
the browser of compatible
classes.

This override of mouseDown: does the following:

1. Invokes NSMatrix’s implementation of mouseDown: to allow the normal
processing of this event.

2. Gets the row of the cell clicked and, if it’s a valid row, creates a userinfo
dictionary containing the clicked row, and posts the
SelectionInMatrixNotification.

Now that you’ve created the SelectionNotifMatrix class, you must re-assign the
class membership of the object in the interface. You can do this easily in
Interface Builder.

SelectionHotifMatrix Inspecto X

The Custom Classes browser lists the original
class of the selected object and all compatible
custom subclasses.

CalendarMalrix =
ISMatrix oo
electionNotifatrix

161



Chapter 4

To Do Tutorial

You can depict the interaction between a user and an OpenStep
application as a cyclical process, with the Window Server playing
an intermediary role (see illustration below). This cycle—the
event cycle—usually starts at launch time when the application
{which includes all the OpenStep frameworks it’s linked to) sends
a stream of PostScript code to the Window Server to have it draw
the application interface. : :

Then the application begins its main event loop and begins
accepting input fromthe user (seefacing page). When users click
or drag the mouse or type on the keyboard, the Window Server
detects these actions and processes them, passing them to the
application as events. Often the application, in response to these
events, returns another stream of PostScript code to the Window
Server to have it redraw the interface.

In addition to events, applications can respond to other kinds of
input, particularly timers, data received at a port, and data waiting

atafile descriptor. But events are the mostimportantkind of input.

Events

The Window Server treats each user action as an event; it
associates the event with a window and reports it to the
application that created the window . Events are objects:
instances of NSEvent composed from information derived from

©the user action.

All eventmethods defined in NSResponder (such as mouseDown:
and keyDown:) take an NSEvent as their argument. You can query
an NSEvent to discover its window, the location of the event
within the window, and the time the event occurred (relative to
system start-up). You can also find out which (if any) modifier keys
were pressed (such as Command, Alternate, and Control), the

codes identifying characters and keys, and various other kinds of

information.

An NSEvent also divulges the type of event it represents. There
are many eventtypes (NSEventType); they fall into five categories:

* Keyboard events Generated when a key is pressed down, a
pressed key is released, or a modifier key changes. Of these,
key-down events are the most useful. When you handle a key-
down event, you often determine the character or characters
associated with the event by sending the NSEvent a
characters message.

* Mouse events Mouse events are generated by changesin
the state of the mouse buttons {that is, down and up) for both
left and right mouse buttons and during mouse dragging.
Events are also generated when the mouse simply moves,
without any button pressed.

» Tracking-rectangle events If the application has asked the
window system to set a tracking rectangle in a window, the
window system creates mouse-entered and mouse-exit
events when the cursor enters the rectangle or feaves it.

* Periodic events A periodic event notifies an application that
a certain time interval has elapsed. An application canrequest
that periodic events be placed in its event queue at a certain
frequency. They are usually used during atracking loop. (These
events aren't passed to an NSWindow.)

* Cursor-update events An cursor-update event is generated
when the cursor has crossed the boundary of a predefined
rectangular area. '

Events
A (Ilther
- ications
Server Applicati  E—
User pplication
— |
Monitored Port
or File
PostScript
Code Timed
Entries
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The Event Queue and Event Dispatching

When an application starts up, the NSApplication object (NSApp)
starts the main event loop and begins receiving events from the
Window Server (see page 116). As NSEvents arrive, they're putin
the event gueue in the order they're received. On each cycle of
the loop, NSApp gets the topmost event, analyzes it, and sends an
event message to the appropriate object. (Event messages are
defined by NSResponder and correspond to particular events.)
When NSApp finishes processing the event, it gets the next event,
and repeats the process again and again until the application
terminates.

The objectthatis “appropriate” for an event depends on the type
of event. NSApp sends most event messages to the NSWindow in
which the user action occurred. If the event is a keyboard or
mouse event, the NSWindow forwards the message to one of the
objectsinits view hierarchy: the NSView within which the mouse
was clicked or the key was pressed. If the NSView can respond
tothe event—thatis, itaccepts firstresponder status and defines
an NSResponder method corresponding to the event message—
it handles the event.

I Conven kcﬂi NSEvent ,‘1 NSAppIication'——]
NSEvent
NSEvent NSWindow
Rl NSEvent |
erver

NSView

Ifthe NSView cannot handle an event, it forwards the message to
the next responder in the responder chain (see below). Ittravels
up the responder chain until an object handles it.

NSWindow handles some events itself, and doesn't forward them
to an NSView, such as window-moved, window-resized, and
window-exposed events. (Since these are handled by NSWindow
itself, they are not defined in NSResponder.) NSApp also
processes a few kinds of events itself; these include cursor-
update, and application-activate and -deactivate events.

First Responder and the Responder Chain

Each NSWindow in an application keeps track of the objectinits
view hierarchythat has first responderstatus. This is the NSView
that currently receives keyboard events for the window. By
default, an NSWindow is its own first responder, but any NSView
within the window can become first responder when the user
clicks it with the mouse.

You can also set the first responder programmatically with the
NSWindow's makeFirstResponder: method. Moreover, the first-
responder object can be a target of an action message sentby an
NSControl, such as a button or a matrix. Programmatically, you do
this by sending setTarget: to the NSControl (or its cell) with an
argument of nil. You can do the same thing in Interface Builder by
making a target/action connection between the NSControl and
the First Responder icon in the Instances display of the nib file
window.

Recall that all NSViews of the application, as well as all
NSWindows and the application object itself, inherit from
NSResponder, which defines the default message-handling
behavior: events are passed up the responder chain. Many
Application Kit objects, of course, override this behavior, so
events are passed up the chain until they reach an object that
does respond. i :

The series of next responders in the responder chain is
determined by the interrelationships between the application’s
NSView, NSWindow, and NSApplication objects {see page 149).
For an NSView, the next responder is usually its superview; the
content view's next responder is the NSWindow. From there, the -
event is passed to the NSApplication object.

For action messages sent to the first responder, the trail back
through possible respondents is even more detailed. The
messages are first passed up the responder chain to the
NSWindow and then to the NSWindow’s delegate. Then, if the
previous sequence occurred in the key window the same path is
followed for the main window. Then the NSApplication object
tries to respond, and failing that, it goes to NSApp's delegate.
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Creating and Managing an Inspector (ToDolnspector)

In Interface Builder

1

Create a new nib file named
ToDolnspector.nib and add itto
the ToDo project.

Create the inspector panel.
Drag a panel object from the

Windows palette.

Make the title of the panel
“Inspector.” '

Resize the panel, using the
example at right as a guide.

Put labels and fields on the panel
and set their attributes (as
shown).

Put a pop-up button on the panel
and set cell titles {as shown).

Assign tags to the pop-up button
cells.

Create a separator line just below
the pop-up button.

Put an empty box object in the
lower part of the panel.
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An inspector is a panel of fields and controls that enable users to examine and
set an object’s attributes. Because objects often have many attributes and
because you want to make it easy for users to set those attributes, inspectors
usually have more than one display; users typically access these multiple
displays using a pop-up list.

The ToDo application has an inspector panel that allows users to inspect and set
the attributes of the currently selected ToDoltem. The inspector panel has its
own controller: ToDolnspector. While showing you how to create the inspector
panel and ToDolnspector, this section focuses on four things:

Managing displays according to user selections

Getting the current ToDoltem

Updating the currently selected display

Updating the current ToDoltem as users make changes to it

Inspector

The text fields after the labels should have a light
gray background and should not be editable. The
lower of these fields should be large enough to

hold the text of an item.

Double-click to display the three default cells
(ltem1, Item2, and Item3). Then, for each cell,
double-click its title to select it and type the new
title. Assign tags (0 to 2) to the cells.

Turn off the title attribute and resize the box object
so it fits just inside the lower part of the panel.
To provide a guide for resizing, this example
shows the box having a border; turn the border
off after resizing.

Before You Go On

You might be wondering about the empty box object in the lower part of the
panel. This box by itself may not seem a promising thing for displaying object
attributes, but it is critical to the workings of the inspector panel. A box that you
drag from the Views palette contains one subview, called the content view.
NSBox’s content view fits entirely within the bounds of the box. NSBox
provides methods for obtaining and changing the content view of boxes. You’ll
use these methods to change what the inspector panel displays.
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3 Create an off-screen panel

The scroll view is its own grouping (Notes).
holding the inspector’s displays.

Inspector Views

Drag a panel object from the

‘ L] . L] | ]
Windows palette. iT{Task Completed tme: [ [ CamGem
: : ——— When to Reschedule —— === Yhen to Notify ————==
Resize the panel, using the ‘| Dontreschedule | {71Do notnotfy ‘
example at right as a guide. {17 [Next day - | "1 15 minutes before :
’ i : ! iZ] 1 hour before - :
Put the labels, text fields, scroll | L] week fram now = e
. . : {TMonth from now { 7|1 day before S
view, and switch and radio-button f:;»_"‘specmc date Floter [ I nours |
matrices on the panel shown in i M myyiae : RO i
the example at right. ' Ly iy i ;

Make the When to Reschedule ) o S » . -
and When to Notify groupings
(boxes).

Turn off the border attributes of each outer box. —————-———/

Make three other groupings for

the three displays: Notes, Before You Go On
Reschedule, and Notification.

. . You probably now see where the inspector panel gets its displays and how it puts
Resize the resulting boxes to the them in place. When the inspector panel is first opened (and ToDolnspectornib is
same dimensions as the p s b b P P o
“dummy” view in the inspector loaded) the inspector controller, ToDolnspector, replaces the content view of
panel. the inspector’s empty box (dummyView) with the content view of the Notification

box in the off-screen panel. Thereafter, every time the user chooses a new pop-
up button in the inspector panel, ToDolnspector replaces the currently
displayed content view with the content view of the associated off-screen box.

( , A

When users choose a new display,
ToDolnspector replaces the current
content view of dummyView with
the appropriate view on the off-

screen window of inspector views.

dummyView —
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Define the ToDolnspector class.
Create a subclass of NSObject
and name it “ToDolnspector.”

Add the outlets and actions in the
tables at right to the new class.

Instantiate ToDolnspector.

Connectthe ToDolnspector
object to its outlets and as the
target of action messages (see
tables at right).

Connect ToDolnspector and the
inspector panel via the panel’s
delegate outlet.

Close both panels.
Save ToDolnspector.nib.

Create source-code files for
ToDolnspector and add them to
the project.
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Outlet Connection From ToDolnspector To...

dummyView The empty box object in the inspector panel

inspectorViews The title bar of the off-screen panel

notesView The box in the off-screen panel containing the scroll view

notifView The box in the off-screen panel containing the fields and controls
related to notification of impending items

reschedView The box in the off-screen panel containing the fields and controls
related to rescheduling items

inspPopUp The pop-up button on the inspector panel

inspDate The uneditable text field next to the “Date” label

inspltem The uneditable text field next to the “Item” label

inspNotifHour The first field after the “Time" label

inspNotifMinute The second field after the “Time” [abel

inspNotifAMPM The matrix holding the “AM” and “PM" radio buttons

inspNotifOtherHours The text field in the “When to Notify” box

inspNotifSwitchMatrix The matrix of switches in the “When to Notify” box

inspSchedComplete The “Task Completed” switch

inspSchedDate The text field in the “When to Reschedule” box

inspSchedMatrix The matrix of switches in the “When to Reschedule” box

inspNotes The text object inside the scroll view

Action Connection To ToDolnspector From...

newlnspectorView:

The pop-up button on the inspector panel

switchChecked:

The matrix of switches in the “When to Notify” box, the AM-PM matrix,
the “Task Completed” switch, and the matrix of switches in the “When
to Reschedule” switches.
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In Project Builder

5 Add declarations to

ToDalnspector.h.

Open ToDolnspector.h.

Type the declarations shown at
right (ellipses indicate existing
declarations).

@interface ToDoInspector
{

: NSObject

ToDoItem *currentItem;
/* oo */
}
/* L. )/
- (void)setCurrentItem: (ToDoltem *)newItem;
- (ToDoItem *)currentItem;
- (void)updateInspector: (ToDoltem *)item;

Import ToDoltem.h and @end
ToDoDoc.h.
The ToDolnspector class has a utility function for clearing switches setin a
matrix and defines constants for the tags assigned to the pop-up buttons.
OpEHTbDOHEPecmLm' static void clearButtonMatrix{id matrix);

Forward-declare enum { notifTag = 0, reschedTag, notesTag };
clearButtonMatrix() at the
beginning of the file.

. Using tags to identify cells rather than cell titles is a better localization strategy.
Define enum constants for the

op-up button tags. . .
pop-tp tags ToDolnspector has two accessor methods, one that gives out the current item

and one that sets the current item.

6 Implementthe accessor methods
for the class.

- (void)setCurrentItem: (ToDoItem *)newItem

if (currentlItem) [currentltem autorelease];
Implement currentltem to return if (newItem)
the instance variables it names.

currentItem = [newItem retain]; /* 1 %/
Implement setCurrentltem: as else
shownatﬁght currentItem = nil;
[self updateInspector:currentItem]; /* 2 */

This implementation of a “set” accessor method probably seems familiar to
you—except for a couple of things:

1. Instead of copying the new value, this implementation retains it. By retaining, it
shares the current ToDoltem with the document controller (ToDoDoc) that has
sent the setCurrentltem: message, enabling both objects to update the same
ToDoltem simultaneously.

Note: Later in this section, you’ll invoke ToDolnspector’s setCurrentitem:
method in various places in ToDoDoc.m.

2. Updates the current display of the inspector with the appropriate values of
the new ToDoltem.
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Switch inspector displays based

on user selections.

Implement newlnspectorView:.
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- (void)newInspectorView: (id)sender

{
NSBox *newView=nil; L
NSView *cView = [[inspPopUp window] contentView]; . /* 1 */
int selected = [[inspPopUp selectedItem] tag]:; :
switch(selected) { = - . g ans
case notifTagéi -
newView = notifView;
break;
case reschedTag:
newView = reSchedView;
break;
case notesTag:
newView = notesView;

/% 2 %/

}
if ([[cView subviews] containsObject:newView]) return; /* 3 */
[dummyView setContentView:newView]; /* 4 %/
if (newView == notifView) [inspNotifHour selectText:self];

if (newView == .notesView) [inspNotes '

- setSelectedRange:NSMakeRange(0,0)];

[self updatelnspector:currentItem]; . . I YA - N
[cView displayl; 3 L ‘ !

This method switches the current inspector display according to the pop-up
button users select; it does this switching by replacing the dummyView’s content
view. Toward this end, the method:

1. Gets the panel’s content view and the tag of the selected pop-up button.

2. Assigns to the newView local variable the off-screen box object corresponding

to the tag of the selected pop-up button.

3. Returns if the selected display is already on the inspector panel. The subviews

message returns an array of all subviews of the inspector panel’s control view,
and the containsObject: message determines if the chosen display is among
these subviews.

4. Replaces the content view of the inspector panel’s dummyView. In awakeFromNib

(which you’ll soon implement) you’ll retain each original content view. The
setContentView: method replaces the new view and releases the old one;
because it’s been retained, the replaced view doesn’t disappear.

5. Updates the inspector with the current item,; this item hasn’t changed, but the

display is new and so the set of instance variables to be displayed is different.
The display message forces a re-draw of the inspector panel’s views.
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8 Update the current inspector
display with the new ToDoltem.

Write the first part of the
updatelnspector: method shown
atright.

{

(void)updateInspector: (ToDoItem *)newltem

int minute=0, hour=0, selected=0;
selected = [[inspPopUp selectedltem] tagl:
[[inspPopUp window] orderFront:self];
if (newItem && [newItem isKindOfClass:[ToDoItem class]])
[inspItem setStringValue: [newItem itemName]];
[inspDate setStringValue:[[newItem day]
descriptionWithCalendarFormat:@"%a, %b %d %Y"
timeZone: [NSTimeZone localTimeZone] locale:nill];
switch(selected) {
case notifTag: {
long notifSecs, dueSecs = [newltem secsUntilDue];
BOOL ampm = ConvertSecondsToTime (dueSecs, &hour,
[[inspNotifAMPM cellAtRow:0 column:0] setState:!ampm];
[[inspNotifAMPM cellAtRow:0 column:1] setState:ampm];
[inspNotifHour setIntValue:hour];
[inspNotifMinute setIntValue:minute];
notifSecs = dueSecs - [newlItem secsUntilNotif];
if (notifSecs == dueSecs) notifSecs = 0;
clearButtonMatrix (inspNotifSwitchMatrix);
switch(notifsecs) {
case 0:
[{inspNotifSwitchMatrix cellAtRow:0 column:0]
setState:YES];
break;
case (hrInSecs/4):
[[inspNotifSwitchMatrix cellAtRow:1 column:0]}
setState:YES];
break;
case (hrInSecs):
[[inspNotifSwitchMatrix cellAtRow:2 column:0]
setState:YES];
break;
case (dayInSecs):
[[inspNotifSwitchMatrix cellAtRow:3 column:0]
setState:YES];
break;
default: /* Other */
[[inspNotifSwitchMatrix cellAtRow:4 column:0]
setState:YES];
[inspNotifOtherHours setIntValue:
( (dueSecs-notifSecs) /hrInSecs)];

/* 1 */

{72 */

/* 3 */

/x4 */

) break;
}
‘break;
) :
caseQreschedTag:

ak; -
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The updatelnspector: mcthod is a long one, so we’ll approach it in stages. This first part updatc
the common data elements (item name and date) and, if the selected display is for notification
updates that display.

1. Gets the tag assigned to the selected pop-up button.

2. Tests the argument newltem to see if it is a ToDoltem. This test is important
because if the argument is nil, the method clears the display of existing data
(next example).

If newltem is a ToDoltem, updatelnspector: first updates the Item and Date
fields.

3. If the tag of the selected pop-up button is notiffag, updates the associated
inspector display. This task starts by converting the due time from seconds to
hour, minute, and PM boolean values and then setting the appropriate fields
and button matrix with these values.

4. Sets the appropriate switch in the “When to Notify” matrix. It starts with the
difference (in seconds) between the time the item is due and the time the
item notification is sent. It calls clearButtonMatrix(} to turn all switches off and
then, in a switch statement, sets the switch corresponding to the difference in
value between seconds from midnight before due and before notification.

Before You Go On

Update the Notes display: Add code to update the inspector’s Notes display from the
information in the ToDoltem passed into updatelnspector.. (Check the
documentation on NSText to see what method is suitable for this.) The selected
pop-up button must have notesTag assigned to it. Also put the cursor at the start
of the text object by selecting a “null” range.

Note that tutorial omits the rescheduling logic of the "ToDo application,
including the code in this method that would update the “Reschedule” display.
Rescheduling of ToDoltems is reserved as an optional exercise for you at the
end of this tutorial.
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Finish the implementation of }
updatelnspector: by resetting all else if (!newItem) { /* newltem is nil */
displays if the argument is nil. [inspIltem setStringValue:@""];

[inspDate setStringValue:@""};

[inspNotifHour setStringvValue:@""];

[inspNotifMinute setStringvValue:@""];

[[inspNot1fAMPM cellAtRow:0 column:0] setState:YES];

[[inspNotifAMPM cellAtRow:0 column:1l] setState:NO];

clearButtonMatrix (inspNotifSwitchMatrix) ;

[[inspNotifSwitchMatrix cellAtRow:0 column:0]
setState:YES] ;

[inspNotifOtherHours setStringValue:@""];

[inspNotes setString:@""];

As you’ve most likely noticed, the updatelnspector: method calls the function
clearButtonMatrix({), which resets the states of all button cells in a switch matrix to
NO. This function has a counterpart, index0fSetCell{), that returns the index of the
currently selected switch.

Implement the void clearButtonMatrix(id matrix)
clearButtonMatrix() utility {
function. int i, cnt=[[matrix cells] count];

for(i=0; i<cnt; i++)
[[matrix cellAtRow:1i column:0] setState:NO];

The cells message returns the cells of the matrix as an array; the count message
determines the number of cells.
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9 Update the currentitem with new

172

values entered in the inspector.

Implement switchChecked: to
apply changes made through
switches and other controls.

hChecked: (id) sender

f ( 1nspNot1fHour 1ntVa1ue]) T .
tmpSecs. = ConvertTlmeToSeconds( 1nspNot1fHour
‘ [1nspNot1fM1nute 1ntVa1ue],
[lsender cellAtRow 0. colum étate])f
[currentItem setSechntllDue tmpSecs],
[[NSApp ma W1ndow} setDo umentE‘lted

sUptilNotif:tmpSecs—(hrInSecs/4)];

[currentItem setSechntllNotl : [ihspkotifotherHours;intvélu
* hrInSecs)], ‘ ‘ ' s

NSLog(@“Error in selectedRow")'
break.k ;
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When users click a switch button on any inspector display, or when they click
one of the AM-PM radio buttons, the switchChecked: method is invoked. This
method works by evaluating the sender argument: the sending object.

L.

4.

If sender is the radio-button matrix (AM-PM), gets the new time due by calling the
utility function ConvertTimeToSeconds(), sets the current item to have this new value,
marks the document as edited, and then sends updateMatrix to the document
controller to have it display this new time.

. If sender is the “When to Notify” matrix, gets the index of the selected cell

and the seconds until the item is due. It evaluates the first value in a switch
statement and uses the second value to set the current item’s new secsUntilNotif
value. It also sets the window to indicate an edited document.

. If sender is the “Task Completed” switch, sets the status of the current item

to “complete,” sets the window to indicate an edited document, and has the
document controller update its matrices.

As before, implementation of this rescheduling block is left as a final exercise.

Since text fields are controls that send target/action messages, you could also
have switchChecked: respond when data is entered in the fields. However, users
might not press Return in a text field so you can’t assume the action message will
be sent. Therefore, it’s better to rely upon delegation messages.
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Update the current item if
changes are made to the
contents of text fields or the text
object of the inspector panel.

(void)textDidEndﬁditingf(NSNéﬁificaEion *Ynotif /; 1“*/‘
if ([notif object] == inspNotes)

[currentItem setNotes: [inspNotes stringl];
[ [NSApp mainWindow] setDocumentEdited:YES];

- (void)controlTextDidEndEditing: (NSNotification *)notif

{
long tmpSecs=0;
‘if ([notif object] == inspNotifHour || /* 2 */
[notif object] == inspNotifMinute) {

tmpSecs = ConvertTimeToSeconds ([inspNotifHour intvalue],
[inspNotifMinute intValue],
[[inspNotifAMPM cellAtRow:0 column:1] state]l);
[currentItem setSecsUntilDue:tmpSecs];
[[[NSApp mainWindow] delegate] updateMatrix];
[ [NSApp mainWindow] setDocumentEdited:YES];
} else if ([notif object] == inspNotifOtherHours) { /* 3 */
if ([inspNotifSwitchMatrix selectedRow] == 4) {
[currentItem setSecsUntilNotif: ({inspNotifOtherHours
intvValue] * hrInSecs)];

: [ [NSApp mainWindow] setDocumentEdited:YES];

} else if ([notif objeét] == inspSchedDate) { /¥4 */
3 i

The textDidEndEditing: and controlTextDidEndEditing: notification messages are sent to
the delegate (and all other observers) when the cursor leaves a text object or text
field (respectively) after editing has occurred.

1. After editing takes place in the “Notes” text object, this method is invoked, and it
responds by resetting the notes instance variable of the ToDoltem with the
contents of the text object.

2. If the object behind the notification is the hour or minute field of the
“Notifications” display, controlTextDidEndEditing: computes the new due time,
sets the current item to have this new value, and then sends updateMatrix to the
document controller to have it display this new time. (This code is almost the
same as that for the AM-PM matrix in the switchChecked: method.)
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10 Synchronize the items displayed
in the document with the
inspector.

Open ToDoDoc.m.
Import ToDolnspector.h.

Add the code atrighttothe end of
the controlTextDidEndEditing:
method.

Post identical notifications in the
other ToDoDoc methods listed in
the table below.

In ToDoDoc.h declare as extern
the string constant
ToDoltemChangedNotification.

In ToDoDoc.m, declare and
initialize the same constant.

3. If the object behind the notification is the “Other...hours” text field in the
“When to Notify” box, the method verifies that the “Other” switch is
checked and, if it is, sets the ToDoltem with the new value.

4. Here is another empty rescheduling block of code that you can fill out in a
later exercise.

Now it’s time to address two related problems in synchronizing displays of data.
"The first is the requirement for the inspector to display the ToDoltem currently
selected in the document. In TeDoDoc.m write code that communicates this object
to ToDolnspector through notification.

id curItem;
VAN ¥

if {curItem = [currentltems cbjectAtIndex:row]) {

1f (![curItem isKindOfClass:[ToDoltem class]l)
curltem = nil;

[[NSNotificationCenter defaultCenter] postNotificationName:

' ToDoItemChangedNotification object:curItem
userInfo:nil]};

The controlTextDidEndEditing: method is where ToDoltems are added, removed, or
modified, so it’s especially important here to let ToDolInspector know when
there’s a change in the current ToDoltem. The fragment of code above gets the
current item (row holds the index of the selected row); if the returned objectisn’t
a ToDoltem, curltem is set to nil. Then the code posts a
ToDoltemChangedNotification, passing in curltem as the object related to the
notification.

Post an identical notification in other ToDoDoc methods that select a
ToDoltem or that require the removal of the currently displayed ToDoltem
from the inspector’s display. In methods of this second type, there is no need to
get the current item because the object argument of the notification should
always be nil. This argument is eventually passed to "ToDolnspector’s
updatelnspector:, to which nil means “clear the display.”

Other Methods Posting Notifications to ToDolnspector object: Argument
calendarMatrix:didChangeToDate: nil
calendarMatrix:didChangeToMonth:year: nil
windowShouldClose: (for both “Save” and “Close”) nil
selectionlnMatrix: current item or nil

175



Chapter 4

To Do Tutorial

Open the inspector panel when
users choose the Inspector
command.

Implement ToDoController's
showlnspector: method to load
ToDolnspector.nib and make the
inspector panel the key window.

Update the document and
inspector to display initial
values.

In ToDoDoc.m, implement
selectlitem:.

Invoke this method at the
appropriate places (see below).

The use of notifications to
communicate changes in one
object to another object in an
application is a good design
strategy because it removes the
need for the objects to have
specific knowledge of each other.
It also makes the application
more extensible, because any
number of objects can also
become observers of the changes.
However, there is a way for
ToDoDoc to locate
ToDolnspector reliably using the
various relationships established
within the program framework.
See page 189 to see how this is
done.
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The second data-synchronization problem involves the selection and display of
initial values in the document and the inspector when the user:

® Opens the inspector
® Opens a document
e Selects a new day from the calendar

You must return to ToDoDoc.m to write code that implements this behavior.

- (void)selectItem: (int) item:

{
id thisItem = [currentItems objectaAtIndex:item];
[itemMatrix selectCellAtRow:item column:0];

if (thisItem) {

if (![thisItem isKindOfClass: [ToDoItem class]]) thisItem = nil;

[ [NSNotificationCenter defaultCenter]
postNotificationName:ToDoItemChangedNotification:
object:thisItem
userInfo:nil];

The selectitem: method selects the text field identified in the argument and posts
a notification to the inspector with the associated ToDoltem as argument (or nil
if the text field is empty). Next, invoke selectltem: in these methods:

Method‘ Comment

calendarMatrix:didChangeToDate: Make it the final message, with an argument of 0 (ToDoDoc.m).

openDaoc: Invoke after opening a document, with an argument of 0
(ToDoController.m)

showlnspector: Invoke afer opening the inspector panel, passing in the index of the
selected row in the document. (ToDoController.m). Hint: Get the
current document by querying for the delegate of the main window,
then obtain the selected row from this object.

Before You Go On

Make ToDolnspector respond to the notification. Declare a notification method
named currentitemChanged: and implement it to set the current item with the object
value of the notification. Then, in init or awakeFromNib, add ToDolnspector as an
observer of the ToDoltemChangedNotification, identifying currentitemChanged:
as the method to be invoked.
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13 Format and validate the contents - (void)awakeFromNib
of inspector text fields. {

NSDateFormatter *dateFmt;
In TeDolnspector.m:

Implement awakeFromNib as [[inspNotifHour cell] setEntryType:NSPositivelIntTypel; /* 1 */
shown at right. [[inspNotifMinute cell] setEntryType:NSPositivelIntType];
dateFmt = [[NSDateFormatter alloc] /* 2 */

Implement control:isValidObject:
to ensure that users can only
enter the proper range of
numbers in the hour and minute
text fields.

initWithDateFormat:@"3%m/%d/%y" allowNaturallanguage:YES];
[[inspSchedDate cell] setFormatter:dateFmt];
[dateFmt release];
[inspPopUp selectItemAtIndex:0]; /* 3 */
[inspNotes setDelegate:self];

[[notifView contentView] removeFromSuperview]; /* 4 */
notifview = [[notifView contentView] retain];

[ [reschedView contentView] removeFromSuperview];

reschedvView = [[reschedView contentView] retain];

[ [notesView contentView] removeFromSuperview];

notesView = [[notesView contentView] retain];

[inspectorViews release];

[self newInspectorView:self];

ToDolnspector’s awakeFromNib method sets up formatters for the inspector’s
hour, minute, and date fields. It also performs some necessary “housekeeping”
tasks.

1. Sets the hour and minute fields to accept only positive integer values.

2. Creates a date formatter (an instance of NSDateFormatter) that accepts and
formats dates as (for example) “12/25/96.” After associating the formatter with
the date text-field cell, it releases it (setFormatter: retains the formatter).

3. Makes the Notification display the start-up default, using the index of the
“Notification” cell rather than its title to improve localization. Then it sets self
to be the delegate of the text object.

4. Each of the three inspector displays in the off-screen panel (inspectorViews) is
the content view of an NSBox. This section of code extracts and retains each
of those content views, reassigning each to its original NSBox instance
variable in the process. This explicit retaining is necessary because, in
newlInspectorView:, each currrent content view is released when it’s swapped
out. Once all content views are retained, the code releases the off-screen
window and invokes newlnspectorView: to put up the default display.
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‘Besides responding to events, all objects that inherit from

NSView can render themselves on the screen. They do this

- rendering through image composition and PostScript drawing.
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NSViews draw themselves as an indirect result of receiving the
display message (or a variant of display); this message is sent -
explicitly or through conditions that cause automatic display. The
display message leads to the invocation of an NSView's
drawRect: method and the drawRect: methods of all subviews of
that NSView. The drawRect: method should contain all code
needed to redraw the NSView completely.

An NSView can be automatically displayed when:
*» Users scroll it (assuming it supports scrolling).
* Users resize or expose the NSView's window.

* The window receives a display message or is automatically
updated.

» For some Application Kit objects, when an attribute changes.‘

An NSView represents a context within which PostScript drawing
can take place. This context has three components:

» Arectangular frame within a window to which drawing is

clipped.
= A coordinate system

¢ The current PosfScript graphics state

Frame and Bounds

: An NSView’s frame specifies the location and dimensions of the

NSView in terms of the coordinate system of the NSView’s‘
superview. It is a rectangle that encloses the NSView. You can

]
Frame rotated within its :
superview. <
1
]
. 1
< 1
.. . .
1 K
. K
]
1,
1,
Flipped coordinate :
system X g 0.0,00
1
1
1 Bounds origin
i (0000 " _

Location of frame
within its superview
© (200, 300}

programmatically move, scale, and rotate the NSView by
reference to its frame (setFrameOrigin:, setFrameSize:, and so
on). ' -

To draw efficiently, the NSView must have its frame rectangle
translated into its own coordinate system. This translated
rectangle, suitable for drawing, is called the bounds. The bounds
rectangle usually specifies exactly the same area as the frame
rectangle, but it specifies that area in a different coordinate
system. In the default coordinate system, an NSView's bounds is
the same as its frame, except that the point locating the frame
becomes the origin of the bounds (x = 0.0, y = 0.0). The x- and y-
axes of the default coordinate system run parallel to the sides of
the frame so, for example, if you rotate the frame the default
coordinate system rotates with it.

This relationship between frame and bounds has several
implications important in drawing and compositing.

» Each NSView's coordinate system is a transformation of its
superviewss.

* Drawing instructions don't have to account for an NSView's
location on the screen or its orientation.

* Changesin asuperview's coordinate system are propagated to
its subviews.

NSView allows you to flip coordinate systems {so the positive y-
axis runs downward) and to otherwise alter coordinate systems.

Focusing

Before an NSView can draw it must /ock focusto ensure that it
draws in the correct window, place, and coordinate system. It

locks focus by invoking NSView's lockFocus method. Focusing
modifies the PostScript graphics state by: :

* Making the NSView's window the current device

» Creating a clipping path 'éround the NSView's frame

*+ Making the PostScript coordinate system match the NSView’s

coordinate system

Atter drawing; the NSView should unlock focus (unlockFocus).
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PostScript Drawing

In OpenStep, NSViews draw themselves by sending binary-
encoded PostScript code to the Window Server. The Application
Kit and the Display PostScript frameworks provide a number of C-
language functions that send PostScript code to perform common
drawing tasks. You can use these functions in combinations to
accomplish fairly elaborate drawing.

The Application Kit has functions and constants, declared in
NSGraphics.h, for (among other things):

* Drawing, filling, highlighting, clipping and erasing rectangles
» Drawing buttons, bezels, and bitmaps
* Computing window depth and related display information

You also call OpenStep-compliant drawing routines defined in
dpsOpenStep.h. These routines (such as DPSDoUserPath()) draw
a specified path. In addition, you can call the functions declared
in psops.h. These functions correspond to single PastScript
operatars, such as PSsetgray() and PSfill().

You can also write and send your own custom PostScript code.
pswrap is a program {in /usr/bin) that converts PostScript code
into C-language functions that you can call within your
applications. ltis an efficient way to send PostScript code to the
Window Server. The following pswrap function draws grid lines:

defineps DrawGrid(float width, height, every)
5 6 div setgray
0 every width {
0 moveto 0 height rlineto stroke
} for
0 every height {
0 exch moveto width O rlineto stroke
} for
endps

Compose the function in a file with a .psw extension and add it to
the Other Source project “suitcase” in Project Builder. When you
next build your project, Project Builder runs the pswrap program,
generating an objectfile and a header file (matching the file name
of the .psw) file, and links these into the application. To use the
code, import the header file and call the function when you want
to do the drawing:

DrawGrid (5.0, 5.0, 1.0);

Compositing Images

The other technique NSViews use to render their appearance is
image compositing. By compositing (with the SOVER operator)

NSViews can simply display an image within their frame. You
usually composite an image using NSImage's
compositeToPoint:operation: {or a related method).

NSImage allows you to copy images into your user interface. It
uses various subclasses of NSImageRep to store the multiple
representations of the same image—color, grayscale, TIFF, EPS,
and so on—and chosing the representation appropriate for a
given type or display. NSImage can read image data from a
bundle {including the application’s main bundle), from the
pasteboard, or from an NSData object.

Compositing allows you to do more than simply copy images.
Compositing builds a new image by overlaying images that were
previously drawn. It's like a photographer printing a picture from
two negatives, one placed on top of the other. Various
compositing operators (NSCompositingOperation, defined in
dpsOpenStep.h) determine how the source and destination
images merge.

Source Image Destination Image

Operation Destination After

Copy Source image overlays
Source image wherever

Source it is opaque, and

Over destination image
elsewhere.
Destination image

R wherever it is opaque but

CD)ﬁ":ft'nat'on source image is

transparent, and

transparent elsewhere.

You can achieve interesting effects with compositing when the
initial images are drawn with partially transparent paint.
(Transparency is specified by coverage, a PostScript indicator of
paint opacity.) In a typical compositing operation, paint that's
partially transparentwon't completely cover the image it's placed
on top of; some of the other image will show through. The mare
transparent the paint is, the more of the otherimage you'll see.
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If you want an object that draws itself differently than any other
Application Kit object, or responds to events in a special way, you
should make a custom subclass of NSView. Your.custom subclass
should complete at [east the steps outlined below.

Note: If youmake a custom subclass of any class thatinherits from
NSView, and you want to do custom drawing or event handling,
the basic procedure presented here still applies.

Interface Builder

1 Define a subclass of NSView in Interface Builder, Then
generate header and implementation files.

2 Drag a CustomView object from the Views palette onto a
window and resize it. Then, with the CustomView object still
selected, choose the Custom Class display of the Inspector
panel and select the custom class. Connect any outlets and
actions. .

Custom Views Inspector

Initializing Instances

initialized instance of self. The argument of this method is th
frame rectangle of the NSView, usually as set in Interface

Builder (see step 2). You might want to drsplay the custom view

at thrs pornt

“-» Call C functions that correspond to srngle PostScnpt

3 Override the designated initializer, initWithFrame: to return an

Handling Events

In the next section, you'll make a subclass of NSButtonCell that
uniquely responds to mouse clicks. The way custom NSViews
handle events is different. If you intend your custom NSView to
respond to user actions you must do a couple of things:

4 Override acceptsFirstResponderto return YESifthe NSView
to handle selections. (The default NSView behavioris to return
NQ;) e

5 Overrrdethe desrred NSResponder eventmethods
(mouseDown:, mouseDragged keyDown etc.)

- (void)mouseDown: (NSEvent, *)event {
if (([event modifierFlags] &
NSControlKeyMask) {
doSomething () ;
} ' e
You can query the NSEvent argument for the location of the user

action in the window, modifier keys pressed, character and key
codes, and other rnformatlon G g

Drawing

When you send drsplay toan NS\few its drawRect method and‘
each of its subview's drawRect: are invoked. This metho is I
where an NSView renders its appearance e

6 Override drawRect. The argument is usuallythe frame :
rectangle in which drawing is to accur. This tells the Window
Server where the NSView's coordinate system is located. To
draw the NSView, you can do one or more of the followin

. Composrte an NSI

o Call Applrcatron Kit functrons suchas NSRectFrIII) and
NSFrameRect () {NSGraphics.h). g

~ operations, such as PSsetgray() and PSﬁII()

~-Call custom rawrng functrons created with pswrap.

Guide to Drawing and Compositing’
re rnformatron on drawing techmques and requiremen
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Subduss Exumple: Overriding and Adding Behavior (ToDoCell)

Buttons in the Application Kit are two-state controls. They have two—and only
two—states: 1 and 0 (often expressed as Boolean YES and NO, or ON and
OFF). For the To Do application, a three-state button is preferable. You want
the button to indicate, with an image, three possible states: notDone (no image),
done (an “X”), and deferred (a check mark). These states correspond to the
possible statues of a ToDoltem.

The ToDoCell class, which you will implement in this section, generates cells
that behave as three-state buttons. These buttons also display the time an item
is due.

:&?5?:5?@ ]— Time item is due.

The superclass of ToDoCell is NSButtonCell. In creating ToDoCell you will
add data and behavior to NSButtonCell, and you will override some existing
behavior.

Item status.

Why Chose NSButtonCell as Superclass?

ToDoCell's superclass is NSButtonCell. This

choice prompts two questions:
¢ Why a button cell and notthe button itself?
« Why this particular superclass?

NSCell defines state as an instance variable,
and thus all cells inherit it. Cells instead of
controls hold state information for reasons of
efficiency—aone control (a matrix) can
manage a collection of cells, each cell with
its own state setting. NSButton does provide
methods for getting and setting state values,:
but it accesses the state value of the cell
{usually NSButtonCell} that it contains.

NSButtonCell is ToDoCell's superclass
because button cells already have much of
the behavior you want. By virtue of
inheritance from NSActionCell, button cells
can hold target and action information.
Button cells also have the unique capability
to display an image and text simultaneously.
These are all aspects of behavior needed for
ToDoCell.

When you think that you need a specialized
subclass of an OpenStep class, you should
first spend some time examining the header
files and reference documentation on not
only that class, but its superclasses and any

“sibling” classes.
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Add header and implementation
files to the project.

Chose New in Project from the
File menu.

Inthe New File In ToDo panel,
select the Class suitcase, click
Create header, type “ToDoCell”
after Name, and click OK.

Complete ToDoCell.h.
Make the superclass

NSButtonCell.

Add the instance-variable and
method declarations shown at
right.

Add the enum constants for state
values {as shown).

Initialize the allocated ToDoCell
instance (and deallocate it).

Select ToDoCell.m in the project
browser.
Implement init as shown at right.

Implement dealloc.
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"enum _ToDoButtonStétew{ﬁotDone=0} done, defeired} ToDoButtonStaEé}

@interface ToDoCell : NSButtonCell
{ -G
ToDoButtonState triState;

NSImége *doneImage, *deferredImage;
NSDate *timeDue;

- (void)setTriState: (ToDoButtonState)newState;
- (ToDoButtonState)triState;

(void)setTimeDue: (NSDate *)newTime;

(NShate *)timeDue;b

@end

The triState instance variable will be assigned "ToDoButtonState constants as
values. The NSImage variables hold the “X” and check mark images that
represent statuses of completed and deferred (that is, rescheduled for the next
day). The timeDue instance variable carries the time the item is due as an
NSDate; for display, this object will be converted to a string,

- (id)init
{
NSString *path;
[super initTextCell:@""];

triState = notDone; i

[self setType:NSToggleButton]; /* 1%/
[self setImagePosition:NSImageLeft];

[self setBezeled:YES];

[self setFont:[NSFont userFontOfSize:12]];

k[self setAlignment :NSRightTextAlignment];

/* 2 */
path = [[NSBundle mainBundlel pathForImageResource:@"X.tiff"];
doneImage = [[NSImage alloc] initByReferencingFile:path];

path = [[NSBundle mainBundle]
pathForImageResource:@"checkMark.tiff"]; ;
deferredImage = [[NSImage alloc] initByReferencingFile:pathl];

return self;

1. Sets some superclass (NSButtonCell) attributes, such as button type, image and
text position, font of text, and border.

2. Through NSBundle’s pathForlmageResource:, gets the pathname for the cell
images and creates and stores the images using the pathname.
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Implementthe accessor methods
related to state.

Write the methods that get and
set the triState instance variable.

Override the superclass methods
that get and set state.

- {void)setTriState: (ToDoButtonState)newState /* 1 */
{
if (newState == deferred+l)
triState = notDone;
else

triState = newState;
[self _setImage:triState];

- (ToDoButtonState)triState {return triState;}

- (void)setState: (int)val /* 2 */
{
}
- (int)state /* 3 %/
{

if (triState == deferred)

return (int)done;
else
return (int)triState;

Accessing state information is a dual-path task in ToDoCell. It involves not only
setting and getting the new state instance variable, triState, but properly handling
the inherited instance variable by overriding the superclass accessor methods for
state.

1. If the new value for triState is one greater than the limit (deferred), reset it to zero
(notDone); otherwise, assign the value. The reason behind this logic is that (as
you’ll soon learn) when users click a ToDoCell, setTriState: is invoked with an
argument one more than the current value. This way users can cycle through the
three states of ToDoCell.

2. Overrides setState: to be a null method. The reason for this override is that
NSCell intervenes when a button is clicked, resetting state to zero (NO).
This override nullifies that effect.

3. Overrides state to return a reasonable value to client objects that invoke this
accessor method.
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Set the cell image.

Declare the private method
_setlmage:.

Implement the _setimage:
method.

184

@interface ToDoC

(PrivateMethods)

-~ (void)_s (ToDoButtOnState)aState} VA
@end ' i ! :
/* oLoo %/ : : -
- (void)_setImage: (ToDoButtonState)aState
switch(asState) { /* 2 */
‘case notDone: {
[self setImage:nil];
break; :
}
case done: { e
[self setImage:doneImage]; 
break;
}
case deferred: ({
[self setImage:deferredImage];
break;
.
}
[ (NSControl *) [self controlvView] updateCell:self]; /* 3 %/

This portion of code handles the display of the cell’s image by doing the
following;

L.

In a category of ToDoCell in ToDoCell.m, it declares the private method _setimage:.
Private methods, which by convention begin with an underscore, are methods that
you don’t want clients of your object to invoke. In this case, you don’t want the
image to be set independently from the cell’s triState value.

. In a switch statement, evaluates the tri-state argument and sets the cell’s

image appropriately (setlmage: is an NSButtonCell method).

. Sends updateCell: to the control view of the cell’s control (a matrix) to force a

re-draw of the cell.
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6 Track mouse clicks ona
ToDoCell and reset state.

Override two NSCell mouse-
tracking methods as shown in this
example.

7 Getand set the time due,
displaying the time in the
process.

ImplementsetTimeDue: as shown
in this example.

Implement timeDue to return the
NSDate.

(BOOL) startTrackingAt: (NSPoint)startPoint inView:
(NSView *)controlView

return YES;

- (void)stopTracking: (NSPoint)lastPoint at: (NSPoint)stopPoint
inView: (NSView *)controlView mouselIsUp: (BOOL) flag

if (flag == YES) {
[self setTriState:([self triStatel+1)];

When you create your own cell subclass, you might want to override some
methods that are intrinsic to the behavior of the cell. Mouse-tracking methods,
inherited from NSCell, are among these. You can override these methods to
incorporate specialized behavior when the mouse clicks the cell or drags over it.
ToDoCell overrides these methods to increment the value of triState.

¢ Overrides startTrackingAtinView: to return YES, thus signalling to the control
that the ToDoCell will track the mouse.

* Overrides stopTracking:atinView:mouselsUp: to evaluate flag and, if it’s YES, to
increment the triState instance variable. (The setTriState: method “wraps” the
incremented value to zero (notDone) if it is greater than 2 (deferred)).

- (void)setTimeDue: (NSDate *)newTime
{
if (timeDue)
[timeDue autorelease];
if (newTime) {
timeDue = [newTime copyl;
[self setTitle:[timeDue descriptionWithCalendarFormat:
@"%$I:%M %p" timeZone:[NSTimeZone localTimeZone]
locale:nil]];
}
else {
timeDue = nil;
[self setTitle:@"-->"];

The setTimeDue: method is similar to other “set” accessor methods, except thatit
handles interpretation and display of the NSDate instance variable it stores. If
newTime is a valid object, it uses NSDate’s
descriptionWithCalendarFormat:timeZone:locale: method to interpret and format the
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8 Atlaunchtime, create and install
your custom cells in the matrix.

Select ToDoDoc.m in the project
browser.

Insert the code at right in
awakeFromNib.

9 Respond to mouse clicks on the
matrix of ToDoCell’s.

In ToDoDoc.m, implement
itemChecked.:.
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date object, then displays the result with setTitle:. If newTime is nil, no due time has
been specified, and so the method sets the title to “-->".

You’ve now completed all code required for ToDoCell. However, you must now
“install” instances of this class in the To Do interface.

- (void)awakeFromNib
{
int i;
/* ... */
i = [[markMatrix cells] count];
while (i--) {
ToDoCell *aCell = [[ToDoCell alloc] init];
[aCell setTarget:self];
[aCell setAction:@selector(itemChecked:)];
[markMatrix putCell:aCell atRow:i column:0];
[aCell release];

‘This block of code substitutes a ToDoCell for each cell in the left matrix
(markMatrix) you created for the To Do interface. It creates a ToDoCell, sets its

target and action message, then inserts it into the markMatrix by invoking
NSMatrix’s putCell:atRow:column: method.

Finally, you must implement the action message sent when the matrix of
ToDoCells is clicked. (This response to mouse-down is for objects external to
ToDoCell, while the mouse-tracking response sets state internally.)

- (void)itemChecked:sender
{

int row = [sender selectedRow];

ToDoCell *cell = [sender cellAtRow:row column:0];

if (cell && [currentItems count]) {

id‘item = [currentItems objectAtIndex:rowl;
if (item && [item isKindofClass:[ToDoItem class]]) {

i ~ [item setItemStatus:[cell triState]l];
- [[sender window] setDocumentEdited:YES];

This method gets the ToDoCell that was clicked and the object in the
corresponding text field. If that object is a ToDoltem, the method updates its
status to reflect the state of the ToDoCell. It then marks the window as
containing an edited document.
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Setting Up Timers for Notification Messages

Add the timer as an instance
variable to ToDoltem.
Open ToDoltem.h.

Add the instance variable
itemTimer of class NSTimer.

Write accessor methods to get
and set this instance variable.

Create and set the timer, or
invalidate it.

Open ToDoDoc.m.

Implement the setTimerForltem:

method, which is shown at right.

The To Do application includes as a feature the capability for notifying users of
items with impending due times. Users can specify various intervals before the
due time for these notifications, which take the form of a message in an attention
panel. In this section you will implement the notification feature of To Do. In

the process you’ll learn the basics of creating, setting, and responding to timers.

Here’s how it works: Each ToDoltem with a “When to Notify” switch (other
than “Do not notify”) selected in the inspector panel—and hence has a positive
secsUntilNotif value—has a timer set for it. If a user cancels a notification by
selecting “Do not notify,” the document controller invalidates the timer. When
a timer fires, it invokes a method that displays the attention panel, selects the
“Do not notify” switch, and sets secsUntilNotif to zero.

Implementing the timer feature takes place entirely in Project Builder, but
extends across several classes.

- (void)setTimerForItem: (ToDoItem *)anItem
{
NSDate *notifDate;
NSTimer *aTimer;
if ([anItem secsUntilNotifl) {
notifDate = [[anItem day] addTimeInterval:[anItem
secsUntilNotifll;
aTimer = [NSTimer scheduledTimerWithTimeInterval:
[notifDate timeIntervalSinceNow]
target:self
selector:@selector(itemTimerFired:)
userInfo:anItem
repeats:NO]J ;
[anItem setItemTimer:aTimer];
} else . 5
[[anItem itemTimer] invalidate];

/*1x/

/* 2 x

/* 3 */

This method sets or invalidates a timer, depending on whether the ToDoltem
passed in has a positive secsUntilNatif value.

1. Tests the ToDoltem to see if it has a positive secsUntilNotif value and, if it has,
composes the time the notification should be sent.

2. Creates a timer and schedules it to fire at the notification time, and instructs
it to invoke itemTimerFired: when it fires. It also sets the timer in the ToDoltem.

3. If the secsUntilNotif variable is zero, invalidates the item’s timer.
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Respond to timers firing.

Implement itemTimerFired: as
shown at right.
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(vo inéémTimerEifea;&idftimer

ﬁ, @"%@ on %@", nll

. ‘ultemName],k[dueDate : L ;
descrlptlonW1thCalendarFormat @"%b %4, Y at %
tlmeZone [NSTimeZone" defaultTlmeZ f
[anTtem setSechntllNotlf 0]: -

[1nspControlle’;resetNot;f witchl;

When a ToDoltem’s timer goes off, it invokes the itemTimerFired: method
(remember, you designated this method when you scheduled the timer).

1. This method communicates with ToDolInspector in a more direct manner than
notification. It gets the ToDolInspector object through this chain of association: the
delegate of the application object is ToDoController, which holds the id of the
inspector panel as an instance variable, and the delegate of the inspector panel is
ToDolnspector.

2. Composes the notification time (as an NSDate), beeps, and displays an
attention panel specifying the name of a ToDoltem and the time it is due. It
then sets the ToDoltem’s secsUntilNotif instance variable to zero, and sends
resetNotifSwitch to ToDolnspector to have it reset the “When to Notify”
switches to “Do not Notify.”

Before You Go On

Implement resetNotifSwitch: You haven’t written ToDolnspector’s resetNotifSwitch
method yet, so do it now as an exercise. It should select the “Do not Notify”
switch after turning off all switches in the matrix, and then force a redisplay of
the switch matrix.

Next you must send setTimerForltem: at the right place and time, which is
ToDolnspector, when the user alters a “When to Notify” value.



Setting Up Timers for Notification Messages *

4 Send the message that sets the
timer at the right times

[[[NSApp mainWindow] delegate] setTimerForItem:currentItem];

Open ToDolnspector.m. . . . .
P P Instead of archiving an item’s NSTimer, To Do re-creates and resets it when the

In switchChecked:, insert the application is launched.

setTimerForltem: message at

right afterthe switch statement
evaluating which “When to if ([self activeDaysl) {
Notify” switch was checked.

In controlTextDidEndEditing:,

dayenum = [[self activeDays] keyEnumerator];
while (itemDate = [dayenum nextObjectl]) {

insert the same message at the
end of the block related to the
inspNotifOtherHours variable.

When the application is
launched, reset item timers.

Add the code at right, below, to

ToDoDoc’s initWithFile: method.

NSEnumerator *itemenum;

ToDoItem *anItem=nil;

NSArray *itemArray = [[self activeDays]

objectForKey:itemDate] ;

itemenum = [itemArray objectEnumerator];

while ((anItem = [itemenum nextObject]) &&
[anItem isKindOfClass:[ToDoItem class]] &&
[anTtem secsUntilNotif]) {

[self setTimerForItem:anltem];

This block of code traverses the activeDays dictionary, evaluating each ToDoltem
within the dictionary. If the ToDoltem has a positive secsUntilNotif value, it
invokes setTimerForltem: to have a timer set for it.

Tick Tock Brrrring: Run Loops and Timer

A run loop—an instance of NSRunLoop—
manages and processes sources of input.
These sources include mouse and keyboard
events from the window system, file
descriptor, inter-thread connections
(NSConnection), and timers {NSTimer).

Applications typically won't need to either
create or explicitly manage NSRunLoop
objects. When a thread is created, an
NSRunLoop object is automatically created
for it. The NSApplication object creates a

- default thread and therefore creates a
‘default run loop.

NSTimer creates timer objects. A timer
object waits until a certain time interval has

elapsed and then fires, sending a specified
message to a specified object. For example,
you could create an NSTimer that
periodically sends messages to an object,
asking itto respond if an attribute changes.

NSTimer objects work in conjunction with
NSRunLoop objects. NSRunLoops control
loops that wait for input, and they use
NSTimers to help determine the maximum
amount of time they should wait. When the
NSTimer's time limit has elapsed, the
NSRunLoop fires the NSTimer (causing its
message to be sent), then checks for new
input.
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Build, Run, and Extend the Application
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Although you probably have been building the ToDo project frequently now, as
it’s been taking shape, build it one more time and check out what you have
wrought. Go through the following sequence and observe To Do’s behavior.

1. When you choose New from the Document menu, the application creates a new
To Do document and selects the current day.

2. Enter a few items. Click a new day on the calendar and enter a few more
items. Click the previous day and notice how the items you entered reappear.

3. Choose Inspector from the main menu. When the inspector appears, click an
item and notice how the name and date of the item appears in the top part of
the inspector. Enter due times for a couple items, and some associated notes.
Note how the times, as you enter them, appear in the Status/Due column of
the To Do document. Click among a few items again and note how the
Notifications and Notes displays change. ‘

4. Click a Status/Due button; the image toggles among the three states. Then,
with an item that has a due time, select a notification time that has already
passed. The application immediately displays an attention panel with a
notification message. When you dismiss this panel, To Do sets the
notification option to “Do not notify.”

5. Click the document window and respond to the attention panel by clicking
Save. In the Save panel, give the document a location and name. When the
window has closed, chose Open from the Document menu and open the
same document. Observe how the items you entered are redisplayed.

Optional Exercises

You should be able now to supplement the To Do application with other
features and behaviors. Try some of the following suggestions.

Make Your Own Info Panel

Make your own Info panel. Define a method that responds to a click on the Info
panel button by loading a nib file containing the panel. The owner of the panel
can be the application controller. You can customize this panel however you
wish. For instance, put the application icon in a toggled button (the main image)
and make the alternate image a photo (yourself, your significant other, your
dog). When users click the button, the image changes between the two.



Build, Run, and Extend the Application

Implement Application Preferences

Make a Preferences panel for the application, with a new controller object (or
the application controller) as the owner of the nib file containing the panel.
Follow what you’ve done for ToDolnspector, especially if the panel has
multiple displays. Some ideas for Preferences: how long to keep expired
ToDoltems before logging and purging them (see below); the default document
to open upon launch; the default rescheduling interval (see below). Store and
retrieve specified preferences as user defaults; for more information, see the
NSUserDefaults specification.

Implement Rescheduling

ToDo’s Inspector pane has a Rescheduling display that does almost nothing
now. Implement the capability for rescheduling items by the period specified.

Implement Logging and Purging

After certain period (set via Preferences), append expired ToDoltems (as
formatted text) to a log, and expunge the ToDoltems from the application.

191



Chapter 4 To Do Tutorial

192



Chapter 5
Where To Go From Here

£ it e .







Sections

World Wide Web

Programming Tools and
Resources

Information
Professional Services

Ordering NeXT Products and
Services

Chapter 5

Where To Go From Here

195



Where To Go From Here

196



If you’ve completed the tutorials in this book, you’re no longer a novice in
OpenStep development. You should be able to attempt an OpenStep
application on your own, and should expect to carry it off successfully. However,
there is much more for you to learn (or to learn in greater detail). There will
probably be times when you’ll need information or help. You might want to
pursue a training course, you might want to order a NeX'T product, or you might
have questions you’ll need answered, or problems you’ll need resolved.

This section points you toward these sources of information and help. It also
includes descriptions of tools, resources, and documentation frequently used in
application development.

World Wide Web

NeXT’s corporate home page is at: hitp://www.next.com.

From there you can navigate to summaries of products, such asWebObjects®,

Enterprise Objects Framework®, and D’OLE®—and order the products on-
line. You can learn about NeXT programs in education, consulting and technical
support. You can also use the NeXTanswers document retrieval system. For
WebObjects, you can download versions of the product, try out demonstration
WebObjects applications, and access related documentation.
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Programming Tools and Resources

Other Development Applications

OPENSTEP Developer for Mach includes applications other than Project
Builder and Interface Builder. Except where noted, these applications are
installed in /NextDeveloper/Apps.

Name Description

FileMerge Visually compares the contents of two files or two directories. You can use
FileMerge, for example, to determine the differences between versions of the
same source code file or between two project directories. You can also use it
to merge changes.

MallocDebug Measures the dynamic-memory usage of applications, finds memory leaks,
analyzes all allocated memory in an application, and measures the memory
allocated since a given time.

IconBuilder A simple graphics program for creating application and documenticons.
Yap A utility for editing and previewing PostScript code.
Sampler Analyzes performance problems with your application by sampling the call

stack of your program over a period. {In /NextDeveloper/Demos)

Other Installed Frameworks

A framework contains a dynamic shared library, related header files, and
resources (including nib files, images, sounds, documentation, and localized
strings) used by the library. All frameworks are installed in /NextLibrary/Frameworks.
OPENSTEP Developer for Mach provides these other frameworks in addition
to the Application Kit and the Foundation frameworks:

Name Description

System Operating-system and low-level Objective-C runtime APIs

SoundKit Sound recording, playback, and editing capabilities.

InterfaceBuilder Creation of custom static (compiled) palletes for use in Interface Builder
NEXTIME Real-time video imaging

NIAccess Netinfo’s access layer

NiInterface Netinfo's interface layer
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Useful Command-Line Tools

NeXT has created or modified several tools for compilation, debugging,
performance analysis, and so on. The following table lists some of the more
useful of these tools. You can get further information using the man pages
system.

Name Description Location

cc Compiles C, Objective-C, C++, and Objective-C++ /bin
source code files.

gdb Source-level symbolic debugger for C, extended by /bin
NeXT to support Objective-C, C++, Mach, Windows NT,
and (by late 1996) Windows 95.

gnumake Utility for making programming projects. /bin
as Assembler; translates assembly code into object code. /bin
defaults Reads, writes, searches, and deletes user defaults. fusr/bin

The defaults system records user preferences that
persist when the application isn't running. When users
specify defaults in an application’s Preferences panel,
NSUserDefaults methods are used to write the defaults.

pswrap Creates C functions that “wrap” PostScript code and  /usr/bin
send it to the Window Server for interpretation.

nibTool Reads the contents of an Interface Builder nib file. Jusr/bin
Prints classes, the hierarchy, objects, connections, and
localizable strings.

libtool Creates static or dynamic libraries from specified
object bin files for one or multiple architectures.

otool Displays specified parts of object files or libraries. /bin

nm Displays the symbol table, in whole or in part, of the /bin
specified object file or files.

oh Records allocation and deallocation events. Jusr/bin
» AnalyzeAllocation Analyzes program memory allocation. [usr/bin
fixPrecomps Creates a precompiled header file for each of the major /usr/bin
frameworks.
strip Removes or modifies the symbol table attached to /bin

assembled and linked output.

lipo Creates, lists, and manipulates multi-architecure /bin
objectfiles
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Converting NEXTSTEP Code to OPENSTEPp

You can take advantage of an automated conversion process to convert
NEXTSTEP® Release 3.x code to OPENSTEP Release 4.0. By completing
this process you’ll make your application an OpenStep application (that is, an
application conforming to the OpenStep specification). An OpenStep
application—one without any specific operation-system dependencies—
should run on any OpenStep system.

The TOPS scripts you run to perform the conversion process, along with 3.3
header files and intermediate frameworks, are located at ‘
/NextDeveloper/OpenStepConversion. The OPENSTEP Conversion Guide provides
instructions on using the scripts as well as summaries of API changes and
conversion tips. '

Other Programming Resources

You can find programming resources—such as fonts, sounds, and palettes—in
various subdirectories of /NextLibrary.

Name Comments

SystemResources Character-set information and location of headers for automatic
precompilation (fixPrecomps)

Colors Bundles containing the default set of color binaries for the Colors panel
Fonts Default set of system fonts, including AFM, bitmap, and outline versions
PS2Resources PostScriptfiles containing calibrated color space and color rendering, printing

halftones, and gray-shading patterns

Rulebooks Glyph generators for various string encodings

Sounds Default sound files (“.snd”) such as Cricket, Ping, and Rooster




Information

Information

For more information on Digital
Librarian and on other means for
accessing documentation , see
“Where To Go For Help” on
page 54.

For details of using the Project
Find panel, see “Finding
Information Within Your Project”
on page 94.

NeXT publishes documentation for users, developers, and system
administrators. It also, through its Professional Services, offers customers access
to NeXTanswers, an automated document retrieval system.

To order documentation, call 1-800-TRY-NEXT.

Accessing Documentation
On OPENSTEP for Mach, several tools help you access documentation:

¢ Digital Librarian’s NextDeveloper bookshelf includes most of the documents
described in “Developer Documentation” below, as search targets. This
bookshelf, which located at /NextLibrary/Bookshelves, also includes instructions
for creating your own custom bookshelf.

¢ In Project Builder, you can use the Project Find panel to display reference
documentation on classes, protocols, methods, functions, and other types.

¢ In Project Builder or in a Terminal window, you can issue commands to
UNIX’s man pages system to display information on command-line tools.

Developer Documentation

The core set of documentation for OPENSTEP is the reference specifications
describing OpenStep classes, protocols, methods, functions, types, and
constants. The reference documentation for the two major OpenStep
frameworks is stored within the frameworks:

/NextLibrary/Frameworks/AppKit.framework/Resources/English.Iproj/Documentation
/NextLibrary/Frameworks/Foundation.framework/Resources/English.Iproj/Documentation

Several documents—some printed but most only in on-line form—supplement
this core set of documentation. The following table describes these materials

directly related to OPENSTEP for Mach; all documents are located at
/NextLibrary/Documentation/NextDev
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NeXT’s Professional Services
also distributes OpenStep
programming information
through NeXTanswers, an
automated decument retrieval

system. See page 204 for details.
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Book/Document Description /NexDev Directory
Object-Oriented Title says it all TasksAndConcepts
Programming and the (as ObjectiveC)

Objective-C Language

OPENSTEP Development. Using Project Builder, Interface Builder, and other  TasksAndConcepts
Tools and Techniques tools in program development (as DevEnvGuide)

Programming Topics Contains conceptual background and step-by-step  TasksAndConcepts
instructions for common programming tasks.
(Note: the numbered of covered topics will grow in
the months following release 4.0.)

General Reference Display PostScript reference documentation plus Reference
information pertinent to all OpenStep frameworks

Release Notes Current release notes on frameworks, development ReleaseNotes
applications, and tools

Other Developer Documentation

If you’ve installed Enterprise Objects Framework or Portable Distributed
Objects documentation for these products will also be installed in
NextLibrary/Documentation/NextDev 'T'his includes the API reference and Developer’s
Guide for Enterprise Objects Framework.

You will also find third-party documentation installed in
/NextLibrary/Documentation, including reference documentation for the GNU
libg++ (C++) library.

System Administration Documentation

Documentation for system administrators of OPENSTEP for Mach networks
can find a helpful manual in /NextLibrary/Documentation/NextAdmin. This manual
describes planning and setting up networks, as well as the creation of user
accounts. It also explains details of NFS, discusses administrative tasks such as
backups and security, and provides troubleshooting guidelines.

In /NextLibrary/Documentation, you’ll also find back issues of the magazine for
system administrators, NEXTSTEP In Focus.



Professional Services

Professional Services

NeXT provides training, consulting, and technical support for its customers. For
more information on the programs described below, call 1-800-955-NEXT
(U.S.), +1 415-780-2922 (elsewhere in North America), +44 181-565-0005
(Europe). You can also visit the Professional Services section of the NeXT
website at http://www.next.com/Services for up-to-date information on current
programs in technical education, consulting, and support.

Education

Courses offered by NeXT’s Training department give developers of all
backgrounds a strong foundation in the fundamentals of OpenStep application
development. This background is critical to the successful implementation of
OpenStep programs by development teams.

Customers can choose from three training formats:

¢ Open enrollment classes, held at NeX'I”s training facilities in Redwood City,
Washington, D.C., and Chicago

e On-site classes at the customer’s location

e On-site Object Learning Solutions, which over periods of several weeks
provide customers with training and tailored development of skills.

Object Expert Consulting

The Object Expert program assigns an expert in OpenStep development to
assist customers in their projects on a full-time basis. The committment can be
from two months to as many months as necessary. The Object Expert can help
with developing a prototype (including project planning, requirements,
integration, and testing) or can provide analysis, design, planning, programming,
integration, and testing expertise for full-fledged application-development
projects.

Software Maintenance and Technical Support

With the Software Maintenance program customers can get one copy of each
covered release of software and documentation as well as major and minor
software upgrades. They can select from four levels of technical support and
software maintenance offered by NeX'T.

Support includes a range of offerings, from installation assistance to
NeXTanswers. Developers receive debugging assistance and problem
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investigation, memory management and performance tuning, portability advice,
and help with converting NEXTSTEP code to OpenStep. System
administrators can obtain help with problems related to network connectivity,
Netlnfo domain requirements analysis and implementation, hardware selection

and configuration questions, and other areas.

NeXTanswers

NeXTanswers is an automated retrieval system that gives customers access to
the latest product information, technical documents, drivers, and other software.
You can access NeXTanswers through NeX'T"’s website (http://www.next.com) and
by:

* Electronic mail: Send requests to nextanswers@next.com with a subject line of
HELP to receive instructions on how to proceed.

® Fax: Call 415-780-3990 from a touch-tone phone and follow instructions
(you’ll need to know the ID numbers of the files you want).

¢ Anonymous FTP: Connect to FTRNEXT.COM and read
pub/NeXTanswers/README for further instructions.

¢ BBS: Call 415-780-2965, log in as “guest”, and go to the Files section. From
there you can download NeXTanswer documents.

Requests sent to NeXTanswers are answered electronically, and are not read or
handled by a person. It does not answer your questions or forward your requests.



Ordering NeXT Products and Services

Ordering NeXT Products and Services

To order NeX'T products and services, you can:
1. Call 1-800-TRY-NEXT (U.S. only); a sales representative will assist you.
2. Send electronic mail to trynext@next.com.

3. Fill out the on-line form on the World Wide Web at
http://www.next.com/AboutNext/Feedback.html and a sales representative will
promptly contact you.

4. Contact one of the sales offices below, which can also furnish you with
product brochures, data sheets, and other information.

Worldwide Headquarters

900 Chesapeake Drive
Redwood City, CA 94063
Tel: (415) 366-0900

Fax: (415) 780-3714

North American Field Sales Offices

Washington DC Office

1650 Tysons Boulevard, Suite 650
McLean, VA 22102

Tel: (703) 938-6398

Fax: (703) 506-3990

New York Office

One Park Avenue, Sixth Floor
New York, NY 10016

Tel: (212) 503-4750

Fax: (212) 503-4751

New Jersey Office

90 Washington Valley Road
Bedminister, NJ 07921
Tel: (908) 719-8905

Fax: (908) 719-8903
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Chicago Office

311 South Wacker Drive, 22nd Floor
Suite 2250

Chicago, IL 60606

Tel: (312) 697-4500

Fax: (312) 697-4501

Canadian Office

4370 Dominion Street
Suite 400

Burnaby, British Columbia
Canada V5G -4L7

Tel: (604) 451-1877

Fax: (604) 451-1819

Mexico (MeXT)
Tel: 011 525-530-7278

European and Asian Sales Offices

NeXT Computer UK Limited
"Technology House
Meadow Bank

Furlong Road:

Bourne End

Bucks

SL8 5A]

Tel:+ 44(0) 1628 535222
Fax:+44(0) 1628 535200

NeXT Computer Paris, France
Tour CBC

8rue Felix Pyat

F-92800 Puteaux la Defense
Tel: (+33) 146 93 27 82

Fax: (+33) 146 93 29 28

NeXT Software K.K. (Asia Pacific)
Tennoz Central Tower 7F
2-2-24 Higashi-Shinagawa
Shinagawa-ku, Tokyo
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140 Japan
Tel: +81-3-5461-7161
Fax: +81-3-5461-7170

NeXT Software Deutschland GmbH
Gruenwalder Weg 13a
D-82008 Unterhaching
Germany

Tel: +49 89614 5290

Fax: +49 89 614 529 12
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“Object-oriented programming” has become one of the premier buzzwords in
the computer industry. To understand why, it’s important to cut through the
hype and focus on the problem that engendered the object-oriented approach.

In classic procedural programming (used with COBOL, Fortran, C, and other
languages), programs are made of two fundamental components: daza and code.
The data represents what the user needs to manipulate, while the code does the
manipulation. To improve project management and maintenance, procedural
programs compartmentalize code into procedures. However, much of the data is
global, and each procedure may manipulate any part of that global data directly.

- procedure

With the procedural approach, the network of interaction between procedures
and data becomes increasingly complex as an application grows. Inevitably, the
interrelationships become a hard-to-maintain tangle—spaghetti code. A simple
change in a data structure can affect many procedures, many lines of code—a
nightmare for those who must maintain and enhance applications. Procedural
programming also leads to nasty, hard-to-find bugs in which one function
inadvertently changes data that another function relies on.

Objects change all that.
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An object is a self-contained programmatic unit that combines data and the

procedures that operate on that data. In the Objective-C language, an object’s
data comprises its iustance variables, and its procedures, the functions that affect
or make use of the data, are known as methods.

Like objects in the physical world, objects in a program have identifying
characteristics and behavior. Often programmatic objects are modelled on real
objects. For example, an object such as a button has an analog in the buttons on
control devices, such stereo equipment and telephones. A button object
includes the data and code to generate an appearance on the screen that
simulates a “real” button and to respond in a familiar way to user actions.

A button object highlights its on-screen representation
when the user clicks it.

Encapsulation

Just as procedures compartmentalize code, objects compartmentalize both code
and data. This results in data encapsulation, effectively surrounding data with the
procedures for manipulating that data.

"Typically, an object is regarded as a “black box,” meaning that a program never
directly accesses an object’s variables. Indeed, a program shouldn’t even need to
know what variables an object has in order to perform its functions. Instead, the
program accesses the object only through its methods. In a sense, the methods
surround the data, not only shielding an object’s instance variables but
mediating access to them:

Objects are the basic building blocks of Objective-C applications. By
representing a responsibility in the problem domain, each object encapsulates a
particular area of functionality that the program needs. The object’s methods
provide the interface to this functionality. For example, an object representing
a database record both stores data and provides well-defined ways to access that
data.



Using this modularity, object-oriented programs can be divided into distinct
objects for specific data and specific tasks. Programming teams can easily parcel
out areas of responsibility among them, agreeing on interfaces to the distinct
objects while implementing data structures and code in the most efficient way
for their specific area of functionality.

Messages

To invoke one of the object’s methods you send it a message. A message requests
an object to perform some functionality or to return a value. In Objective-C, a
message expression is enclosed in square brackets, like this:

celsius = [converter convertTemp:fahrenheit]
\ﬂ_l \ ~ J \ ~ J . > J
returned value receiver method name argument

In this example converter is the object that receives the message, the receiver.
Everything to the right of this term is the message itself; it consists of a method
name and any arguments the method requires. The message received by
converter tells it to convert a temperature in Fahrenheit to Celsius and return that
value.

- In Objective-C, every message argument is identified with a label. Arguments
follow colon-terminated 4eywords, which are considered part of the method
name. One argument per keyword is allowed. If a method has more than one
argument—as NSString’s rangeOfString:options: method does, for example—
the name is broken apart to accept the arguments:

range = [string rangeOfString:@”OPENSTEP” options:NSLiteralSearch];

Often, but not always, messages return values to the sender of the message.
Returned values must be received in a variable of an appropriate type. In the
above example, the variable range must be of type NSRange. Messages that
return values can be nested, especially if those returned values are objects. By
enclosing one message expression within another, you can use a returned value
as an argument or as a receiver without having to declare a variable for it.

newString = [stringOne stringByAppendingString:
[substringFromRange: .
[stringTwo rangeOfString:@”OPENSTEP” at:NSAnchoredSearch]]];

The above message nests two other messages, each of which returns a value
used as an argument. The inmost message expressions is resolved first, then the
next nested message expression is resolved, then the third message is sent and
a value is returned to newString.
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An Object-Oriented Program

Object-oriented programming is more than just another way of organizing data
and functions. It permits application programmers to conceive and construct
solutions to complex programs using a model that resembles—much more so
than traditional programs—the way we organize the world around us. The
object-oriented model for program structure simplifies problem resolution by
clarifying roles and relationships.

You can think of an object-oriented program as a network of objects with well-
defined behavior and characteristics, objects that interact through messages.

—> Messages

Different objects in the network play different roles. Some correspond to
graphical elements in the user interface. The elements that you can drag from
an Interface Builder palette are all objects. In an application, each window is
represented by a separate object, as is each button, menu item, or display of text.

Applications also assign to objects functionality that isn’t directly apparent in the
interface, giving each object a different area of responsibility. Some of these
objects might perform very specific computational tasks while others might
manage the display and transfer of data, mediating the interaction between
user-interface objects and computational objects.

Once you’ve defined your objects, creating a program is largely a matter of
“hooking up” these objects: creating the connections that objects will use to
communicate with each other.



The example of display highlights
the role of inheritance in
polymorphism: a subclass often
implements an identically named
method (that is, overrides the
method) of its superclass to achieve
more specialized behavior. See the
following section, “Classes,” for
details.

Polymorphism and Dynamic Binding

Although the purpose of a message is to invoke a method, a message isn’t the
same as a function call. An object “knows about” only those methods that were
defined for it or that it inherits. It can’ confuse its methods with another object’s
methods, even if the methods are identically named.

Each object is a self-contained unit, with its own name space (an name space
being an area of the program where it is uniquely recognized by name). Just as
local variables within a C function are isolated from other parts of a program, so
too are the variables and methods of an object. Thus if two different kinds of
objects have the same names for their methods, both objects could receive the
same message, but each would respond to it differently. The ability of one
message to cause different behavior in different receivers is referred to as
polymorphism.

Polymorphism

The advantage polymorphism brings to application developers is significant. It
helps improve program flexibility while maintaining code simplicity. You can
write code that might have an effect on a variety of objects without having to
know at the time you write the code what objects they might be. For example,
most user-interface objects respond to the message display; you can send display
to any of these objects in your interface and it will draw itself, in its own way.

Dynamic binding is perhaps even more useful than polymorphism. It means both
the object receiving a message and the message that an object receives can be
set within your program as it runs. This is particularly important in a graphical,
user-driven environment, where one user command—say Copy or Paste—may
apply to any number of user-interface objects.
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Dynamic Binding

In dynamic binding, a run-time process finds the method implementation
appropriate for the receiver of the message; it then invokes (or calls, in a sense)
this implementation and passes it the receiver’s data structure. This mechanism
makes it easier to structure programs that respond to selections and actions
chosen by users at run time. For example, either or both parts of a message
expression—the receiver and the method name—can be variables whose values
are determined by user actions. A simple message expression can deliver a Cut,
Copy, or Paste menu command to whatever object controls the current
selection.

Dynamic binding even enables applications to deal with new kinds of objects,
ones that were not envisioned when the application itself was built. For
example, it lets Interface Builder send messages to objects such as EOModeler
when it is loaded into the application by means of custom palettes.

Polymorphism and dynamic binding depend on two other features: dynamic
typing and introspection. The Objective-C language allows you to identify objects
generically with the data type of id. This type defines a pointer to an object and
its data structure (that is, instance variables) which, by inheritance from the root
class NSObject, include a pointer to the object’s class. What this means is that
you don’t have to type objects strictly by class in your code: the class for the
object can be determined at run time through introspection.

Introspection means that an object, even one typed as id, can reveal its class and
divulge other characteristics at run time. Several introspection methods allow
you to ascertain the inheritance relationships of an object, the methods it
responds to, and the protocols that it conforms to.



Classes

You can create objects in your code
with the alloc and init methods
described here. But when you
define a class in Interface Builder,
that class definition is stored in a

nib file. When an application loads

that nib file, Interface Builder
causes an instance of that class to
be created.

Some of the objects networked together in an applications are of different kinds,
and some might be of the same kind. Objects of the same kind belong to the
same c/ass. A class is a programmatic entity that creates znustances of itself—
objects. A class defines the structure and interface of its instances and specifies
their behavior. ‘

When you want a new kind of object, you define a new class. You can think of a
class definition as a type definition for a kind of object. It specifies the data
structure that all objects belonging to the class will have and the methods they
will use to respond to messages. Any number of objects can be created from a
single class definition. In this sense, a class is like a factory for a particular kind
of object.

In terms of lines of code, an object-oriented program consists mainly of class
definitions. The objects the program will use to do its work are created at run
time from class definitions (or, if pre-built with Interface Builder, are loaded at
run time from the files where they are stored).

A class is more than just an object “factory,” however. It can be assigned
methods and receive messages just as an object can. As such it acts as a c/ass
object.

Object Creation

One of the primary functions of a class is to create new objects of the type the
class defines. For example, the NSButton class creates new NSButton objects
and the NSArray class creates new NSArrays. Objects are created at run time in
a two-step process that first allocates memory for the instance variables of the
new object and then initializes those variables. The following code creates a
new Country object:

id newCountry = [[Country alloc] init];

The receiver for the alloc message is the Country class (from the Travel Advistor
application in the next tutorial). The alloc method dynamically allocates
memory for a new instance of the receiving class and returns the new object.
The receiver for the init message is the new Country object that was
dynamically allocated by alloc. Once allocated and initialized, this new record is
assigned to the variable newCountry.

After being allocated and initialized, a new object is a fully functional member
of its class with its own set of variables. The newCountry object has all the
behavior of any Country object, so it can receive messages, store values in its
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instance variables, and do all the other things a Country object does. If you need
other Country objects, you create them in the same way from the same class
definition.

Objects can be typed as id, as in the above example, or can be more restrictively
typed, based on their class. Here, newCountry is typed as a Country object:

Country *newCountry = [[Country alloc] init];

The more restrictive typing by class enables the compiler to perform type-
checking in assignment statements.

Inheritance

Inkeritance is one of the most powerful aspects of object-oriented programming,.
Just as people inherit traits from their forbearers, instances of a class inherit
attributes and behavior from that class’s “ancestors.” An object’s total
complement of instance variables and methods derives not only from the class

that creates it, but from all the classes that class inherits from.

Because of inheritance, an Objective-C class definition doesn’t have to specify
every method and variable. If there’s a class that does almost everything you
want, but you need some additional features, you can define a new class that
inherits from the existing class. The new class is called a subclass of the original
class; the class it inherits from is its superclass.

Instance of superclass

Instance of subclass

Creating a new class is often a matter of specialization. Since the new class
inherits all its superclass’s behavior, you don’t need to reimplement the things
that work as you want them to. The subclass merely extends the inherited
behavior by adding new methods and any variables needed to support the
additional methods. All the methods and variables defined for—or inherited
by—the superclass are inherited by the subclass. A subclass can also alter



Other root classes are possible. In
fact, OPENSTEP’s Distributed
Objects makes use of another root
class, NSProxy.

superclass behavior by overriding an inherited method, reimplementing the
method to achieve a behavior different from the superclass’s implementation.
(The technique for doing this is discussed later.)

The Class Hierarchy and the Root Class
A class can have any number of subclasses, but only one superclass. This means

that classes are arranged in a branching hierarchy, with one class at the top—the
root class—that has no superclass:

Part of the OpenStep class
hierarchy.
( NSArray ) ( NSResponder)( NSString )
|
' NSWindow ) ( NSView ) ' NSApplication .

)

NSObject is the root class of this hierarchy, as it is of most Objective-C class
hierarchies. From NSObject, other classes inherit the basic functionality that
makes messaging work, enables objects to work together, and otherwise invests
objects with the ability to behave as objects. Among other things, the root class
creates a framework for the creation, initialization, deallocation, introspection,
and storage of objects.

As noted earlier, you often create a subclass of another class because that
superclass provides most, but not all, the behavior you require. But a subclass
can have its own unique purpose that does not build on the role of an existing
class. To define a new class that doesn’t need to inherit any special behavior
other than the default behavior of objects, you make it a subclass of the
NSObject class. Subclasses of NSObject, because of their general-purpose
nature as objects, are very common in OpenStep applications. They often
perform computational or application-specific functions.
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Advantages of Inheritance

Inheritance makes it easy to bundle functionality common to a group of classes
into a single class definition. For example, every object that draws on the

screen—whether it draws an image of a button, a slider, a text display, or a graph
of points—must keep track of which window it draws in and where in the

window it draws. It must also know when it’s appropriate to draw and when to
respond to a user action. The code that handles all these details is part of a single
class definition (the NSView class in the Application Kit). The specific work of
drawing a button, a slider, or a text display can then be entrusted to a subclass.

This bundling of functionality both simplifies the organization of the code that
needs to be written for an application and makes it easier to define objects that
do complicated things. Each subclass need only implement the things it does
differently from its superclass; there’s no need to reimplement anything that’s
already been done.

What’s more, hierarchical design assures more robust code. By building on a
widely used, well-tested class such as NSView, a subclass inherits a proven
foundation of functionality. Because the new code for a subclass is limited to
implementing unique behavior, it’s easier to test and debug that code.

Any class can be the superclass for a new subclass. Thus inheritance makes
every class easily extensible—those provided by OpenStep, those you create,
and those offered by third party vendors.

Defining a Class

You define classes in two parts: One part declares the instance variables and the .
interface, principally the methods that can be invoked by messages sent to
objects belonging to the class, and the other part actually implements those
methods. The interface is public. The implementation is private, and can
change without affecting the interface or the way the class is used.

The basic procedure for defining a class (using Interface Builder) is covered in
the Currency Converter tutorial. However, here is a supplemental list of
conventions and other points to remember when you define a class:

* The public interface for a class is usually declared in a header file (-h
extension), the name of which is the name of the class. This header file can
be imported into any program that makes use of the class.

* The code implementing a class is usually in a file taking the name of the class
and having an extension of .m. This code must be present—in the form of a
framework, dynamic shared library, static library, or the implementation file
itself—when the project containing the class is compiled.



* Method declarations and implementations must begin with and - sign ora +
sign. The dash indicates that these methods are used by instances of the class;
a + sign precedes methods that the class object itself uses.

® Method definitions are much like function definitions. Note that methods not
only respond to messages, they often initiate messages of their own—just as
one function might call another. .

¢ In a method implementation you can refer directly to an object’s instance
variables, as long as that object belongs to the class the method is defined in.
There’s no extra syntax for accessing variables or passing the object’s data
structure. The language keeps all that hidden.

¢ A method can also refer to the receiving object as self. This variable makes it
possible for an object, in its method definitions, to send messages to itself.

Overriding a Method

A subclass can not only add new methods to the ones it inherits, it can also
replace an inherited method with a new implementation. No special syntax is
required; all you do is reimplement the method.

Overriding methods doesn’t alter the set of messages that an object can receive;
it alters the method implementations that will be used to respond to those
messages. As mentioned earlier, this ability of each class to implement its own
version of a method is referred to as polymorphism.

It’s also possible to extend an inherited method, rather than replace it outright.
"To do this you override the method but invoke the superclass’s same method in
the new implementation. This invocation occurs with a message to super, which
is a special receiver in the Objective-C language. The term super indicates that
an inherited method should be performed, rather than one defined in the
current class.
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In addition to subclassing, you can expand an object and make it fit with other

classes using two Objective-C mechanisms: categories and protocols.

Categories provide a way to extend classes defined by other implementors—for
example, you can add methods to the classes defined in the OPENSTEP
frameworks. The added methods are inherited by subclasses and are
indistinguishable at run-time from the original methods of the class. Categories
can also be used as a way to distribute the implementation of a class into groups
of related methods and to simplify the management of large classes where more
than one developer is responsible for components of the code.

Protocols provide a way to declare groups of methods independent of a specific
class—methods which any class, and perhaps many classes, might implement.
Protocols declare interfaces to objects, leaving the programmer free to choose
the implementation most appropriate to a specific class. Protocols free method
declarations from dependency on the class hierarchy, so they can be used in
ways that subclasses and categories cannot. They allow objects of any class to
communicate with each other for a specific purpose.

OpenStep provides a number of protocols. For example, the spell-checking
protocols and the object-dragging protocols enable other developers to
seamlessly integrate their spell-checking and object-dragging implementations
into an existing system.
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document 109
control TextDidChange: 142

control TextDidEndEditing: 146-148,
166, 167

converting code,to OpenStep 190
coordinate system 18, 135, 141, 170
flipping 170
copy 79, 83, 103
copying objects 21, 117
and reference count 83
copyWithZone: 117
CORBA5
core program framework 140-141, 168
coverage 171
creating
class 33
custom view object 172
document 135
form 58
" object 207
panel 156
currentEvent 141
custom palette 206
custom view 112
and Interface Builder 122

customizing menus 64
CustomView object 172

D

.D’OLE 5,187

documentation 192
data

atport 154

mediating 86

serializing 100

storage 78

synchronizing displays of 167, 168
data encapsulation 30, 202
data source 60, 69, 84, 89
DataViews palette 60
date 125
date and time 126, 130

creating object 127

formatting 127

dateWithYear:month:day:hour:minute:
second:timeZone: 130

day of the week 127
dealloc 80, 83, 100, 118

deallocation 77, 78, 80, 82-83, 100, 103,
118, 209

debugger 102, 103
debugging 117
declaration 46, 134
method 43,116
deep copy 117
defaults 189

delegate 37,73,74,91,99, 129, 133, 140,
141, 149, 155

method implemented by 60,111, 142,
165

delegate 141
delegation 69,91, 144
delimiter checking 85
description 117,118

descriptionWithCalendarF ormat:
timeZone:locale: 149

design
hierarchical 210
hybrid 32
of application 32
determining class membership 206

dictionary 68,99
Digital Librarian application 50, 88, 191
display 160, 170, 172
Display PostScript 4, 7, 18, 108, 171
documentation 192
displays
synchronizing 168
distributed computing 4
document 107, 133
and nib file 133
closing 138
creating 135
icon 113
initial values 168
management 29
marking as edited 139, 142
opening 137
saving 138, 143, 144
setting type of 113

document controller 109, 110, 131, 132,
133, See also controller object

Document menu 131
Interface Builder 111
document type 113
documentation 50, 51, 88, 191
accessing 191
reference 51, 191
system administration 192
drag-and-drop 20, 29
drawing 29, 140, 141, 170-172
functions 171
drawRect: 170, 172
duplicating object 21
dynamic binding 46, 89, 205-206
dynamic loading 110
dynamic shared libraries 7

. dynamic typing 36, 46, 206

E

Edit menu 24

editable text 21

Emacs key bindings 85
enableDoubleReleaseCheck: 103
encapsulation 30, 202
encodeObject: 81
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encodeValueOfObjCType:at: 81
encodeWithCoder: 77, 81, 100, 118

Enterprise Objects Framework 4, 5, 60,
187

documentation 192
entity object 83
enum constant 85
EOModeler 206
event 18, 154-155, 181

and custom NSView 172

dispatching 140, 155

handling 140, 172

keyboard 155

message 140
eventcycle 154-155
event queue 155
extensibility 210

extension, file 113

F
fat files 48
faxing 29
field, formatting 96, 169
file
extension 113
management 29
opening 137
saving 138-139
type 137
file descriptor 154, 181
file package 48
File’s Owner 74,110
FileMerge application 188
finding information 50, 51
first responder 140, 155
firstResponder 141
focusing 170
font 190
setting 130
Font panel 22
Font submenu 28
form 58
formatter 29, 97
setting 169
formatting, of fields 96

-

228

Foundation framework 4,7, 78

frame 170

framework 7,48, 110, 188
documentation 191
Foundation 78

function 119

G
gdb 52,102,103, 117, 189
generating

instances 72

source-code files 42, 74
generating code files 114
"get" method 77,79
gnumake 48, 189
graphical debugger 102
grid, aligning on 24
grouping

objects 59
grouping methods 212

H
header file 42, 43,210
Help 29, 50, 88, 131
hierarchical data 61
hierarchy

of classes 209

I
icon
application 66
document 113
icon mode (Interface Builder) 73
IconBuilder application 188
id 34,206
identifier 89
column 60
image
adding to button 123
adding to interface 63
compositing 171
image view 63
implementation file 42, 44, 210
importing header files 45
incremental search 88

indentation 85
Info panel 131, 182
informal protocol 89, 124, 129
inheritance 8, 33, 208, 209
advantage of 210
init 80, 100, 118, 207
initialization 77, 80, 100, 118, 125, 209
defaule 80
initializing text 20
initWithCoder: 77, 81, 100, 118
initWithFrame: 125, 172
input source 181
inspector panel 19, 156
creating 156
display of 157
managing 156
instance 33, 207
generating 38
instance method 46
instance variable 91, 114, 202, 207, 211
declaring 76, 114, 210
inheriting 208
scope 46
setting 83 »
Instantiate command 38, 72
interface 17
creating with Interface Builder 17-27
testing 27, 28, 66
Interface Builder 6, 17,97, 207
and custom NSView 172
inspector 19
palettes 7,20
interface file 210
Objective-C 43
internationalization 76
interoperability 5
introspection 206, 209
invalidate 116, 179
isDocumentEdited: 143, 147
isEqual: 117
isEqualToString: 147
isKindOfClass: 117, 147

K
key 68,69, 145
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key equivalent 93

key window 18, 155
keyboard event 154, 155
keyWindow 141
keyword 46, 80, 203

L
label 21,22
1d 48
libg++ 192
library 48

dynamic 7
line on interface

creating 24
link editor 48
linking 48
lipo command 189
loadNibNamed: 136
localization, and nib files 63
localTimeZone 125
locating project symbols 88

M

main bundle 110

main menu 131

main nib file 17, 108
main window 18, 138, 155
main() 16, 108
mainMenu 141
mainWindow 138, 141
make 7

make, See also gnumake 7
Makefile 16

makefile 47, 48
Makefile.postamble 16
Makefile.preamble 16

makeFirstResponder: 143, 149, 155

makeKeyAndOrderFront: 45
making a connection 40
MallocDebug application 188
man pages 88
matrix 125

and tabbing 134
menu 18, 64

and Interface Builder 24

customizing 131

default 24

Document 111
Menus palette 64, 111

message 45,46, 203, 211

action

nesting 45, 46, 52, 203
.method 30, 46, 114, 202

accessor 46, 77,79

class 46

declaring 43, 77, 116, 210

delegation 73,111,129, 142, 146, 149,
165

difference from function 205
extending 211
inheriting 208
instance 46
invoking the superclass 153
overriding 152, 175, 208, 211
private 176
syntax 211

model object 31, 32, 67, 109, 145

Model-View-Controller paradigm 30, 32,
67,109, 120

modifier key 154

modularity 8, 30, 109, 203

mouse click, simulating 138

mouse event 154

mouseDown: 152, 172

multi-document application 107, 131
design 133

multi-document architecture 107

mutableCopy 103

N
name completion 85
nesting messages 45
Netlnfo 4, 188
network management 192
New command 133, 135
NeXT
ordering products 195
publications 51, 191
website 187
next responder 140, 155

NeXTanswers 187, 194
NextDeveloper bookshelf 191
NEXTIME 188
nextKeyView 25, 28, 64
nib file 16, 182, 207
and localization 63
auxiliary 74, 110, 133
creating 156
definition 17
document 110
loading 108, 136
main 17, 108
sound and images 63
nibTool 189
nil 46, 80, 146
nm command 189
notification 69, 91, 167, 168, 179
adding an observer 101
advantages 168
identifying 152
posting 153
notification center 91
notification queue 91
NSActionCell 97
NSApp 74, 108, 138, 141, 155
NSApplication 18, 108, 140, 141, 155
NSApplicationMain() 108
NSArchiver 99, 100
NSArray 68, 78, 89, 95, 117
NSBox 156, 169
NSBrowser 141
NSBundle 99, 100, 110, 174
NSButtonCell 125, 148, 173, 174
NSCalendarDate 125
NSCell 97
NSCoder 81, 100
NSCoding protocol 100, 114
NSCompositingOperation 171
NSConnection 181
NSControl 96, 97, 120, 125, 155
NSCopying protocol 114, 117
NSCountedSet 68
NSData 78,171
NSDate 97, 125, 174, 180
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NSDatcFormatter 97, 169
NSDictionary 68, 78, 99, 100
inserting objects 150
NSEvent 154
NSEventType 154
NSFormatter 97
NSHomeDirectory() 139
NSImage 171, 174
NSImageRep 171
NSImageView 63
NSMatrix 120, 121, 125
NSMutableArray 84, 95, 111
NSMutableDictionary 84
NSMutableString 76
NSNotification 91, 101, 167
NSNotificationCenter 91, 101, 167
NSNumber 78,97
NSObject 33, 78, 83, 124, 209
NSOpenPanel 137
NSProcessInfo 78
NSResponder 120, 140, 154, 155
NSRunAlertPanel() 98, 143
NSRunLoop 116, 181
NSSavePanel 139
NSSet 68
NSString 76, 78, 89
NSTableColumn 60, 89
NSTableDataSource 89
NSTableView 60, 89
NSText 87
NSTextFieldCell 86
NSThread 78
NSTimelnterval
NSTimer 116, 179, 181
NSTimeZone 125
NSUnarchiver 100
NSValue 78

NSView 120, 125, 135, 140, 141, 155,
170, 210

custom 172

focusing 170
NSWindow 18, 138, 140, 141, 154, 155
numberofRowsInTableView: 90
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object 8,9,33
aligning 24, 25
allocation 78
analog to 202
and dynamic binding 206
and name space 205
archiving 77, 139, 150
array 111
attribute 156
box 24,59, 156, 160
button 23
class membership 206
communication 180
comparison 117
connecting 36, 39, 40
controller 31, 32, 68, 84, 109
copying 21,117
creation 207
deallocation 77, 78, 80, 103, 118
definition 202
dictionary 68
disposal 82, 83
duplicating 21
dynamic typing 34
entity 83
form 58
formatter 169
initialization 77, 80, 100, 118
initializing text 20
inspector 156
interface 30, 203
introspection 206
matrix 111, 125, 134
model 31, 32, 67, 109
modularity 109
ownership policy 78, 82, 83
placing 20
pop-up list 162
putting in NSDictionary 150
relation to class 33
resizing 20
retaining 82, 169
retention 83

reusing 109

scroll view 60

sizing 20

text 59, 166

text field 165, 166

unarchiving 136

value 83

view 32,112,120
objectAtIndex: 137, 147
objectForKey: 68, 151

94

-Objective-C 7, 48, 202, 203, 206, 208,

211,212
documentation 192
header file 43
summary 46
object-oriented program 204
design 30
object-oriented programming 201
documenation 192
objects
connecting 37,73
grouping 59, 157
making same size 21
sharing 159
observer 91
oh command 103, 189
Open command 133, 137
Open panel 111, 133, 137
opening a document 137
openPanel 137
OPENSTEP 4
application 28,29
development applications 188
OpenStep 7
converting code to 190
specification 4, 190
OPENSTEP Developer 4,6
OPENSTEP User 4
ordering products 195
origin point 135
outlet 25, 34,70, 72,123
connecting 39
defining 35, 36
outline mode 73



Index

overriding a method 152, 173, 175, building 47 S

208, 211 directory 15 sales offices 195
invoking superclass 153 project browser 16 Same Size command 21
ownership, of objects 82 Project Builder 6, 110 Sampler application 188
P checking delimiters 85 Save command 133, 138
palette 20, 110, 190 indentation 85 Save panel 111, 133,139
panel 18 launching 15 savePanel 139
creating 156 searching 88 saving a document 138, 143
inspector 157 Project Find panel 51, 88, 191 screen, coordinate system 135
off-screen 157 project symbols 88 scroll view 60
pasteboard 29 protocol 212 scrolling 170
pathForlmageResource: 174 adopting 76, 114 searching code 83
PDO, See Portable Distributed Objects informal 124 selectable text 21
performClose: 138 pswrap 171,172,189 selectedCell 130
periodic event 154 putCell:atRow:column: 178 selectedRow 93
persistence 81 R selectText:A 45, 86
placing objects 20 radio mode 125 self 46, 211
platforms, supported 5 receiver 45. 203 sender 45
’ services 29

plug-and-play 29 reference documentation 51, 88 .
Services menu 24

po command 117 release 80, 83, 103 "set" method 77. 79
polymorphism 46, 89, 205, 211 release notes 192 sz;l:;stizZchll;' 126
pop-up list 18 reliability 8 C Vi ~.160
Portable Distributed Objects 4, 5 removeFromSuperView 169 setontentview:

setDataSource: 89
setDocumentEdited: 139, 142
setEntryType: 96

documentation . 192 replaceObjectAtIndex:withObject: 147
posting, a notification 91

PostScript 154, 170
and drawing 171

representedFilename 137

resizing setFloatingPointFormatleft:right: 96

setFormatter: 97, 169
setFrameOrigin: 170

view object 20

Preferences panel 131, 183 window 19

principal class 108 resource

setFrameSize: 170

print: 65 for programming 190 .
printing 29, 65 resOUrCes sctidcntlflt‘:rz4 889
procedural programming 201 application 174 setImage: 1

d 201 . setObject:forKey: 150
procedures . responder chain 140, 155 Stace: 5787
professional services 5 retain 79, 83, 103, 159 setdtate: S/,

setString : 87
setStringValue: 86
setTarget: 155
setting the font 22, 130
setTitle: 136, 148

: setTitleWithRepresentedFilename:
programming reusing object 71 136 P '

procedural 201

program development and content view 160

command-line tools 189 retaining object
resources 190 implications of 83
work flow 14 reusability 109

program, object-oriented 204 ‘reuse 8, 108

root class 209

work flow 14 ' root object 78,99, 100 -
project 15

shallow copy 117

sharedApplication 108
rows, of objects 25 sizing objects 21

addingclass to 114 runModalForDirectory:file:types: 137
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sortedArrayUsingSelector: 89
sound 190
Sound Kit 188
source-code files
generating 42, 74, 114
specialization 209
standard window 18
start TrackingAtinView: 177
state 57
static typing 46
stop Tracking:at:inView:mouselsUp: 177
string object
and character strings 76
empty 80
stringValue 87
strip command 189
subclass 8, 33, 208, 209
creating 33, 152, 173, 209
custom view 172
making 108
Subclass command 70
subclassing 108
subview 59, 141, 160
suitcase 16
Sun Solaris 4
super 46, 80, 125, 211
superclass 33, 70, 121, 152, 208, 209
accessor method 175
superview 59, 141, 155
support, technical 193
switch 57, 87, 162
symbols, definitions and references 88
system administration 192

T

tabbing, between fields 26

table view 60, 69, 89
configuring 61
identifier 89

tableView:

objectValueForTableColumn: row:
90

tableView:setObjectValue:
forTableColumn:row: 90

TabulationViews palette 60
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tag 124, 125, 128, 160, 162
tag 130
target 36, 40
setting programmatically 126
target/action paradigm 37, 155, 165
techncial documentation 51
technical support 193
testing an interface 27, 66
text
aligning 22
background color 21
editable 21
selectable 21
text color 21
text field 165, 166
attributes 21
font 22
formatting 169
placing and resizing 20
tabbing between 26
validation 169
text object 59, 166
Text submenu 28
textDidChange: 101
textDidEndEditing: 166
thread 181
tile 93
time zone 126
time, See date and time
timer 116, 154, 179, 181
firing 180
scheduling 179
Title object 22
tools, command-line 189
TOPS 190
tracking-rectangle event 154
training 193

_ transparency 171

typing, static and dynamic 208
U

unarchiveObjectWithFile: 100, 136

unarchiving 77, 118, 136
Unicode 76
userlnfo dictionary 153

)
validation, of fields 96, 169
value object 68, 83
view hierarchy 18, 140, 141
view object 18, 32, 120

custom 112,172

printing 65

removing from superview 169
Views palette 20, 172

w
WebObjects 5, 136, 187
window 18, 154

attributes 19

behavior 28

closing 143

depth 171

events 155

key 18

locating 136

main 18

making first responder 143

positioning 135

resizing 19

setting title 136

status 138
Window Server 18, 108, 140, 154
Windows menu 24
Windows operating system 4
Windows palette 157
windowShouldClose: 143
World Wide Web 187, 195

Y
Yap application 188



Printed on recycled paper
6863.00




